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1 前言

1.1 文档说明
本说明仅适用于熟悉国家标准且经过培训的控制和自动化工程专家。
在安装和调试组件时，必须遵循文档和以下说明及解释。
操作人员应具备相关资质，并始终使用最新的生效文档。

相关负责人员必须确保所述产品的应用或使用符合所有安全要求，包括所有相关法律、法规、准则和标准。

免责声明

本文档经过精心准备。然而，所述产品正在不断开发中。
我们保留随时修改和更改本文档的权利，恕不另行通知。
不得依据本文档中的数据、图表和说明对已供货产品的修改提出赔偿。

商标

Beckhoff®、ATRO®、EtherCAT®、EtherCAT G®、EtherCAT G10®、EtherCAT P®、MX-System®、Safety over
EtherCAT®、TC/BSD®、 TwinCAT®、TwinCAT/BSD®、TwinSAFE®、XFC®、XPlanar® 和 XTS®是 Beckhoff
Automation GmbH
的注册商标并由其授权使用。本出版物中所使用的其它名称可能是商标名称，任何第三方出于其自身目的使用
它们可能会侵犯商标所有者的权利。

EtherCAT®是注册商标和专利技术，由 Beckhoff Automation GmbH 授权使用。

版权所有

© Beckhoff Automation GmbH。
未经明确授权，不得复制、分发、使用和传播本文档内容。
违者将被追究赔偿责任。Beckhoff Automation GmbH 保留所有发明、实用新型和外观设计专利权。

第三方商标

本文档可能使用了第三方商标。有关商标信息，可以访问：https://www.beckhoff.com/trademarks。

1.2 安全信息
安全规范

为了确保您的使用安全，请务必仔细阅读
并遵守本文档中每个产品的安全使用说明。

责任免除

所有组件在供货时都配有适合应用的特定硬件和软件配置。严禁未按文档所述修改硬件或软件配置，否则，德
国倍福自动化有限公司对由此产生的后果不承担责任。

人员资格

本说明仅供熟悉适用国家标准的控制、自动化和驱动工程专家使用。

警示性词语

文档中使用的警示信号词分类如下。为避免人身伤害和财产损失，请阅读并遵守安全和警告注意事项。

https://www.beckhoff.com/trademarks
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人身伤害警告

 危险
存在死亡或重伤的高度风险。

 警告
存在死亡或重伤的中度风险。

 谨慎
存在可能导致中度或轻度伤害的低度风险。

财产或环境损害警告

注意
可能会损坏环境、设备或数据。

操作产品的信息

这些信息包括：
有关产品的操作、帮助或进一步信息的建议。

1.3 信息安全说明
Beckhoff Automation GmbH & Co.KG (简称 Beckhoff) 的产品，只要可以在线访问，都配备了安全功能，支
持工厂、系统、机器和网络的安全运行。尽管配备了安全功能，但为了保护相应的工厂、系统、机器和网络免
受网络威胁，必须建立、实施和不断更新整个操作安全概念。Beckhoff 所销售的产品只是整个安全概念的一
部分。客户有责任防止第三方未经授权访问其设备、系统、机器和网络。它们只有在采取了适当的保护措施的
情况下，方可与公司网络或互联网连接。

此外，还应遵守 Beckhoff 关于采取适当保护措施的建议。关于信息安全和工业安全的更多信息，请访问本公
司网站 https://www.beckhoff.com/secguide。

Beckhoff 的产品和解决方案持续进行改进。这也适用于安全功能。鉴于持续进行改进，Beckhoff 明确建议始
终保持产品的最新状态，并在产品更新可用后马上进行安装。使用过时的或不支持的产品版本可能会增加网络
威胁的风险。

如需了解 Beckhoff 产品信息安全的信息，请订阅 https://www.beckhoff.com/secinfo 上的 RSS 源。

https://www.beckhoff.com/secguide
https://www.beckhoff.com/secinfo


用户界面组件

TE1000 15版本： 2.15.0

2 用户界面组件
TwinCAT 3 开发环境包含多个组件。用户界面的外观取决于各组件的排列和配置。

解决方案资源管理器

菜单栏

消息窗口

工具 栏

属性窗口

工具箱

编辑器窗口

信息和状态栏

标准组件

菜单栏 根据 Customize（自定义）对话框中的设置显示菜单。
工具 栏 根据 Customize（自定义）对话框中的设置显示带符号按钮所表示的命令。
工具箱 显示当前活动编辑器可用的“工具”（例如图形化编程元素）
解决方案资源管理器 显示 TwinCAT 3 项目及结构化形式的相关项目元素。
属性窗口 显示当前在解决方案资源管理器中选择的元素属性。
编辑器窗口 这用于定义和编辑对象。在程序编辑器中（例如 ST 编辑器、CFC 编辑

器），编辑器窗口通常在下部显示程序编辑器（实现部分），在上部显示声
明编辑器。在其他编辑器中，编辑器窗口可能还包含对话框（例如任务编辑
器、设备编辑器）。

以下组件在脱机或联机模式下提供项目的当前流程信息：

消息窗口 显示当前与语法检查、编译过程等相关的错误、警告和消息。
编辑器的监控窗口和联机视图 用于监控 POU 或用户定义的表达式/变量列表。
信息和状态栏 显示 TwinCAT 3 Runtime 的状态。如果编辑器窗口当前处于活动状态，则

显示当前光标位置和设置的编辑模式。在联机模式中，您可以看到当前程序
状态。

TwinCAT 安装了某些标准设置，这些设置决定了标准组件的外观、结构和行为，从而决定了用户界面。“配
置用户界面 [} 32]”部分描述了您可以如何编辑标准设置，以便对用户界面进行个性化调整。“参考用户界
面 [} 48]”部分提供了有关命令的详细信息。

显示 TwinCAT 3 Runtime 的状态

除了显示 TwinCAT 3 Runtime 的当前运行模式（运行模式或配置模式）之外，还会显示与选定 TwinCAT 3
Runtime 的连接质量。对连接质量的评估始终以当前设置的连接超时时间为基准。
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设置的超时时间分为微型超时和重试。因此可得出以下关系：

设置的连接超时时间 = 微型超时 * 重试的次数。

关于如何划分微型超时和重试，需区分不同情况处理：

如果设置的连接超时时间 >= 30 s，
则微型超时 = 5 s，重试 = 设置的连接超时时间 / 5

如果设置的连接超时时间 >= 10 s，
则微型超时 = 2 s，重试 = 设置的连接超时时间 / 2

否则：微型超时 = 500 ms，重试 = 设置的连接超时时间 *2

每次微型超时后，系统都会重新尝试与目标系统建立通信。系统不会输出任何错误消息。此类信息主要用于评
估与目标系统的连接质量。

此处有以下 3 个级别：

黄色条： 连接质量良好：
不足 ¼ 的微型超时已过期。

橙色条： 第 1 级警告：
¼ 的微型超时已过期。

红色条： 第 2 级警告：
一半的微型超时已过期。

闪烁行为 显示屏会按照此处说明的颜色闪烁，以指示微型超时的状态。
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2.1 标准菜单
菜单栏默认可见。其包含截屏中显示的主菜单。

TwinCAT 项目的上下文菜单可按标准调用。

2.2 标准工具栏
可通过工具栏快速访问命令。工具栏默认设置如下。

标准工具栏选项

TwinCAT PLC 工具栏选项

TwinCAT XAE 基础工具栏选项

2.3 标准命令
主菜单默认包含以下命令。仅在相应编辑器打开时显示特定于编辑器的菜单和命令。您也可以使用其他命令，
可将其添加至现有或新定义的菜单中。

文件

File (文件) 菜单包含与项目文件相关的操作命令 (打开、关闭、保存、打印、页面设置...)
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符号 命令
命令：项目... (创建新的 TwinCAT 项目) [} 54]

命令项目/解决方案（打开项目/解决方案） [} 49]

命令：从目标打开项目 [} 56]

命令从存档中打开解决方案 [} 49]

命令：新项目... (添加新的 TwinCAT 项目) [} 56]

命令：现有项目... (添加现有 TwinCAT 项目) [} 56]

命令：最近项目和解决方案 [} 57]

命令：保存全部 [} 57]

命令：保存 [} 57]

命令将 <Solution name> 另存为 [} 57]

命令将 <solution name> 另存为存档…… [} 48]

命令：将 <TwinCAT project name> 另存为 [} 58]

命令将 <TwinCAT project name> 另存为存档…… [} 246]

命令将 <PLC project name> 另存为 [} 58]

命令将 <PLC project name> 另存为存档…… [} 50]

命令：通过电子邮件发送... [} 58]

命令：关闭解决方案 [} 58]

命令：关闭 [} 59]

命令：退出 [} 59]

命令：页面设置... [} 59]

命令：打印 [} 59]

编辑

Edit (编辑) 菜单包含文本编辑器中的工作命令 (语言编辑器、声明编辑器...)
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符号 命令
复制 标准命令 [} 60]

剪切

删除

粘贴

重做

撤销

命令删除 [} 60]

命令全选 [} 60]

命令：输入助手 [} 60]

命令：自动声明 [} 62]

命令：转至 [} 66]

命令转至定义 [} 67]

命令：导航至 [} 68]

命令：大写 [} 68]

命令：小写 [} 68]

命令：查看空白处 [} 68]

命令：快速替换 [} 71]

命令：快速查找 [} 69]

命令：切换写入模式 [} 72]

命令：重命名 [} 73]

命令：重命名 '<variable>' [} 73]

命令：删除 '<variable>' [} 76]

命令：添加 '<variable>' [} 74]

命令：重新排序变量 [} 76]

视图

View (视图) 菜单包含用于激活用户界面窗口中各个默认视图的命令。
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符号 命令
命令：打开对象 [} 77]

命令：表格视图 [} 78]

命令：文本视图 [} 77]

命令：全屏 [} 78]

命令：工具栏 [} 78]

命令：解决方案资源管理器 [} 79]

命令：属性窗口 [} 79]

命令：工具箱 [} 80]

命令：错误列表 [} 81]

命令：输出 [} 82]

项目

Project (项目) 菜单包含处理项目对象和项目属性以及复制和导出项目或对象的命令。

符号 命令
命令添加新项目（项目） [} 83]

命令添加现有项目（项目） [} 50]

命令：添加新项目（对象） [} 256]

命令：导出至 ZIP [} 257]

命令：从 ZIP 导入 [} 257]

命令：导出 PLCopenXML [} 258]

命令：导入 PLCopenXML [} 258]

命令：新建文件夹 [} 257]

命令属性（PLC 项目） [} 92]

命令属性（对象） [} 88]

PLC 项目设置 [} 109]

构建

Build（构建）菜单包含通过编译（不生成代码）创建项目的命令，即运行带语法检查的预编译，以及清除与
在线更改和离线代码生成相关的先前编译信息的命令。
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符号 命令
命令构建 PLC 项目 [} 115]

命令重建 PLC 项目 [} 115]

命令构建解决方案 [} 113]

命令重建解决方案 [} 113]

命令清除 PLC 项目 [} 115]

命令清除解决方案 [} 113]

命令检查所有对象 [} 114]

调试

Debug (调试) 菜单包含管理控制器程序执行 (启动、停止) 的命令和调试任务 (断点、逐步处理、写入和强制
值) 的命令。

符号 命令
命令：新断点 [} 115]

命令：编辑断点 [} 119]

命令：启用断点 [} 119]

命令：禁用断点 [} 119]

命令：切换断点 [} 119]

命令：单步跳过 [} 120]

命令：单步跳入 [} 120]

命令：单步跳出 [} 120]

命令：显示下一语句 [} 121]

命令运行至光标处 [} 121]

TwinCAT

TwinCAT 菜单包含控制 TwinCAT 3 Runtime 环境的命令。
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符号 命令
命令激活配置 [} 122]

命令：重启 TwinCAT 系统 [} 122]

命令：重启 TwinCAT (配置模式) [} 122]

命令：重新载入设备 [} 122]

命令：扫描 [} 122]

命令：切换自由运行状态 [} 123]

命令：显示在线数据 [} 123]

命令：显示子项 [} 123]

命令：隐藏禁用项目 [} 124]

命令：选择目标系统 [} 123]

命令软件保护 [} 124]

命令：激活启动项目 [} 249]

PLC

PLC 菜单包含打开为使用 PLC 项目提供开发环境的工具的命令。
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符号 命令
命令：断点 [} 131]

命令查找所有引用 [} 68]

命令：交叉引用表 [} 129]

命令：调用栈 [} 133]

命令：调用树 [} 133]

命令：浏览调用树 [} 66]

命令：监视列表 <n> [} 128]

命令：监视所有强制执行 [} 128]

命令：添加至监视 [} 66]

命令登录 [} 142]

命令：登出 [} 144]

命令：下载 [} 140]

命令冷重置 [} 144]

命令：初始值复位 [} 144]

命令在线更改 [} 141]

命令：开始 [} 143]

命令：停止 [} 144]

命令：单循环 [} 145]

命令：强制值 [} 145]

命令：写入值 [} 148]

命令：取消强制值 [} 147]

命令：切换流程控制模式 [} 145]

命令：显示模式 - 二进制、十进制、十六进制 [} 148]

命令：创建本地化模板 [} 149]

命令：管理本地化 [} 150]

命令：切换本地化 [} 150]

命令：激活 PLC 项目 [} 150]

命令：激活 PLC 实例 [} 151]

命令：显示内存视图 [} 125]
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工具

Tools (工具) 菜单包含打开创建项目运行特定环境 (库和设备安装、自定义用户界面、编辑器选项、加载和保
存等) 的工具的命令。

符号 命令
命令：选项 [} 151]

命令：自定义 [} 177]

窗口

Window (窗口) 菜单包含定位用户界面视图 (配置、打开、关闭等) 的命令。

符号 命令
命令：浮动 [} 180]

命令：程序坞 [} 180]

命令：隐藏 [} 181]

命令：自动隐藏全部 [} 181]

命令：自动隐藏 [} 181]

命令：固定选项卡 [} 181]

命令：新水平选项卡组 [} 182]

命令：新垂直选项卡组 [} 182]

命令：重置窗口布局 [} 182]

命令：关闭所有文件 [} 182]

命令：窗口 [} 183]

窗口子菜单命令 [} 183]

上下文菜单 TwinCAT 项目
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符号 命令
命令：将 <TwinCAT project name> 另存为项目文件... [} 246]

命令：保存全部 [} 57]

命令：通过电子邮件发送 <TwinCAT project name>... [} 58]

命令：自动将 <TwinCAT project names> 备份到目标系统 [} 247]

命令：将 <TwinCAT project name> 与目标系统进行比较… [} 247]

命令：使用目标系统更新项目… [} 247]
命令：使用 TwinCAT 2.xx 版本加载项目… [} 247]

命令：显示隐藏配置 [} 247]
命令：从解决方案中删除 [} 247]

命令：重命名 [} 248]

命令：构建 <TwinCAT project name> [} 115]

命令：重建 <TwinCAT project name> [} 115]
命令：卸载项目 [} 249]
命令：导入 AutomationML… [} 249]
命令：导出 AutomationML… [} 249]

2.4 默认视图和窗口
在 TwinCAT 中，窗口和视图是有区别的。

视图

“视图”是用户界面主窗口中的一个独立于 PLC 对象的窗口。视图具有以下属性：
• 可通过 View (视图) 菜单打开视图。
• 视图通常包含一个不可配置的工具栏，其中带用于在视图内排序、查看和搜索的按钮。
• 视图可靠在主窗口边框，或置于屏幕的任何位置。
• 只能通过主窗口中的选项卡隐藏和显示视图。

默认打开以下视图：
• Solution Explorer
• Error List (错误列表)
• 输出
• 工具箱
• 属性窗口

窗口

“窗口”取决于 PLC 对象。窗口具有以下属性：
• 可通过 Window (窗口) 菜单或双击对象打开窗口。
• 可在用户界面特定区域以选项卡形式将窗口作为 MDI 窗口排列。窗口的排列取决于用户特定设置。
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• 无法隐藏窗口。
• 默认不打开窗口。

示例：
• PLC 对象的编辑器窗口

2.5 信息栏
信息栏根据激活的视图或窗口显示当前光标位置和编辑模式以及 TwinCAT 3 Runtime 的模式。

光标位置

编辑器窗口激活时显示当前光标位置。

当前光标位置，从编辑器窗口左侧或顶部开始：

L (Ln) 行号
C (Col) 列号 (列只包含一个空格、字母或数字)
Chr (Ch) 字符数 (字符可以是一个字母、一个数字、甚至一个选项卡范围，比如可以包含 4 列)

双击一个字段，打开 Go To Line (转至行) 对话框。您可在此指定一个放置光标的行。

编辑模式

编辑器窗口激活时显示当前编辑模式。

当前设置的编辑模式：

INS 插入模式
OVR 覆盖模式

双击该字段以更改设置。

TwinCAT 系统状态

您可以根据系统托盘中的 TwinCAT 系统服务图标颜色识别 TwinCAT 系统的状态。可能出现以下状态：

TwinCAT 3 Runtime 处于配置模式

TwinCAT 3 Runtime 处于运行模式

TwinCAT 3 Runtime 处于停止模式

TwinCAT 3 Runtime 处于异常模式

闪烁状态表示微型超时 [} 15]。
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2.6 状态符号
PLC 模块状态

PLC 对象 PLC 实例 状态
TwinCAT 处于配置模式
PLC 退出
PLC 停止
TwinCAT 处于运行模式
PLC 登录
PLC 停止
TwinCAT 处于运行模式
PLC 登录
PLC 启动
TwinCAT 处于运行模式
PLC 退出
PLC 停止
TwinCAT 处于运行模式
PLC 退出
PLC 启动
TwinCAT 处于运行模式
其他用户已登录 PLC。
PLC 启动

PLC 对象的状态

自上次保存以来对象未更改。

自上次保存以来对象已更改。

对象已签名。

对象已加密。

2.7 系统菜单
TwinCAT 系统菜单提供访问 TwinCAT 系统功能的所有重要命令。除了启动和停止运行时的重要运行时命令之
外，该菜单还包含访问路由器设置以及工程与运行时之间通信的命令。当工程与运行时位于单独的计算机上
时，路由器命令尤其重要。也可直接通过 TwinCAT 系统菜单启动工程环境。

通过右击系统托盘中的 TwinCAT 系统服务图标打开系统菜单。
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2.7.1 关于 TwinCAT...
TwinCAT System (TwinCAT 系统) 对话框列出了所安装的 TwinCAT 版本的所有基本数据。可根据要求将此
数据复制到剪切板或发送电子邮件至 TwinCAT 支持热线。
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2.7.2 实时

时基 用于计算百分比的时间基准。固定时基目前设置为 1 毫秒。
CPU 使用/限制 该滑块可用于为 TwinCAT 实时系统分配处理器时间。时基目前设置为 1 毫秒。在所

示示例中，TwinCAT 最多分配了 80% 的计算时间。时基为 1 毫秒意味着 TwinCAT
每毫秒的最大可用时间为 800 微秒。还意味着 Windows 至少剩余 200 微秒。当
TwinCAT 实时系统切换至空闲任务时，处理器回到 Windows。滑块栏显示实时系统
的当前使用情况。显示的是 256 次循环 (毫秒) 的平均数。

系统延迟 显示实时系统的当前和最大延迟时间。测量中央系统节拍延迟的时间。保存最大时
间，直到滑块被操作或退出对话框。当然，也会在未打开对话框时测量延迟时间。
如果超过设置的最大时间，窗口中会显示一条消息并创建日志条目。通过调用对话框
可重置消息，从而在下一次超时时再次显示消息。

2.7.3 路由器

信息

存储器

TwinCAT 系统要求显示用于 AMS 消息和 TwinCAT 实时环境存储器管理的 RAM。当 TwinCAT 系统启动时，
Windows 请求整个存储器。可在 TwinCAT 系统节点中配置存储器大小。

全部 启动 TwinCAT 系统时可用的 RAM。
可用 TwinCAT 目前可用的 RAM。

注册

必须在路由器上注册所有参与 TwinCAT 消息系统 (AMS) 的设备。TwinCAT 服务器有固定的端口号 (例如
TwinCAT PLC LZS1: 851，...)。消息路由器为 TwinCAT 客户端分配一个端口号。
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端口 注册端口号
驱动器 TwinCAT 服务器占用的端口
传输协议 已注册的设备号 (NetIDs)

邮件调试 结合 TwinCAT ADS 监控器，可记录整个 TwinCAT 消息流量。注意：附加消息会减慢
消息流量。TwinCAT ADS 监控器不是 TwinCAT 的标准供应范围。

清理

路由器的清理功能可用于释放来自不再运行的程序的路由器端口。此功能尤其适用于 PLC 项目的开发阶段。

更改 AMS NetID

本地计算机

AMS NetID AMS Net ID 是 TwinCAT 网络中的本地计算机地址。AMS Net ID 包含 6 个字节并且以
一个点符号表示。“Net ID”必须由项目规划人员分配，并且不能在 TwinCAT 网络中
重复。默认情况下，此安装会生成一个来自系统 IP 地址的 AMS NetID (如可用) +
“1.1”。如果在安装过程中未确认任何 IP 地址，则创建 AMS NetID
“1.1.1.1.1.1”。

编辑路由

TwinCAT Static Routes (TwinCAT 静态路由) 对话框显示本地 TwinCAT 系统的所有路由信息。

可使用 Add (添加) 按钮添加新路由。

2.7.4 系统
如果 TwinCAT 系统未配置为自动启动，可通过系统菜单手动启动。

启动/重启 TwinCAT 系统启动。输入的所有 TwinCAT 服务器均已加载并初始化。TwinCAT 输入/
输出管理器根据配置对 TwinCAT 输入/输出子系统进行参数化。输入的 PLC 子系统的所
有运行时系统均已初始化。如果输入运行时系统的启动项目，则加载该项目并且 PLC 程
序启动。保留型数据也根据配置加载。

配置 TwinCAT 系统停止。所有输入的 TwinCAT 服务器均已关闭并卸载。当 TwinCAT 系统停
止时，仅 TwinCAT 消息路由器留在存储器中。现在可再次通过 System (系统) > Start
(启动) 来启动 TwinCAT 系统。
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2.7.5 工具

工具 描述
事件查看器 打开 Windows 事件查看器，在其中输入系统错误

TwinCAT 项目比较 打开用于比较或合并 TwinCAT 项目的应用程序
参见：文档源控制 >

TwinCAT 切换运行时 打开用于切换 TwinCAT 2 和 TwinCAT 3 之间 TwinCAT 运行时环境的应用程
序

2.8 在线模式中的用户界面
通过项目登录到目标系统时，所有在窗口中打开的对象和在脱机模式下打开的视图均以在线模式显示。

更多关于各编辑器在线视图的信息，请参见各编辑器的描述。

另请参见：
• PLC 文档：在线模式下的 SFC 编辑器
• PLC 文档：在线模式下的 CFC 编辑器
• PLC 文档：在线模式下的 FBD/LD/IL 编辑器
• PLC 文档：在线模式下的 ST 编辑器
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3 配置用户界面
您可以自定义 TwinCAT 的行为、外观、菜单组件和窗口布局。在 Tools（工具）菜单中，您将找到用于自定
义界面和设置 TwinCAT 选项的对话框。

另请参见：
• 命令：选项 [} 151]
• 命令：自定义 [} 177]

3.1 设置选项
可以在 Options (选项) 对话框的各选项卡中配置 TwinCAT 的行为和外观。在 Tools (工具) 菜单中选择
Options (选项) 命令后，此对话框打开。您可以在此进行各编辑器和功能的设置。这些设置在 TwinCAT 中有
效。设置存储在本地系统的当前用户配置文件中。

另请参见：
• 命令：选项 [} 151]
• 自定义用户界面 [} 33]

3.1.1 自定义文本编辑器设置
应使用相同的字体和编辑器设置，从而在不同程序中实现字体统一。您可以在 TwinCAT 选项中自定义这些设
置。

当 TwinCAT 3 集成到 Visual Studio 中时，字体和表尺寸在默认情况下是预先设置的。

自定义字体和颜色
1. 在 Tools (工具) 菜单中选择 Options (选项) 命令。

ð Options (选项) 对话框打开。
2. 选择类别 Environment > Fonts and colors (环境 > 字体和颜色)。
3. 选择所需的字体设置。
4. 选择 OK (确认) 关闭对话框。
ð 这些设置将在重新启动程序后应用。

默认设置：

元素 仅文本
字体 Consolas
大小 10
项目前景 标准 (黑色)
项目背景 默认 (白色)

自定义文本布局
1. 在 Tools (工具) 菜单中选择 Options (选项) 命令。

ð Options (选项) 对话框打开。
2. 选择类别 TwinCAT > PLC Environment > Text editor (TwinCAT > PLC 环境 > 文本编辑器)。
3. 选择所需的布局设置。
4. 选择 OK (确认) 关闭对话框。
ð 这些设置将在重新启动程序后应用。

默认设置：
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撤销步骤数 100
折叠 缩进
自动换行 无
选项卡宽度 4
保存选项卡 是
缩进字符数 4
自动缩进 智能代码补全

3.1.2 选择语言
1. 在 Tools (工具) 菜单中选择 Options (选项) 命令。

ð Options (选项) 对话框打开。
2. 选择类别 Environment > International settings (环境 > 国际设置)。
3. 选择语言。
ð 这些设置将在重新启动程序后应用。

3.2 自定义用户界面
TwinCAT 根据您的需要提供自定义用户界面的选项。您可以自定义窗口布局以及菜单和命令的可见性。

3.2.1 自定义菜单
您可以根据需要自定义用户界面的菜单命令。可使用 Customize (自定义) 对话框隐藏或添加菜单。

恢复默认设置
使用 Tools > Customize > Commands (工具 > 自定义 > 命令) 中的 Reset all (重置全部) 按钮重置
您在自定义设置中所作的更改。

特殊菜单栏
某些视图，例如在解决方案资源管理器中，有一个特殊菜单栏，其中带有在窗口中排序、显示和搜索
的按钮。这些菜单栏无法配置。

删除菜单或命令
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
2. 选择 Commands (命令) 选项卡。

ð Menu bar (菜单栏) 字段默认激活。
3. 在相应列表框中选择要编辑的菜单。

ð Commands (命令) 区域显示可用的子菜单和命令。
4. 选择一个菜单或命令。
5. 点击 Delete (删除)。

ð 从菜单树中删除菜单或命令。
6. 点击 Close (关闭)。
ð 对话框关闭，菜单进行自定义设置。

添加菜单
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
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2. 选择 Commands (命令) 选项卡。
ð Menu bar (菜单栏) 字段默认激活。

3. 在相应列表框中选择要编辑的菜单。
ð Controls (控制) 区域显示可用的子菜单和命令。

4. 点击 Add New Menu (添加新菜单)。
ð 添加新菜单。

5. 点击 Modify Selection (修改选择) 组合框并输入新菜单的名称。
6. 使用 Move Up (向上移动) 或 Move Down (向下移动) 按钮更改菜单序列的位置。
7. 点击 Close (关闭)。
ð 对话框关闭。新菜单不会完全显示，直到菜单中有命令为止。

添加命令
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
2. 选择 Commands (命令) 选项卡。

ð Menu bar (菜单栏) 字段默认激活。
3. 在相应列表框中选择要编辑的菜单。

ð Commands (命令) 区域显示可用的子菜单和命令。
4. 点击 Add Command... (添加命令)。

ð Add Command (添加命令) 对话框打开。对话框列出所有按类别分组的命令。
5. 选择要添加的命令并点击 OK (确认)。

ð 新命令添加到菜单树。
6. 使用 Move Up (向上移动) 或 Move Down (向下移动) 按钮更改菜单序列的位置。
7. 点击 Close (关闭)。
ð 对话框关闭，新命令在菜单中可用。

另请参见：
• 命令：自定义 [} 177]

3.2.2 自定义工具栏
您可以根据需要自定义 TwinCAT 用户界面的工具栏。您可以使用 Customize (自定义) 对话框隐藏或添加工
具栏。

显示或隐藏工具栏
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
2. 选择要显示或隐藏的工具栏勾选框。

ð 用户界面显示或隐藏工具栏。
3. 点击 Close (关闭)。
ð 对话框关闭。

添加和删除工具栏
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
2. 点击 New (新建)。
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ð New Toolbar (新建工具栏) 对话框打开。
3. 输入名称并点击 OK (确认)。

ð 新的空工具栏自动激活并添加到菜单栏下。
4. 点击 Close (关闭)。
ð 对话框关闭。显示新工具栏。新工具栏不会完全显示，直到工具栏中有命令为止。

使用 Customize > Toolbars (自定义 > 工具栏) 选项卡中的 Delete (删除) 命令以删除您编译的工具栏。

添加和删除命令
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
2. 选择 Commands (命令) 选项卡。

ð Menu bar (菜单栏) 字段默认激活。
3. 激活工具栏字段并从相应的列表框选择要编辑的菜单。
4. 点击 Add Command... (添加命令)。

ð Add Command (添加命令) 对话框打开。对话框列出所有按类别分组的命令。
5. 选择要添加的命令并点击 OK (确认)。

ð 新命令添加到工具栏。
6. 使用 Move Up (向上移动) 或 Move Down (向下移动) 按钮更改菜单序列的位置。
7. 点击 Close (关闭)。
ð 对话框关闭。新命令在工具栏中可用。

使用 Customize > Commands (自定义 > 命令) 选项卡中的 Delete (删除) 命令以删除工具栏中的命令。

另请参见：
• 命令：自定义 [} 177]

3.2.3 自定义键盘快捷键
TwinCAT 通过热键提供直接调用命令的选项。您可以自定义或扩展预定义热键。
1. 在 Tools (工具) 菜单中选择 Customize (自定义) 命令。

ð Customize (自定义) 对话框打开。显示 Toolbars (工具栏) 选项卡。
2. 选择 Commands (命令) 选项卡。
3. 点击 Keyboard (键盘)。

ð Options (选项) 对话框打开。
4. 选择列表框中的命令 Show commands containing (显示包含的命令)。
5. 在文本框中输入热键 Press shortcut keys (按下快捷键)。
6. 点击 Assign (分配)。

ð 热键被分配到命令。
7. 点击 OK (确认)。
ð 您现在可以使用热键调用命令。

另请参见：
• 命令：自定义 [} 177]

3.2.4 排列菜单栏和工具栏
菜单栏始终位于标题栏和窗口区域之间的主要用户界面窗口顶部。
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工具栏靠在菜单栏下方，或作为独立窗口位于屏幕的任何位置。

如要移动工具栏，用鼠标指针点击栏左下角的点，然后按住鼠标按键将工具栏拖到所需位置。

3.2.5 排列视图和窗口
在 TwinCAT 中，您可以根据需要轻松调整各窗口的排列。
1. 拖动标题栏或选项卡上的窗口。

ð 显示指示可能位置的箭头图标。
2. 用鼠标将窗口拖到箭头符号上。

ð 目标位置显示为蓝色阴影区域。
3. 松开鼠标左键。
ð 窗口被插入到选定的目标区域。

必要时，可以将窗口置于 TwinCAT 编程界面之外。

另请参见：
• 在视图与窗口之间切换 [} 37]
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• 显示/隐藏视图 [} 37]
• 调整窗口大小 [} 37]

3.2.6 在视图与窗口之间切换
您可以在当前打开的视图与编辑器窗口之间直接切换。
1. 同时按下 [Ctrl] 和 [Tab] 键。继续按住 [Ctrl] 键。

ð 所有活动视图和编辑器的概览打开。
2. 按住 [Ctrl] 键，同时使用箭头键选择窗口。
3. 松开 [Ctrl] 键。
ð 所选视图或所选编辑器激活。

3.2.7 显示/隐藏视图

隐藏视图

如果隐藏一个视图，则该视图只能作为用户界面中的选项卡使用。点击选项卡时，视图会自动弹出。
1. 点击要隐藏的视图。

2. 启用 Window (窗口) 菜单中的 Auto Hide (自动隐藏) 命令或点击视图右上角的  按钮。
ð 视图隐藏并仅由主窗口侧的一个小选项卡指示。

3. 点击选项卡。
ð 视图显示。

Window (窗口) 菜单上的 Hide (隐藏) 命令可关闭视图。

显示视图
1. 点击隐藏视图选项卡。

2. 启用 Window (窗口) 菜单中的 Dock (程序坞) 命令或点击视图右上角的  按钮。
ð 视图永久显示。

另请参见：
• 命令：自动隐藏 [} 181]
• 命令：隐藏 [} 181]
• 命令：程序坞 [} 180]

3.2.8 调整窗口大小
1. 将鼠标移动到两个窗口或视图之间的分隔线上。

ð 光标变成一个双端箭头。
2. 用鼠标将分隔线拖动到所需位置。
ð 一个窗口变大，另一个窗口变小。

您可以通过移动边框线来调整分离窗口的大小。
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4 使用 TwinCAT 文档

4.1 TwinCAT 3 帮助文档访问
从 Visual Studio® 2013 版本开始，如果本地未安装 TwinCAT Information System，则 TwinCAT 3 帮助系统
将使用 Beckhoff Information System。在这种情况下，TwinCAT 3 上下文辅助功能会使用本地的浏览器在线
搜索 Beckhoff Information System 中的相关内容，并根据搜索结果在在网页浏览器中显示。

为此我们需要联网并确认可以访问 https://infosys.beckhoff.com。

如已安装 TwinCAT 3 Information System ，帮助系统将默认使用本地帮助。

在 TwinCAT Help 菜单中（Visual Studio® 2013 及更高版本），可以分别设置使用本地帮助或在线帮助。

在 Help 菜单中打开子菜单“Define help settings”。
• Browser：在 Beckhoff Information System 中在线搜索关于所用的上下文相关的帮助内容。
• Help Viewer：在已安装的本地 TwinCAT 3 Help 中搜索相应的内容

您可以通过 Windows Start 菜单，或者在 TwinCAT 3 Engineering (XAE) 中通过上下文帮助（F1 帮助）或
Help 菜单调用本地帮助系统。

• 通过 Windows Start 菜单调用 TwinCAT 3 帮助文档 [} 40]
• 通过 Help 菜单调用 TwinCAT 3 帮助文档 [} 39]
• 通过上下文辅助功能调用 TwinCAT 3 帮助文档 [} 40]

通过 Windows Start 菜单调用 TwinCAT 3 帮助文档
ü 您已下载并本地安装了 TwinCAT 3 Information System。
ü 在安装过程中在 Windows Start 菜单中会创建了 Help Viewer 的快捷方式。根据系统配置和（预）设定的

安装组件，可能会提供多个可用链接（例如，对于 TwinCAT 3 Information System 的德语和英语版本这
样的版本选择）。

https://infosys.beckhoff.com
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1. 在 Windows Start 菜单中打开 Beckhoff 文件夹。

2. 点击 Information System <Language> - VS <Version>。
ð 通过 HelpViewer 开启TwinCAT 3 Information System。

通过 Help 菜单访问 TwinCAT 3 文档
ü TwinCAT 3 Engineering 已打开。
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1. 菜单栏打开 Help 并选择 Show Help 命令。

ð 通过 Visual Studio® 帮助系统的 Help Viewer 开启 TwinCAT 3 Information System 。在打开的
Help Viewer 树状图中，选择 Help Viewer -
 Home > Welcome to the Beckhoff Information System > TwinCAT 3。

通过上下文帮助访问 TwinCAT 3 帮助文档

使用上下文辅助功能，帮助系统会根据鼠标指针的位置（图形元素）或编辑器中的选定文本内容，来显示相应
的关联帮助信息。

由于语言设置不同，帮助功能受限
如果您在非 Visual Studio® 以外的环境下安装了 TwinCAT 3 Information System，则帮助系统仅能
在有限程度上使用。
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多种显示方式
从 Visual Studio® 2013 版本开始，可以上下文辅助功能可以与 Beckhoff Information System 一起
使用。
根据帮助系统的结果显示方式取决于其设置 [} 38]，可以显示在本地 Help Viewer 或系统的网页浏览
器当中。

以下将为您展示如何使用本地 TwinCAT 3 Help。在线帮助的使用方法与此类似。仅仅是用网页浏览器作为显
示介质。
ü 打开一个 TwinCAT 3 项目。
ü Start in Help Viewer 命令在菜单 Help > Define help settings 中打开（从 Help Viewer 2.0 开始）。
1. 打开支持的基于文本语言的 TwinCAT 3 编程器，如 ST 或 C++ 。
2. 选择所需查询的表达并按 [F1] 键。
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ð Help Viewer 将自动打开，显示与所选表达相关联的 TwinCAT 3 Information System 中的对应文章。

4.2 更新 TwinCAT 3 帮助文档
TwinCAT 3 Information System 的所有语言版本将每周更新一次。本地安装的
TwinCAT 3 Information System 可通过 Visual Studio® 帮助系统进行手动更新。这取决于 Visual Studio® 版
本或帮助系统。

另请参见：
• 安装 TwinCAT 3 帮助文档

4.2.1 在 Visual Studio® 中更新

以下步骤用于更新 TwinCAT 3 Information System ，兼容 Visual Studio® 2012 / 2013 / 2015 /
2017 / 2019 各版本。

安装 TwinCAT 3 Information System 时， Windows Start 菜单中将创建一个条目，用于直接更新
TwinCAT 3 Information System。
ü 可用的互联网连接。
ü 您拥有管理员权限。
1. 在 Windows Start 菜单中打开 Beckhoff 文件夹。
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2. 点击 Update TC3-InfoSys (<Language>) (VS<Version>)。

3. 在打开的对话框中，确认可以对系统进行更改。
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ð 帮助系统将会检查 TwinCAT 3 Information System 是否有更新可用。帮助系统图标将显示在
Windows 菜单栏中。

当您将鼠标指针移动到帮助系统图标上方时，将显示更新进度。

4. 确认 TwinCAT 3 Information System 可以更新。

ð 更新状态显示在 Windows 菜单栏中：

4.2.2 在 Visual Studio® 2010 中更新
如果有可用的互联网连接，安装的 TwinCAT 3 Information System 可以通过 TwinCAT 3 Engineering 中的
Visual Studio® 帮助系统直接进行更新。
ü 可用的互联网连接。
1. 启动 TwinCAT 3 Engineering 或 Visual Studio® 2010。
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2. 从 Help 菜单中选择 Manage Help Settings。

3. 在打开的帮助系统的对话框中，点击 Check for updates online。
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ð 帮助系统会自动检测 TwinCAT 3 Information System 的可用更新。已安装文档组件的可用更新将被
显示出来。

4. 点击 Update 下载可用的更新。
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5. 点击 Yes 确认安装更新包。

ð 在成功更新后点击 Finish 结束对话框。
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5 参照用户界面
TwinCAT 用户界面默认显示主命令。如要自定义菜单配置，从 Tools (工具) 菜单中选择 Customize (自定
义)。

另请参见：
• --- FEHLENDER LINK ---

5.1 文件

5.1.1 存档选项
TwinCAT 开发环境提供了可用于存储 TwinCAT 项目的 3 种不同存档文件类型，例如，用于存档或传递给同
事：tnzip、tszip 和 tpzip。

您应该使用的存档文件的类型取决于您想要在存档文件夹中存储哪些项目。

存档文件类型 焦点 内容 命令
tnzip 解决方案 [} 48] *.tnzip 存档文件夹包含在解决方案中所包含的所有

TwinCAT 项目类型。
这些项目可以是 TwinCAT、TwinCAT HMI、Scope 或
Connectivity 项目。

构建 [} 48]
打开 [} 49]

tszip TwinCAT 项目
[} 49]

*.tszip 存档文件夹包含要存档的 TwinCAT 项目。 构建
打开 [} 49]

tpzip PLC 项目 [} 50] *.tpzip 存档文件夹包含要存档的 PLC 项目。 构建
打开 [} 50]

5.1.1.1 解决方案
• 创建 *.tnzip TwinCAT 解决方案存档：命令将 <solution name> 另存为存档…… [} 48]
• 打开 *.tnzip TwinCAT 解决方案存档：命令从存档中打开解决方案 [} 49]

5.1.1.1.1 命令将 <solution name> 另存为存档……

功能：此命令可打开用于将文件另存为存档的标准对话框。解决方案可作为 *.tnzip 存档保存在目标路径下。

调用：File（文件）菜单，上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择解决方案。

*.tnzip 的内容 *.tnzip 存档文件夹包含在解决方案中所包含的所有 TwinCAT 项目类型。
这些项目可以是 TwinCAT、TwinCAT HMI、Scope 或 Connectivity 项目。

打开命令 使用以下命令可以重新打开 tnzip 存档：
命令从存档中打开解决方案 [} 49]。

关于 PLC 项目的说明 如果解决方案包含 1 个或多个 PLC 项目，则在这些 PLC 项目的存档文件夹中存储
的文件和文件夹将取决于相关项目的 PLC 项目设置。
设置选项卡 [} 111]
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5.1.1.1.2 命令从存档中打开解决方案

功能：此命令可提取 TwinCAT 解决方案存档 *.tnzip。

调用：菜单 File > Open（文件 > 打开）

执行此命令打开 Open（打开）对话框。从文件系统中选择存档文件并确认对话框。Select Folder for new
Solution（选择新解决方案的文件夹）对话框打开。选择用于存储所提取解决方案文件的文件夹。

*.tnzip 的内容 *.tnzip 存档文件夹包含在解决方案中所包含的所有 TwinCAT 项目类型。
这些项目可以是 TwinCAT、TwinCAT HMI、Scope 或 Connectivity 项目。

创建命令 使用以下命令可以创建 tnzip 存档：
命令将 <solution name> 另存为存档…… [} 48]

关于 PLC 项目的说明 如果解决方案包含 1 个或多个 PLC 项目，则在这些 PLC 项目的存档文件夹中存储
的文件和文件夹将取决于相关项目的 PLC 项目设置。
设置选项卡 [} 111]

5.1.1.2 TwinCAT 项目
• 创建 *.tszip TwinCAT 项目存档：命令将 <TwinCAT project name> 另存为存档…… [} 246]
• 打开 *.tszip TwinCAT 项目存档：命令项目/解决方案（打开项目/解决方案） [} 49]

5.1.1.2.1 命令项目/解决方案（打开项目/解决方案）

符号：

热键：[Ctrl] + [Shift] + [O]

功能：此命令可打开用于打开文件的默认对话框。您可以在此处浏览 TwinCAT 项目文件的文件系统并在开发
系统中打开它。

调用：菜单 File > Open（文件 > 打开）

打开项目对话框

文件类型 用于过滤文件类型的选择列表
• 可以打开所有支持格式的文件。

选项 • 添加（例如，该选项仅用于将测量项目添加至解决方案。不要使用该选项将多个
TwinCAT 项目添加至解决方案。）

• 关闭解决方案
打开 TwinCAT 打开所选项目文件。必要时，首先进行转换。

TwinCAT *.tszip 项目存档

*.tszip 的内容 *.tszip 存档文件夹包含要存档的 TwinCAT 项目。
创建命令 使用以下命令可以创建 tszip 存档：

命令将 <TwinCAT project name> 另存为存档…… [} 246]
关于 PLC 项目的说明 如果 TwinCAT 项目包含 1 个或多个 PLC 项目，则在这些 PLC 项目的存档文件夹

中存储的文件和文件夹将取决于相关项目的 PLC 项目设置。
设置选项卡 [} 111]

另请参见：
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• PLC 文档：您的第 1 个 TwinCAT 3 PLC 项目
• PLC 文档：创建标准项目

5.1.1.3 PLC 项目
• 创建 *.tpzip PLC 项目存档：命令将 <PLC project name> 另存为存档…… [} 50]
• 打开 *.tpzip PLC 项目存档：命令添加现有项目（项目） [} 50]

5.1.1.3.1 命令将 <PLC project name> 另存为存档……

功能：此命令可打开用于将文件另存为存档的标准对话框。PLC 项目可作为 *.tpzip 存档保存在目标路径下。

调用：File（文件）菜单，上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT PLC 项目（<PLC project name>）。

存档文件夹中的文件和文件夹取决于 PLC 项目设置。

*.tpzip 的内容 *.tpzip 存档文件夹包含要存档的 PLC 项目。
打开命令 使用以下命令可以重新打开 tpzip 存档：

命令添加现有项目（项目） [} 50]
关于 PLC 项目的说明 在 PLC 项目的存档文件夹中存储的文件和文件夹取决于该 PLC 项目的 PLC 项目

设置。
设置选项卡 [} 111]

5.1.1.3.2 命令添加现有项目（项目）

符号：

功能：此命令可打开标准浏览器对话框，该对话框可用来搜索 PLC 项目文件并在编程系统中打开它。如果安
装了合适的转换器，则您可以打开不同格式的项目。

调用：Project（项目）菜单或 Solution Explorer（解决方案资源管理器）中的 PLC 对象上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 节点。
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文件类型 默认情况下，您可以将筛选器设置为以下 1 种文件类型：
• PLC 3.x 项目文件（*.PLCproject）：TwinCAT 3 PLC 项目，带扩展名“.PLCproject”
• PLC 3.x 项目存档（*.tpzip）：TwinCAT 3 PLC 项目存档，带扩展名“.tpzip”

◦ 另请参见：命令将 <PLC project name> 另存为存档…… [} 50]
• PLC 3.x 库导入（*.library）：TwinCAT 3 PLC 库，带扩展名“.library”
• PLC 2.x 项目文件（*.pro）：TwinCAT 2 PLC 项目，带扩展名“.pro”
• PLC 2.x 导入库（*.lib）：TwinCAT 2 PLC 库，带扩展名“.lib”
• PLC 3.x 项目导入（*.PLCproject）：PLC 项目，带扩展名“.project”

打开 所选项目打开或转换后打开。

*.tpzip PLC 项目存档

*.tpzip 的内容 *.tpzip 存档文件夹包含要存档的 PLC 项目。
创建命令 使用以下命令可以创建 tpzip 存档：

命令将 <PLC project name> 另存为存档…… [} 50]
关于 PLC 项目的说明 在 PLC 项目的存档文件夹中存储的文件和文件夹取决于该 PLC 项目的 PLC 项目

设置。
设置选项卡 [} 111]
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打开 PLC 项目时可能出现的情况

当您打开项目时，可能会出现以下情况：

1. 另一个项目仍打开。 [} 52]
2. 项目以 TwinCAT 3 的旧版本保存。 [} 52]
3. 项目未以 TwinCAT 3 保存。 [} 52]
4. 项目未正确终止并启用“自动保存”。 [} 53]
5. 项目为只读。 [} 53]
6. 该库安装在库的存储库中并从中检索。 [} 53]

1. 另一个项目仍打开。

您会被询问是否保存并关闭其他项目。

2. 项目以 TwinCAT 3 的旧版本保存。

如果因为打开的项目以 TwinCAT 3 的旧版本保存而导致文件格式不同，则有两个选项：
• 如果无法以当前所用编程系统的格式保存项目，则必须对其进行更新以便继续处理项目。此时出现的表

达式：The changes you made... (您作出的更改...) 指加载项目时各组件的内部任务。
• 如果仍将项目保存为之前的格式，则您可以决定是否更新或保留格式。如果您决定保留格式，则数据可

能丢失。如果您决定更新格式，则无法再通过旧版本编程系统打开项目。

除了文件格式外，显式插入库的版本、可视化配置文件以及打开项目的编译器版本可能与当前编程系统安装的
版本不同。

如果在当前编程系统上安装了更新的版本，则 Project Environment (项目环境) 对话框自动打开，您可在其
中更新版本。如果此时未更新，则可在之后随时通过 Options > Project Environment (选项 > 项目环境) 对
话框进行更新。

注意编译器版本
如果打开一个用旧版本编程系统创建的项目，并且在项目设置中设置了该项目的最新编译器版本，则
当编译器版本的项目环境设置在新编程系统中设置为 Do not update (不更新) 时，将继续使用上一
次在旧项目中使用的编译器版本 (即不是新环境中的“当前”版本)。

3. 项目未以 TwinCAT 3 保存。

案例 1)

如果您在选择要打开的项目时设置了文件过滤器，并且有合适的转换器可用，则会自动使用转换器并将项目转
换为当前格式。该转换特定于转换器实现。通常，系统会提示您定义对引用库或设备引用的处理。

TwinCAT 3 转换器
在导入期间，只有在转换器能够编译该项目而且没有错误时才能成功地根据 TwinCAT 3 语法调整
TwinCAT PLC 控制项目。

如果在选择待打开的项目时已设置 All Files (全部文件) 选项，则不启用转换器并且 Convert Project (转换项
目) 对话框打开。在对话框中，您需要通过选择一个选项显式触发项目的转换。

• Convert to the current format (转换至当前格式)：从选择列表中选择您要使用的转换器 (转换应用)。
转换后，无法以旧版本打开该项目。

• Create a new project and add a specific device (创建一个新项目并添加特定设备)：(未实现)

TwinCAT 2.x PLC 控制项目选项
在 TwinCAT 2.x PLC 控制项目选项中设置项目目录路径并且在 Project Information (项目信息) 对
话框中采用项目信息。

案例 2)
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如果库集成在“转换映射”尚未存储在库选项中的项目中，则会出现 Converting a library reference (转换
库引用) 对话框，您可在该对话框中定义如何转换该参考：

• Convert and install the library (转换并安装库)：如果选择此选项，所引用的库将转换为新格式并在
项目中保持引用。它自动安装在 Other (其他) 类别的库存储库中并继续使用。如果库中没有安装所需的
项目信息 (标题、版本)，将提示您在 Enter Project Information (输入项目信息) 对话框中将其输入。

• Use the following library, which is already installed (使用以下已安装的库)：如果您选择了这些选
项，则所引用的库将被已安装在本地系统上的另一个库所替代。使用 Select (选择) 按钮打开 Select...
(选择...) 对话框。您可在此选择其中一个已安装库的所需版本。这对应于在 Library Properties (库属
性) 对话框中处理的版本配置。通常，星号 (“*”) 表示该项目中使用系统上可用库的最新版本。可用库
列表的结构与 Library Repository (库存储库) 对话框中相同。您可以按照公司和类别对列表进行排序。

• Ignore the library (忽视库)。The reference will not appear in the converted project (引用将不
出现在转换后的项目中)：如果您启用该选项，则库引用将被删除。之后，转换后的项目不再包含库。

• Use this mapping in future if this library is present (如果该库存在，则在未来使用该映射)：如果您
启用此选项，则当引用相应库时，在此对话框中所作出的设置将立刻应用于未来的项目转换。

在转换后的项目中，库引用在解决方案资源管理器的全局库管理器中定义。转换库引用后，如上文所述，可通
过 Open Project (打开项目) 对话框继续项目转换。

关于库管理的一般信息，参见 PLC 文档中的“使用库”部分。

案例 3)

当您打开引用了一个未在 TwinCAT 2.x PLC 控制转换器选项中定义“转换映射”的设备的 TwinCAT 2. x PLC
控制项目时，Device Conversion (设备转换) 对话框打开，您可以在其中指定是否以及如何将旧设备引用替
换为更新的设备引用。显示最初使用的设备。选择以下选项之一：

• Use the following already installed device (使用以下已安装的设备)：点击 Select (选择) 按钮打开
Select target system (选择目标系统) 对话框，您可在该对话框中选择当前安装在系统上的一个设备。
之后，该设备被插入到转换项目 (非旧项目) 的 Solution Explorer (解决方案资源管理器) 中。选择
Select a target system...(选择目标系统...) 选项以选择所列出的一个设备。可用设备列表的结构与
Device Repository (设备存储库) 对话框中相同。您可以按照制造商或类别对列表进行排序。

• Ignore the device (忽视设备)。No application-specific objects will be available (没有应用特定对
象可用)：如果启用该选项，在新项目的 Solution Explorer (解决方案资源管理器) 中不会创建设备条
目，即设备在转换过程中被忽视，并且未提供任务配置等应用特定对象。

• Save this assignment for future reference (保存此任务供未来引用)：如果选择该选项，则该对话框
的所有设置，即所显示的设备“转换映射”被保存在 TwinCAT 2.x PLC 控制转换器选项中并且应用于未
来的转换。

4. 项目未正确终止并启用“自动保存”。

如果在 Load and Save (加载并保存) 选项中启用了 Auto Save (自动保存) 功能，并且 TwinCAT 3 PLC 在项
目最后一次修改后在未保存的情况下未定期终止，Auto Save Backup (自动保存备份) 对话框打开以处理备份
副本。

5. 项目为只读。

如果要打开的项目为只读状态，将询问您是以写保护模式打开项目还是要解锁项目。

6. 该库安装在库存储库中并从中检索。

如果尝试打开安装在库存储库中的库项目，将显示一条错误消息。您无法使用此路径打开库项目。通过 OK
(确认) 关闭对话框后，项目名称出现在用户界面的标题栏中。名称后的星号 (“*”) 表示该项目自上次保存以
来已被修改。

另请参见：
• PLC 文档：打开 TwinCAT 3 PLC 项目
• PLC 文档：打开 TwinCAT 2 PLC 项目
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5.1.2 命令：项目... (创建新的 TwinCAT 项目)

符号：

热键：[Ctrl] + [Shift] + [N]

功能：此命令打开用于创建新 TwinCAT 项目文件的 New Project (新项目) 对话框。

调用：菜单 File > New (文件 > 新建)

新项目对话框

根据所选模板，您将获得自动具有一定数量对象的项目。

类别

最近 显示最近使用的项目模板。
已安装 > 模板 显示 TwinCAT 项目模板：

• 其他项目类型
• TwinCAT Measurement
• TwinCAT PLC
• TwinCAT 项目

在线 不相关

模板
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类别：其他项目类型
Visual Studio 解决方案 空白 Visual Studio 解决方案
类别：TwinCAT Measurement
波特图 波特图
Scope Scope YT Project (Scope YT 项目)

Scope YT NC Project (Scope YT NC 项目)
Scope YT Project with Reporting (带报告的 Scope YT 项目)
Scope XY Project (Scope XY 项目)
Scope XY Project with Reporting (带报告的 Scope XY 项目)

类别：TwinCAT PLC
TwinCAT PLC 项目

类别：TwinCAT 项目
TwinCAT XAE 项目

Name 待创建项目的名称。根据模板显示默认名称。数字补充确保文件名在文
件系统中的唯一性。
您可以根据操作系统的文件路径约定更改文件名。名称中不允许有点符
号。
TwinCAT 自动添加与所选模板匹配的文件扩展名。

位置 新项目文件的位置。
Browse (浏览)...按钮打开用于浏览文件系统的对话框。
组合框字段显示之前输入路径的历史。

解决方案 • 创建新的解决方案
• 添加
• 在新实例中创建

创建解决方案目录
 解决方案目录已创建。

解决方案名称 解决方案的名称。默认情况下自动采用 TwinCAT 项目名。
确认 TwinCAT 打开新项目。

另请参见：
• PLC 文档：您的第 1 个 TwinCAT 3 PLC 项目
• PLC 文档：创建标准项目

5.1.3 命令项目/解决方案（打开项目/解决方案）

符号：

热键：[Ctrl] + [Shift] + [O]

功能：此命令可打开用于打开文件的默认对话框。您可以在此处浏览 TwinCAT 项目文件的文件系统并在开发
系统中打开它。

调用：菜单 File > Open（文件 > 打开）
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打开项目对话框

文件类型 用于过滤文件类型的选择列表
• 可以打开所有支持格式的文件。

选项 • 添加（例如，该选项仅用于将测量项目添加至解决方案。不要使用该选项将多个
TwinCAT 项目添加至解决方案。）

• 关闭解决方案
打开 TwinCAT 打开所选项目文件。必要时，首先进行转换。

TwinCAT *.tszip 项目存档

*.tszip 的内容 *.tszip 存档文件夹包含要存档的 TwinCAT 项目。
创建命令 使用以下命令可以创建 tszip 存档：

命令将 <TwinCAT project name> 另存为存档…… [} 246]
关于 PLC 项目的说明 如果 TwinCAT 项目包含 1 个或多个 PLC 项目，则在这些 PLC 项目的存档文件夹

中存储的文件和文件夹将取决于相关项目的 PLC 项目设置。
设置选项卡 [} 111]

另请参见：
• PLC 文档：您的第 1 个 TwinCAT 3 PLC 项目
• PLC 文档：创建标准项目

5.1.4 命令：从目标打开项目
功能：此命令加载来自目标系统的项目。

调用：菜单 File > Open (文件 > 打开)

要求：必须配置目标系统的网络路径。

执行此命令将打开网络上的所有设备概览。从该概览中选择目标系统。Select Folder for new Solution (选
择新解决方案的文件夹) 对话框打开。

5.1.5 命令：新项目... (添加新的 TwinCAT 项目)
功能：此命令打开用于在解决方案中创建其他 TwinCAT 项目文件的 New Project (新项目) 对话框。

调用：菜单 File > Add (文件 > 添加)

要求：打开一个 TwinCAT 项目。

例如，仅使用此命令将 Measurement 项目添加到解决方案中。不要使用此命令将多个 TwinCAT 项
目添加至一个解决方案。TwinCAT 目前不支持此功能。

5.1.6 命令：现有项目... (添加现有 TwinCAT 项目)
Function (功能):此命令打开用于将 TwinCAT 项目文件添加至解决方案的 Add Existing Item (添加现有项)
对话框。

Call (调用)：菜单 File  > Add (文件 > 添加)

要求：打开 TwinCAT 项目。
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例如，仅使用此命令将 Measurement 项目添加到解决方案中。不要使用此命令将多个 TwinCAT 项
目添加至一个解决方案。TwinCAT 目前不支持此功能。

5.1.7 命令：最近项目和解决方案
功能：此命令打开最近使用的项目列表，您可以从中选择一个项目打开。

调用：菜单 File (文件)

另请参见：
• PLC 文档：创建并配置项目

5.1.8 命令：保存全部

符号：

功能：此命令保存所有 TwinCAT 项目的对象。

调用：File (文件) 菜单，标准工具栏选项

5.1.9 命令：保存

符号：

热键：[Ctrl] + [S]

功能：此命令保存解决方案、TwinCAT 项目、TwinCAT PLC 项目或当前名称下所选的 PLC 对象 (主、
GVL ...)。

调用：File (文件) 菜单，标准工具栏选项

要求：在 Solution Explorer (解决方案资源管理器) 中选择待保存的解决方案、TwinCAT 项目对象、PLC 项
目对象 (<PLC project name> 项目) 或 PLC 对象。

保存对象

此命令以当前名称保存对象。如果对象自上次保存后发生变更，则对象的“磁盘”图标为红色，打开对象的编
辑器标题栏中的名称用星号标记 ("*")。

另请参见：
• 命令：将 <TwinCAT project name> 另存为 [} 58]

5.1.10 命令将 <Solution name> 另存为
功能：此命令可打开用于保存文件的默认对话框。解决方案可保存在目标路径下。默认选择文件类型 UTF-8
解决方案文件（* .sln）。

调用：菜单 File（文件）

要求：在 Solution Explorer（解决方案资源管理器）中选择解决方案。
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5.1.11 命令：将 <TwinCAT project name> 另存为
功能：此命令打开用于保存文件的默认对话框。项目可保存在目标路径和文件类型下。默认选择文件类型
TwinCAT XAE 项目 (*.tsproj)。

调用：菜单 File (文件)

要求：在 Solution Explorer (解决方案资源管理器) 中选择 TwinCAT 项目对象。

注意：例如，在此保存操作过程中，仅在不同位置创建 *.tsproj 文件。所引用项目和其中包含的对象不会存储
在这个新位置 (例如集成在 TwinCAT 3 项目中的 PLC 项目及其对象)。

另请参见：
• 命令：保存 [} 57]
• PLC 文档：

5.1.12 命令将 <PLC project name> 另存为
功能：此命令可打开用于指定 PLC 项目文件的目标目录的对话框。PLC 项目对象和 .plcproj 文件保存在所选
目录中。

调用：PLC 项目对象上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 PLC 项目对象（<PLC project name>）。

5.1.13 命令创建反汇编文件
功能：该命令可从当前项目中创建 <project name>.asm 反汇编文件，并将它保存在项目文件夹中的文件目录
中。

调用：PLC 菜单 > 创建反汇编文件

5.1.14 命令：通过电子邮件发送...

符号：

功能：此命令启动系统中设置的电子邮件程序并打开一个新电子邮件，该邮件以所选项目的存档文件作为附
件。

调用：File (文件) 菜单，上下文菜单

5.1.15 命令：关闭解决方案

符号：

功能：此命令关闭当前打开的项目。TwinCAT 保持打开。

调用：File (文件) 菜单或在项目仍打开的情况下打开一个新的/不同的项目时隐藏。

如果项目包含未保存的更改，则会出现是否应保存项目的问询。

如果尚未显示保存项目，则会出现确认是否要删除该项目文件的问询。

另请参见：
• PLC 文档：创建和配置 PLC 项目
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5.1.16 命令：关闭
功能：此命令关闭打开的编辑器。

调用：菜单 File (文件)

要求：待关闭的编辑器处于活动状态，或在 PLC 项目树中选择对象。

5.1.17 命令：退出

符号：

热键：[Alt] + [F4]

功能：此命令停止编程系统。如果当前打开一个自上次保存后已被更改的项目，则出现是否要保存该项目的问
询对话框。

调用：菜单 File (文件)

5.1.18 命令：页面设置...

符号：

功能：此命令打开用于配置项目内容打印版本布局的 Page settings (页面设置) 对话框。

调用：菜单 File (文件)

要求：编辑器窗口处于活动状态。

另请参见：
• 命令：打印 [} 59]

5.1.19 命令：打印

符号：

功能：此命令打开用于打印文档的标准 Windows 对话框。

调用：菜单 File (文件)

要求：编辑器窗口处于活动状态。
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5.2 编辑

5.2.1 标准命令
TwinCAT 提供以下标准命令：

• 撤销

，热键：[Ctrl] + [Z]
• 重做：

，热键：[Ctrl] + [Y]
• 剪切

，热键：[Ctrl] + [X]
• 复制：

，热键：[Ctrl] + [C]
• 粘贴：

，热键：[Ctrl] + [C]
• 删除：

，热键：[Del]
• 全选：热键：[Ctrl] + [A]

Call: Edit (调用：编辑) 菜单，PLC 项目树上下文菜单，编辑器窗口上下文菜单

并非所有编辑器都支持 Paste (粘贴) 命令，或者此命令的应用受到限制。在图形编辑器中，仅当粘贴操作创建
正确的结构时才支持该命令。

在 PLC 项目树中，该命令指当前所选对象。可以作出多个选择。

5.2.2 命令删除
热键：[Del]

功能：此命令可从解决方案中删除所选的 PLC 对象。对象留在项目目录中。

调用：PLC 对象上下文菜单

5.2.3 命令全选
热键：[Ctrl + A]

功能：此命令可选择整个内容。

调用：Edit（编辑）菜单，编辑器窗口上下文菜单

5.2.4 命令：输入助手

符号：



参照用户界面

TE1000 61版本： 2.15.0

热键：[F2]

功能：此命令打开 Input Assistant (输入助手) 对话框，根据当前光标位置为编程元素的选择提供支持。

调用：Edit (编辑) 菜单，编辑器窗口上下文菜单

要求：POU 在编辑器中打开，光标位于程序行中。

输入助手对话框 - 类别选项卡

对话框提供所有编程元素，您可以将其添加到编辑器中的当前光标位置。这些元素根据类别排序。此外，您还
可以在 Variables（变量）类别中为范围设置筛选器，例如，局部变量、全局变量或常量。

编辑器的声明部分中的 Input Assistant（输入助手）对话框的详细信息：

编辑器的实现部分中的 Input Assistant（输入助手）对话框：
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结构化视图
：元素以树状结构显示。通过右键点击子菜单中的列标题，您可以隐藏或显

示类型列、地址列和原点列。

：元素以扁平结构显示。
筛选器 您可以在下拉列表框中设置附加的变量类型筛选器。
显式文档

：显示所选项目的描述。
带参数插入

：TwinCAT 在光标位置插入带函数等参数的元素以及这些参数。
示例：如果您插入包含输入变量 fb1_in 和输出变量 fb1_out 的功能块 fb1，“带
参数”，则在编辑器中显示如下：fb1(fb1_in:= , fb1_out=> )

带命名空间前缀插入
：TwinCAT 插入带命名空间前缀的所选元素。对于库功能块，如果库属性指

定命名空间为必填项，您将无法使用复选框。

输入助手对话框 - 文本搜索选项卡

您可以使用该选项卡搜索特定对象。当您在搜索框中键入一个或多个字符时，结果窗口将列出名称包含此搜索
字符串的所有对象的名称。双击所需对象以将其插入到当前光标位置的编辑器。

过滤器 将搜索限制为特定的变量类别。

另请参见：
• PLC 文档：使用输入向导

5.2.5 命令：自动声明
功能：此命令可打开支持变量声明的 Auto Declare（自动声明）对话框。

调用：Edit（编辑）菜单；编辑器窗口上下文菜单

要求：POU 在编辑器中打开，光标位于程序行中。

即使光标位于 POU 实现部分中包含未声明变量名称的行，自动声明功能也将打开 Auto Declare（自动声明）
对话框。为此，您必须在 TwinCAT 选项（Extras > Options > TwinCAT > PLC Programming
Environment > Smart Coding）（附加功能 > 选项 > TwinCAT > PLC 编程环境 > 智能编码）中激活选项
Declare unknown variables automatically (AutoDeclare)（自动声明未知变量（AutoDeclare））。

由于存在智能标签功能，因此，如果您将光标放在 ST 编辑器的实现部分中尚未声明的变量上，然后点击

，也会出现命令 Auto Declare（自动声明）（Build 4026 及以上版本）。
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自动声明对话框
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Scope 尚未声明的变量的有效范围。
示例：VAR (本地变量的默认设置)

Name 尚未声明的变量名
示例：bVar

数据类型
 ：列出标准数据类型。

 :
• 输入助手：打开 Input Assistant (输入助手) 对话框
• 阵列辅助：打开 Array (阵列) 对话框
示例：BOOL

对象 声明新变量的对象。默认为您正在编辑的对象。

 ：列出可以声明变量的对象。
如果所选范围没有可用对象，则显示条目 <Create object>。如果选择 <Create
object> 条目，则用于创建合适对象的对话框 Add object (添加对象) 打开。

初始值 如果未输入初始化值，则变量会自动初始化。

 ：打开 Initialization (初始化) 对话框。此方法有助于初始化结构变量。
示例：FALSE

地址 存储器地址 (参见 PLC 文档：地址)
示例：%IX1.0

标记 属性关键词
• CONSTANT：常量关键词
• RETAIN：保留型变量关键词
• PERSISTENT：持久型变量关键词 (比 RETAIN 更严格)
所选属性关键词被添加至变量声明。

注释 表格声明编辑器显示输入到注释列中的注释。在文本声明编辑器中，它显示在变量声
明上方。
示例：New variable

通过重构应用更改 此选项用于以下有效性范围：
• 输入变量 (VAR_INPUT)
• 输出变量 (VAR_OUTPUT)
• 输入和输出变量 (VAR_IN_OUT)
如果在 TwinCAT 选项 (Tools > Options > TwinCAT > PLC
Environment > Refactoring (工具 > 选项 > TwinCAT > PLC 环境 > 重构) 中启用自
动声明选项 On renaming variables (重命名变量) 和 On adding or removing
variables, or on changing the scope (添加或删除变量或更改范围) ，此选项自动
启用 (参见对话框选项 - 重构 [} 163])。
如果启用此选项，则在关闭对话框时尚未声明变量。相反，Refactoring (重构) 对话
框将打开，可在其中进一步编辑更改。

确认 变量被声明并出现在声明中。
示例：
VAR
    // New variable
    bVar: BOOL := FALSE;
END_VAR

另请参见：
• PLC 文档：声明变量
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阵列对话框

等级和基本类型规格 通过输入阵列的上下边界和基本类型定义字段大小 (维度)。如果点击  按钮，您可
以直接输入或者使用 Input Assistant (输入助手) 或 Array (阵列) 对话框输入基本类
型。

结果 显示定义的阵列。

TwinCAT 只在更改变量的初始值时才重新初始化变量。

初始化值对话框
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变量列表，包括名称（表达式）、初始化值和数据类型。
已更改的初始化值以粗体显示。
列表下的输入字段 输入所选变量的初始化值。
将值应用于所选行 根据输入字段的值更改所选行的初始化值。
将所选行重置为默认值 设置默认的初始化值。
确定 TwinCAT 采用 Auto Declare（自动声明）对话框中的初始化值。

如果要通过此对话框初始化的变量是带有扩展 FB_Init 方法的功能块实例，则在初始化值表格上方会显示另一
个表格（请参见 PLC 文档：方法 FB_init、FB_reinit 和 FB_exit）。本表格列出了附加的 FB_Init 参数。含义
和操作与下方表格基本相同，区别如下：

• 必须为所有变量分配初始化值。否则无法选择 OK（确定）。
• 对于复杂数据类型（结构、数组），不会显示其中包含的组件（类型无法扩展）。在这种情况下，必须

使用相应的变量对复杂类型进行初始化。

对于以这种方式配置的 FB_Init 参数，在 Auto Declare（自动声明）对话框中的初始化值后面会显示 1 个相
应的符号。

另请参见：
• PLC 文档：使用输入向导

5.2.6 命令：添加至监视

符号：

功能：此命令将光标当前所在的变量添加到监视列表以进行在线监控。

调用：上下文菜单

要求：PLC 项目处于在线模式，且光标位于编辑器中的变量上。

该命令将变量插入当前打开的监视列表中。如果当前未打开监视列表，则该命令将变量插入监视列表 1 并打开
其视图。

另请参见：
• PLC 文档：使用监视列表
• PLC 文档：监控值

5.2.7 命令：浏览调用树

符号：

功能：此命令打开 Call Tree (调用树) 视图，其中显示功能块调用及其调用端。

调用：编辑器窗口上下文菜单

要求：在编辑器中打开功能块，且光标位于变量中。

5.2.8 命令：转至
功能：此命令将光标移动至指定代码行。

调用：菜单 Edit (编辑)

要求：POU 在编辑器中打开，光标位于程序行中。

命令打开对话框和一个 Line number (行号) 输入字段。
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5.2.9 命令转至定义

符号：

热键：[F12]

功能：此命令可显示变量或功能的定义点。

PLC 编辑器

调用：编辑器窗口上下文菜单

要求：POU 在编辑器中打开，光标位于变量或功能上。

PLC 过程映像

调用：解决方案资源管理器上下文菜单

要求：扩展过程映像（项目实例），光标位于过程映像中已分配的变量处。

5.2.10 命令转至实例

符号：

功能：此命令可在新窗口中打开功能块的实例。

调用：编辑器窗口上下文菜单

要求：PLC 项目处于在线模式。POU 在编辑器中打开，光标位于功能块的实例上。

该命令不适用于临时实例或编译库中的实例。

5.2.11 命令转至实现

符号：

功能：此命令可在新窗口中打开方法的在线视图。

调用：编辑器窗口上下文菜单

要求：PLC 项目处于在线模式。POU 在编辑器中打开，光标位于方法调用上。

TwinCAT 3.1 Build 4026 及以上版本可用

5.2.12 命令转至引用

符号：

功能：此命令可在在线模式中打开当前聚焦指针所引用变量的声明位置。

调用：编辑器窗口上下文菜单

要求：PLC 项目处于在线模式。POU 在编辑器中打开，光标位于指针上。引用的变量位于静态内存中。

如果指针没有精确地指向变量的开头，则在切换到变量声明时会输出相应的消息。



参照用户界面

TE100068 版本： 2.15.0

TwinCAT 3.1 Build 4026 及以上版本可用

5.2.13 命令查找所有引用
热键：[Shift+F12]

功能：此命令可显示 Cross Reference List（交叉引用列表）视图中所用变量的所有位置。

调用：上下文菜单

要求：POU 在编辑器中打开，并且光标位于变量上，或者 Cross Reference List（交叉引用列表）视图打
开，并且在 Name（名称）字段中指定 1 个变量。

另请参见：
• PLC 文档：查找使用交叉引用列表的位置

5.2.14 命令：导航至
功能：此命令打开用于选择待打开特定元素的对话框。

调用：菜单 Edit (编辑)

5.2.15 命令：大写
功能：此命令将所选代码中的所有小写字母转换为大写字母。

调用：菜单 Edit > Advanced (编辑 > 高级)

要求：POU 在编辑器中打开，并选择代码。

5.2.16 命令：小写
功能：此命令将所选代码中的所有大写字母转换为小写字母。

调用：菜单 Edit > Advanced (编辑 > 高级)

要求：POU 在编辑器中打开，并选择代码。

5.2.17 命令：查看空白处

符号：

功能：此命令可显示空格和选项卡的控制字符。

调用：菜单 Edit > Advanced (编辑 > 高级)

要求：POU 在编辑器中打开。

TwinCAT 用点显示空间，用箭头显示制表符。

5.2.18 命令注释选择
热键：[Ctrl+K] + [Ctrl+C]
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功能：此命令可注释掉所选的代码段。该代码段会被排除在编译之外，对程序的执行没有任何影响。

调用：菜单 Edit > Advanced（编辑 > 高级）

要求：功能块在编辑器中打开，并选择代码。

该命令可用于为程序或程序段的文档创建注释，或从编译中临时排除代码段。命令 命令取消注释选择 [} 69]
可用于取消注释，以便将注释掉的代码段重新集成到程序执行中。

5.2.19 命令取消注释选择
热键：[Ctrl+K] + [Ctrl+U]

功能：此命令可取消注释，并将注释掉的代码段重新集成回到程序执行中。

调用：菜单 Edit > Advanced（编辑 > 高级）

要求：功能块在编辑器中打开，并选择先前使用命令 命令注释选择 [} 68] 注释掉的代码。

5.2.20 命令：快速查找

符号：

热键：[Ctrl] + [F]

功能：此命令扫描项目或项目的一部分以搜索特定字符串。

调用：菜单 Edit > Find and Replace (编辑 > 查找和替换)

命令打开 Find and Replace (查找和替换) 对话框 (Find in Files (在文件中查找) 按钮启用)，可在此对话框中
输入搜索字符串和搜索选项。
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查找并替换对话框
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在文件中替换 切换至 Find and Replace (查找和替换) 对话框 (Replace in Files (在文件中替换)
按钮启用)

查找内容 搜索字符串。
查看

：带被搜索对象的选择列表：
整个解决方案：扫描所有项目对象中的所有可编辑位置。
当前项目：
所有打开的文件：扫描窗口中当前打开的所有编辑器。
当前文档：仅搜索光标当前所在的编辑器。

：打开可以更精确定义待搜索对象的对话框。
区分大小写

：该搜索区分大小写。
全字匹配

：仅查找与搜索字符串完全匹配的字符串。
查看这些文件类型 用于选择文件类型的下拉列表
使用正则表达式

启用  按钮，以帮助您输入正则表达式。
该功能不支持 PLC 编辑器！

仅显示文件名
：仅显示文件名。

查找下一个 开始搜索。下一个搜索结果显示在相应编辑器中的对应位置。
查找全部 在消息窗口中显示所有搜索结果。显示对象和搜索结果的具体位置。

• (Decl)：对象的声明部分
• (Impl)：对象的实现部分
双击列表条目以显示编辑器中的搜索结果。

另请参见：
• 命令：快速替换 [} 71]
• PLC 文档：在整个项目中查找和替换

5.2.21 命令：快速替换

符号：

热键：[Ctrl] + [H]

功能：此命令扫描项目或项目的一部分以搜索特定字符串并将其替换。

调用：菜单 Edit > Find and Replace (编辑 > 查找和替换)

命令打开 Find and Replace (查找和替换) 对话框 (Replace in Files (在文件中替换) 按钮启用)，可在此对话
框中输入待替换的字符串和新字符串以及搜索选项。
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查找并替换对话框

除了“Find” (查找) 对话框中的选项之外，还可以进行以下设置：

替换为 新字符串的输入字段。
替换 查找到的下一个字符串在编辑器中高亮显示并替换 (逐步替换)。
全部替换 立即替换查找到的所有字符串并且不在编辑器中显示。
在全部替换后将修改后的
文件保持在打开状态

查找到的对象的编辑器保持打开状态。

另请参见：
• 命令：快速查找 [} 69]
• PLC 文档：在整个项目中查找和替换

5.2.22 命令：切换写入模式
热键：[Insert]
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功能：此命令启动覆盖模式或插入模式。

调用：双击状态和信息栏中的 [INS] 或 [OVR]

要求：编辑器窗口处于活动状态。

如果覆盖模式激活，则在输入新字符时会覆盖光标后的字符。如果插入模式激活，则插入字符时保留光标后的
现有字符。

5.2.23 命令：重命名
功能：此命令可对 Solution Explorer (解决方案资源管理器) 中的 PLC 对象进行重命名。

调用：PLC 对象上下文菜单

5.2.24 命令：编辑对象 (脱机)
功能：此命令在其编辑器中脱机打开对象。

调用：Project (项目) 菜单，上下文菜单

要求：PLC 项目处于在线模式。在 PLC 项目树中选择对象。

这意味着您也可以在在线模式中编辑对象。之后，通过 Online Change (在线更改) 或 Download (下载) 将更
改发送到控制器。

另请参见：
• 命令在线更改 [} 141]
• 命令：下载 [} 140]

5.2.25 命令：重命名 '<variable>'
功能：此命令打开 Rename (重命名) 对话框以对对象或变量进行重命名。

调用：上下文菜单 PLC object (PLC 对象)，上下文菜单 Editor window > Refactoring (编辑器窗口 > 重构)

要求：在 PLC 项目树中选择对象，或者光标位于编程对象声明部分变量识别符前或之上。

您可以重命名：
• 变量
• POU
• GVL
• 方法
• 属性

重命名对话框

当前名称 对象或变量名
新名称 新名称的输入字段。

如果输入的名称已存在，TwinCAT 将在该输入字段正下方报告这一情况。
确认 如果已在 New Name (新名称) 中输入有效名称，则可激活。

打开 Refactoring (重构) 对话框。
两个窗口中的各对象和位置均以颜色标记。
在两个窗口中可以为每个位置指定一个操作。可在上下文菜单中使用不同命令。
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重构对话框

该对话框显示项目内的所有使用位置。各对象和位置以颜色高亮显示。
对话框左部 带各自对象的项目导航树。
对话框右部 显示对象中出现当前名称的位置。
在两个窗口中可以为每个位置指定一个操作。可在上下文菜单中使用以下命令。
拒绝此更改 放弃对话框右侧的各个更改。
接受此对象 接受受影响对象中的所有更改
拒绝此对象 放弃受影响对象中的所有更改
接受整个项目 接受项目中的所有更改
拒绝整个项目 放弃项目中的所有更改
TwinCAT 通过黄色背景显示接受的更改，通过灰色背景显示放弃的更改。

另请参见：
• PLC 文档：重构

5.2.26 命令：添加 '<variable>'

符号：

功能：此命令在 POU 中声明一个新变量并且在 POU 使用点自动更新。

调用：上下文菜单 Editor window > Refactoring (编辑器窗口 > 重构)

要求：重点在于 POU 的声明部分。

此命令打开用于声明变量的默认对话框。使用 OK (确认) 关闭声明对话框后，将出现由两部分组成的
Refactoring (重构) 对话框。
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重构对话框

对话框左部 项目导航树。
使用 POU 的功能块颜色：红色字体，黄色背景。
点击 POU 对象后，详细视图在对话框右部打开。

对话框右部 声明部分和在声明中添加变量的 POU 实现部分。
更改点的颜色：新添加的声明使用蓝色字体，黄色背景。

在决定要在哪些点应用哪些更改之前，请从右上角的下拉列表中选择所需选项：

添加带占位符文本的输入 默认占位符文本：_REFACTOR_；可编辑
此处定义的占位符文本出现在实现代码中新添加变量的使用点。用于查找受影响的
位置。

添加带以下值的输入 新变量的初始化值

可在对话框左部和右部的变更点上下文菜单使用接受或拒绝更改的命令。另请参见 命令：重命名 '<variable>'
[} 73] 的描述。

示例：

1. 通过重构，功能 F_Sample 被分配一个带初始值“1”的新输入变量“nInput3”。此更改具有以下效果：

之前：
F_Sample(nVarA + nVarB, 3, TRUE);
F_Sample(nInput1:= nVarA + nVarB, nInput2 :=3 , nInputx := TRUE);

之后：
F_Sample(nVarA + nVarB, 3, TRUE, nInput3 := 1);
F_Sample(nInput1:= nVarA + nVarB, nInput2 :=3 , nInputx := TRUE, nInput3 := 1);

2. 通过重构，功能 F_Sample 被分配一个带占位符文本“_REFACTOR_”的新输入变量“nInput3”。

之前：
F_Sample(nInput1 := nVarA + nVarB, nInput2 := 3, nInputx := TRUE);
F_Sample(nVarA + nVarB, 3, TRUE);

之后：
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F_Sample(nInput1 := nVarA + nVarB, nInput2 := 3, nInputx := TRUE, nInput3 := _REFACTOR_);
F_Sample(nVarA + nVarB, 3, TRUE, nInput3 := _REFACTOR_);

另请参见：
• PLC 文档：重构
• PLC 文档：自动声明对话框 [} 63]

5.2.27 命令：删除 '<variable>'

符号：

功能：此命令删除 POU 和所有 POU 使用点中的输入或输出变量。

调用：上下文菜单 Editor window > Refactoring (编辑器窗口 > 重构)

要求：光标位于 POU 声明部分中待删除的变量识别符上。

此命令首先打开一个对话框，显示所要删除的信息。确认后，Refactoring (重构) 对话框出现。关于对话框的
描述，可参见“命令：添加 '<variable>' [} 74]”部分。

如果接受 Refactoring (重构) 对话框中的更改，则删除受影响 POU 的使用点处的相应输入或输出参数。

在 CFC 中，仅断开被删除的输入或输出与功能块的连接。图中保留了输入或输出本身。

ST 中的样本：

使用 Refactoring (重构) 删除 POU 中的输入变量“nInput4”。在各使用点进行自动调节：

删除前：
F_Sample(nInput1 := nVarA + nVarB, nInput2 := 3, nInput4 := 1, nInput5 := TRUE);
F_Sample(nVarA + nVarB, 3, 1, TRUE);

删除后：
F_Sample(nInput1 := nVarA + nVarB, nInput2 := 3, nInput5 := TRUE);
F_Sample(nVarA + nVarB, 3, TRUE);

另请参见：
• PLC 文档：重构

5.2.28 命令：重新排序变量

符号：

功能：在声明编辑器中，您可使用此命令更改当前重点范围 VAR_INPUT、VAR_OUTPUT 或 VAR_IN_OUT 中
的变量序列。

调用：声明编辑器中当前重点范围的上下文菜单

要求：重点是声明上述范围之一，并在其中声明多个变量。

此命令打开 Rearrange (重新排列) 对话框，其中带有当前重点范围的所有声明列表。您可以使用鼠标将所选
声明向上或向下拖动到其他位置。

另请参见：
• PLC 文档：在声明中重新排列变量
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5.3 视图

5.3.1 命令：打开对象

符号：

功能：此命令打开编辑器中的对象。

调用：View (视图) 菜单，上下文菜单 PLC 对象，双击 PLC 对象

要求：在 PLC 项目树中选择一个对象。

在在线模式中，Select Online State (选择在线状态) 对话框打开，您可在其中选择查看应打开对象的视图。
明确选择对象时，对话框不会打开。在此情况下，直接在在线模式中打开。

选择在线状态对话框

功能：此对话框确认如何在在线模式中打开未在脱机模式中打开的对象 (功能块等)。您可以选择打开一个实例
或对象本身的基本实现 (可在在线或脱机模式中选择)。

要求：PLC 项目包含所选对象的多个实例。

在线模式 启用该选项以在在线模式中获得视图。
设备/应用 显示被分配该对象的应用 (项目)。
功能块实例 如果对象是功能块，则显示应用中当前使用的所有实例列表。
实现 选择该选项将显示功能块的基本实现，无论所选实例如何。该选项没有用于非实

例化对象的功能。
脱机模式 启用该选项以在脱机模式中获得视图。

5.3.2 命令：文本视图

符号：

功能：此命令在文本视图中打开声明编辑器。

调用：按钮位于编辑器右侧边缘
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另请参见：
• PLC 文档：使用声明编辑器

5.3.3 命令：表格视图

符号：

功能：此命令在表格视图中打开声明编辑器。

调用：按钮位于编辑器右侧边缘

另请参见：
• PLC 文档：使用声明编辑器

5.3.4 命令：全屏

符号：

热键：[Ctrl] + [Shift] + [F12]

功能：此命令将 TwinCAT 显示切换为全屏模式。

调用：View (视图) 菜单

启用该命令时，TwinCAT 用户界面的主窗口将以全屏模式显示。您可以通过再次禁用该命令恢复到预设大
小。

5.3.5 命令：工具栏
功能：此命令打开一个用于选择所显示工具栏的菜单。

调用：View (视图) 菜单，工具栏区域上下文菜单

在打开的菜单中，选择要显示或隐藏的工具栏。该命令是一个选项，即，当工具栏显示时，它会出现在前面带
有一个勾选标记的菜单中。

另请参见：
• TC3 用户界面文档：自定义工具栏 [} 34]
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5.3.6 命令：解决方案资源管理器

符号：

功能：此命令打开 Solution Explorer (解决方案资源管理器) 视图。

解决方案资源管理器视图

Solution Explorer (解决方案资源管理器) 视图以结构化形式显示 TwinCAT 3 项目与相应的项目元素。在此
视图中，您可以打开用于编辑和配置的对象。

5.3.7 命令：属性窗口

符号：

功能：此命令打开 Properties (属性) 视图。

调用：View (视图) 菜单

属性视图

Properties (属性) 视图显示解决方案资源管理器中当前所选对象的属性。元素属性默认为在表中按类别排
序。点击类别前的加号或减号以显示或隐藏相关参数。用鼠标点击参数的值字段将启用输入模式，可在该模式
中编辑值或属性。您可以对属性视图进行筛选或排序。
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您还可以从 PLC 项目树中一个对象的上下文菜单中调出属性窗口。关于命令以及各种对象属性的描述，请参
见命令属性（对象） [} 88] 部分。

5.3.8 命令：工具箱

符号：

功能：此命令打开 Toolbox (工具箱) 视图。

调用：View (视图) 菜单

工具箱视图

Toolbox (工具箱) 视图显示当前处于活动状态的编辑器的现有工具。该视图默认可使用图形编辑器或可视化
工具。它包含图形编辑元素，您可将这些元素拖动到编辑器窗口。
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5.3.9 命令：错误列表

符号：

功能：此命令打开 Error List (错误列表) 视图。

调用：View (视图) 菜单

错误列表视图

Error List (错误列表) 视图显示与语法检查、编译过程 (编译错误、代码大小)、导入过程或库管理器相关的错
误、警告和消息。消息以表格形式显示。
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过滤器 使用用于选择代码文件组的下拉菜单：
打开文档
当前项目
当前文档

消息类别

• ：错误

• ：警告

• ：信息

单击消息类别符号以显示或隐藏消息。在每个符号旁边，TwinCAT 显示已出现
的消息数量。

清除 清除消息显示
清除错误列表的过滤器设置

严重性级别
(消息类别)

消息文本与原因对象以及项目内的位置。
双击表中的消息条目以转至源文本位置。

代码
描述
项目
文件
Line (线条)

上下文菜单中的命令

清除 清除消息显示
显示列 添加附加列，以更详细地描述错误

 复制
复制所选错误消息

下一个错误 选择下一条消息。显示下一个错误的源文本位置。
上一个错误 选择上一条消息。显示上一个错误的源文本位置。

5.3.10 命令：输出

符号：

功能：此命令打开 Output (输出) 视图。

调用：View (视图) 菜单

输出视图
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消息类别 消息按组件或功能分类，并且可以在选择对话框中使用。可以通过选择
一个类别过滤消息显示。

在代码中查找消息

显示消息的源文本位置。
要求：高亮显示消息。

转至上一条消息

已选择上一条消息。

转至下一条消息

已选择下一条消息。

删除全部

删除全部消息

切换换行符

启用或禁用换行符

上下文菜单中的命令

 复制
复制消息文本

 删除全部
删除全部消息

转至位置

显示消息的源文本位置。
要求：高亮显示消息。

转至下一个位置

已选择下一条消息。

转至上一个位置

已选择上一条消息。

5.4 项目

5.4.1 命令添加新项目（项目）

符号：

功能：此命令可打开 Add New Item （添加新项目）对话框，您可以通过该对话框创建新的 PLC 项目文件。
（此命令仅在选择 PLC 节点时可用。）

调用：Project（项目）菜单或 Solution Explorer（解决方案资源管理器）中的 PLC 对象上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 节点。
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Plc 模板 选择所列模板之一。该模板确定 PLC 项目文件的基本配置。默认可用以下模板：
• 标准 PLC 项目：创建 1 个新的 TwinCAT PLC 项目（*.project）。该项目由向导支持，

包含 1 个库管理器、1 个 POU“MAIN”程序和 1 个引用的任务。
• 空 PLC 项目：创建库项目的“空白”TwinCAT PLC 项目（*.library）。该项目未包含

对象或设备。
名称 在此处定义新项目的名称。默认名称取决于所选模板（通常是“Unnamed<n>”）并且

包含序号，以确保项目名称在文件系统中的唯一性。您可以根据本地操作系统的文件路径
约定来更改默认名称。可添加文件扩展名（例如，.project）。所选模板默认自动添加相
应的扩展名。

位置 指定新项目文件的位置。默认路径取决于所选模板。您可以使用 Browse...（浏览……）
按钮打开默认浏览器并指定路径，或者您可以使用相应的下拉列表选择先前输入的路径。

添加 点击 Add（添加）创建基于设置的新项目。如果光标位于错误符号上，则工具提示会提供
关于如何继续的信息。如果另一个 PLC 项目已打开，则会打开 1 个对话框询问您是否要
在打开新项目之前保存并关闭该项目。新项目名称显示在 TwinCAT XAE 边框窗口的标题
栏中。名称后的星号（“*”）表示该项目自上次保存以来已被修改。

另请参见：
• PLC 文档：您的第 1 个 TwinCAT 3 PLC 项目
• PLC 文档：创建和配置 PLC 项目

5.4.2 命令添加现有项目（项目）

符号：

功能：此命令可打开标准浏览器对话框，该对话框可用来搜索 PLC 项目文件并在编程系统中打开它。如果安
装了合适的转换器，则您可以打开不同格式的项目。

调用：Project（项目）菜单或 Solution Explorer（解决方案资源管理器）中的 PLC 对象上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 节点。



参照用户界面

TE1000 85版本： 2.15.0

文件类型 默认情况下，您可以将筛选器设置为以下 1 种文件类型：
• PLC 3.x 项目文件（*.PLCproject）：TwinCAT 3 PLC 项目，带扩展名“.PLCproject”
• PLC 3.x 项目存档（*.tpzip）：TwinCAT 3 PLC 项目存档，带扩展名“.tpzip”

◦ 另请参见：命令将 <PLC project name> 另存为存档…… [} 50]
• PLC 3.x 库导入（*.library）：TwinCAT 3 PLC 库，带扩展名“.library”
• PLC 2.x 项目文件（*.pro）：TwinCAT 2 PLC 项目，带扩展名“.pro”
• PLC 2.x 导入库（*.lib）：TwinCAT 2 PLC 库，带扩展名“.lib”
• PLC 3.x 项目导入（*.PLCproject）：PLC 项目，带扩展名“.project”

打开 所选项目打开或转换后打开。

*.tpzip PLC 项目存档

*.tpzip 的内容 *.tpzip 存档文件夹包含要存档的 PLC 项目。
创建命令 使用以下命令可以创建 tpzip 存档：

命令将 <PLC project name> 另存为存档…… [} 50]
关于 PLC 项目的说明 在 PLC 项目的存档文件夹中存储的文件和文件夹取决于该 PLC 项目的 PLC 项目

设置。
设置选项卡 [} 111]
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打开 PLC 项目时可能出现的情况

当您打开项目时，可能会出现以下情况：

1. 另一个项目仍打开。 [} 86]
2. 项目以 TwinCAT 3 的旧版本保存。 [} 86]
3. 项目未以 TwinCAT 3 保存。 [} 86]
4. 项目未正确终止并启用“自动保存”。 [} 87]
5. 项目为只读。 [} 87]
6. 该库安装在库的存储库中并从中检索。 [} 87]

1. 另一个项目仍打开。

您会被询问是否保存并关闭其他项目。

2. 项目以 TwinCAT 3 的旧版本保存。

如果因为打开的项目以 TwinCAT 3 的旧版本保存而导致文件格式不同，则有两个选项：
• 如果无法以当前所用编程系统的格式保存项目，则必须对其进行更新以便继续处理项目。此时出现的表

达式：The changes you made... (您作出的更改...) 指加载项目时各组件的内部任务。
• 如果仍将项目保存为之前的格式，则您可以决定是否更新或保留格式。如果您决定保留格式，则数据可

能丢失。如果您决定更新格式，则无法再通过旧版本编程系统打开项目。

除了文件格式外，显式插入库的版本、可视化配置文件以及打开项目的编译器版本可能与当前编程系统安装的
版本不同。

如果在当前编程系统上安装了更新的版本，则 Project Environment (项目环境) 对话框自动打开，您可在其
中更新版本。如果此时未更新，则可在之后随时通过 Options > Project Environment (选项 > 项目环境) 对
话框进行更新。

注意编译器版本
如果打开一个用旧版本编程系统创建的项目，并且在项目设置中设置了该项目的最新编译器版本，则
当编译器版本的项目环境设置在新编程系统中设置为 Do not update (不更新) 时，将继续使用上一
次在旧项目中使用的编译器版本 (即不是新环境中的“当前”版本)。

3. 项目未以 TwinCAT 3 保存。

案例 1)

如果您在选择要打开的项目时设置了文件过滤器，并且有合适的转换器可用，则会自动使用转换器并将项目转
换为当前格式。该转换特定于转换器实现。通常，系统会提示您定义对引用库或设备引用的处理。

TwinCAT 3 转换器
在导入期间，只有在转换器能够编译该项目而且没有错误时才能成功地根据 TwinCAT 3 语法调整
TwinCAT PLC 控制项目。

如果在选择待打开的项目时已设置 All Files (全部文件) 选项，则不启用转换器并且 Convert Project (转换项
目) 对话框打开。在对话框中，您需要通过选择一个选项显式触发项目的转换。

• Convert to the current format (转换至当前格式)：从选择列表中选择您要使用的转换器 (转换应用)。
转换后，无法以旧版本打开该项目。

• Create a new project and add a specific device (创建一个新项目并添加特定设备)：(未实现)

TwinCAT 2.x PLC 控制项目选项
在 TwinCAT 2.x PLC 控制项目选项中设置项目目录路径并且在 Project Information (项目信息) 对
话框中采用项目信息。

案例 2)



参照用户界面

TE1000 87版本： 2.15.0

如果库集成在“转换映射”尚未存储在库选项中的项目中，则会出现 Converting a library reference (转换
库引用) 对话框，您可在该对话框中定义如何转换该参考：

• Convert and install the library (转换并安装库)：如果选择此选项，所引用的库将转换为新格式并在
项目中保持引用。它自动安装在 Other (其他) 类别的库存储库中并继续使用。如果库中没有安装所需的
项目信息 (标题、版本)，将提示您在 Enter Project Information (输入项目信息) 对话框中将其输入。

• Use the following library, which is already installed (使用以下已安装的库)：如果您选择了这些选
项，则所引用的库将被已安装在本地系统上的另一个库所替代。使用 Select (选择) 按钮打开 Select...
(选择...) 对话框。您可在此选择其中一个已安装库的所需版本。这对应于在 Library Properties (库属
性) 对话框中处理的版本配置。通常，星号 (“*”) 表示该项目中使用系统上可用库的最新版本。可用库
列表的结构与 Library Repository (库存储库) 对话框中相同。您可以按照公司和类别对列表进行排序。

• Ignore the library (忽视库)。The reference will not appear in the converted project (引用将不
出现在转换后的项目中)：如果您启用该选项，则库引用将被删除。之后，转换后的项目不再包含库。

• Use this mapping in future if this library is present (如果该库存在，则在未来使用该映射)：如果您
启用此选项，则当引用相应库时，在此对话框中所作出的设置将立刻应用于未来的项目转换。

在转换后的项目中，库引用在解决方案资源管理器的全局库管理器中定义。转换库引用后，如上文所述，可通
过 Open Project (打开项目) 对话框继续项目转换。

关于库管理的一般信息，参见 PLC 文档中的“使用库”部分。

案例 3)

当您打开引用了一个未在 TwinCAT 2.x PLC 控制转换器选项中定义“转换映射”的设备的 TwinCAT 2. x PLC
控制项目时，Device Conversion (设备转换) 对话框打开，您可以在其中指定是否以及如何将旧设备引用替
换为更新的设备引用。显示最初使用的设备。选择以下选项之一：

• Use the following already installed device (使用以下已安装的设备)：点击 Select (选择) 按钮打开
Select target system (选择目标系统) 对话框，您可在该对话框中选择当前安装在系统上的一个设备。
之后，该设备被插入到转换项目 (非旧项目) 的 Solution Explorer (解决方案资源管理器) 中。选择
Select a target system...(选择目标系统...) 选项以选择所列出的一个设备。可用设备列表的结构与
Device Repository (设备存储库) 对话框中相同。您可以按照制造商或类别对列表进行排序。

• Ignore the device (忽视设备)。No application-specific objects will be available (没有应用特定对
象可用)：如果启用该选项，在新项目的 Solution Explorer (解决方案资源管理器) 中不会创建设备条
目，即设备在转换过程中被忽视，并且未提供任务配置等应用特定对象。

• Save this assignment for future reference (保存此任务供未来引用)：如果选择该选项，则该对话框
的所有设置，即所显示的设备“转换映射”被保存在 TwinCAT 2.x PLC 控制转换器选项中并且应用于未
来的转换。

4. 项目未正确终止并启用“自动保存”。

如果在 Load and Save (加载并保存) 选项中启用了 Auto Save (自动保存) 功能，并且 TwinCAT 3 PLC 在项
目最后一次修改后在未保存的情况下未定期终止，Auto Save Backup (自动保存备份) 对话框打开以处理备份
副本。

5. 项目为只读。

如果要打开的项目为只读状态，将询问您是以写保护模式打开项目还是要解锁项目。

6. 该库安装在库存储库中并从中检索。

如果尝试打开安装在库存储库中的库项目，将显示一条错误消息。您无法使用此路径打开库项目。通过 OK
(确认) 关闭对话框后，项目名称出现在用户界面的标题栏中。名称后的星号 (“*”) 表示该项目自上次保存以
来已被修改。

另请参见：
• PLC 文档：打开 TwinCAT 3 PLC 项目
• PLC 文档：打开 TwinCAT 2 PLC 项目



参照用户界面

TE100088 版本： 2.15.0

5.4.3 命令属性（对象）
功能：此命令可启用 Properties（属性）视图，该视图显示关于当前所选对象的一般信息。

调用：PLC 对象上下文菜单

要求：在 PLC 项目树中选择 1 个对象。

根据当前所选对象，显示以下属性领域：
• 高级 [} 88]（编译设置）
• 图像 [} 88]
• 授权 [} 89]
• 一般信息 [} 89]（对象名称、对象路径）
• SFC 设置 [} 90]（顺序功能图标志）
• CFC 设置 [} 91]（执行顺序模式）

在 可视化对象 下记录了特殊可视化属性，在 命令属性 下记录了特殊库和占位符属性。

高级

该区域显示对象编译设置。

始终绑定 真：在编译器中选择对象，因此对象始终包含在编译信息中。因此，它始终会在
PLC 上进行编译和加载。如果对象位于应用程序下或通过同样位于应用程序下的库
引用，则此选项将具有关联性。编译信息还用作可选符号配置变量的基础。
另外，也可以使用 {attribute 'linkalways'} 编译指示来指示编译器始终包含 1 个对
象。

编译器定义 在此处输入的编译器定义不会被评估。
如果您想要使用编译器定义，则在 PLC 项目属性中输入它们。
请参见：
• 命令属性（PLC 项目） > 类别编译 [} 95]
• PLC 文档：引用编程 > 编译指示 > 条件编译指示

从编译中排除 真：对象未包含在下一次编译运行中。
外部实现 （运行时系统中的后期绑定）

只有在特殊的系列情况中才能使用该功能。通常情况下，您可以忽略该选项。
真：在编译项目时，不会为该对象生成代码。在将项目加载到目标系统上之前，该
对象不会被链接，前提是该对象存在于目标系统上（在 PLC 运行时系统或其他实时
模块中）。

图像

在该区域中，您可以为对象分配一个图像，该图像显示在库管理器的图形视图和 FBD/LD/IL 编辑器的工具箱
中。可以通过选择一种颜色实现图像的透明度，该颜色之后会显示为透明。如果您选择 Transparency Color
(透明色) 选项，则可以使用其右侧的矩形按钮打开用于选择颜色的标准对话框。
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授权

该部分包含对象的授权列表。

一般信息

在本部分中，您将会了解有关所选对象的一般信息。

FileName 文件/对象名称
FullPath 对象的存储路径/位置

（此时不可编辑）
版本 文件版本，值：

• 1.1.0.1：当对象以 XML 格式保存时，使用此文件版本。
• 1.2.0.0：当对象以 Base64 格式保存时，使用此文件版本。

请注意，不能将文件版本为 1.2.0.0（或更高）的对象加载到低于 TC3.1.4024 的
开发环境版本中！

（此时不可编辑，可通过存储格式间接配置，请参见格式属性）

文件版本 1.2.0.0（或更高）与 TwinCAT 3.1 < Build 4024 在工程上不兼容
请注意，不能将以文件版本 1.2.0.0（或更高）保存的对象加载到低于 TwinCAT 3.1.4024 的开发环境
版本中！
由于在使用可选的 Base64 格式时，对象会自动以文件版本 1.2.0.0 保存，因此无法使用低于
TwinCAT 3.1.4024 的开发环境版本加载 Base64 格式的对象。
如果 1 个 PLC 项目包含文件版本为 1.1.0.1 的对象和文件版本为 1.2.0.0 的对象，则 1.1.0.1 对象将以
低于 TwinCAT 3.1.4024 的开发环境版本加载。未加载文件版本为 1.2.0.0 的对象。
使用 XAE 版本 TwinCAT 3.1.4024 或更高版本，可以将以文件版本 1.2.0.0 保存的文件的文件版本重
置为 1.1.0.1。

选项

在本部分中，您将会了解可为 PLC 对象配置的一些选项。
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格式 存储格式的单独设置选项：
此时，可针对下列对象类型单独配置对象的存储格式。
存储格式，值：
• XML：对象以 XML 格式保存。

◦ 使用此存储格式的对象以文件版本 1.1.0.1 存储，请参见版本属性。
• Base64：对象以 Base64 格式保存。

◦ 使用此存储格式的对象以文件版本 1.2.0.0 存储，请参见版本属性。
请注意，不能将文件版本为 1.2.0.0（或更高）的对象加载到低于 TC3.1.4024
的开发环境版本中！

Base64 相对于 XML 的优势：
与 XML 相比，Base64 可实现压缩存储。因此，通过对这些对象的文件访问可以提
高性能，例如，在加载、移动或复制对象时可以使用文件访问。
Base64 的可用性：
对于 Build 4024 及以上版本，下列 PLC 对象可选择使用 Base64 存储格式：
• 以图形化实现语言对 POU 主体进行编程的 POU

◦ 顺序功能图（SFC）
◦ FBD/LD/IL（功能块图/梯形图/指令表）
◦ CFC（连续功能图和面向页面的 CFC）
◦ UML 类图和状态图

• 带有以图形化实现语言编程的子元素（例如，动作、方法）的 POU（有关图形
语言的信息，请参见第 1 个关键点）

• 可视化
• 可视化管理器
• 文本列表
• 配方管理器
• 图像池
标准存储格式的设置选项：
对于 PLC 项目，PLC 项目属性（高级类别 [} 104]）中的设置“Write object
content as”（将对象内容写为）可用于定义上述对象类型的标准存储格式。

单独的 LineIds 值：真或假
• 真：该 POU 的行 ID 存储在 1 个单独的文件（LineIDs.dbg）中。
• 假：该 POU 的行 ID 存储在 POU 本身中。
（此时不可编辑，可在写入选项 [} 176]中配置）

排序 值：名称或 GUID
指定子对象（例如方法）在父对象中的存储顺序：按名称或 GUID 排序。
（此时不可编辑，可在写入选项 [} 176]中配置）

写入 ProductVersion 值：真或假
（此时不可编辑，可通过 PLC 项目属性的 高级类别 [} 104] 中的设置“在文件中写
入产品版本”进行配置）。

SFC 设置

该区域显示当前所选SFC 对象的编译和处理 隐式变量的当前设置。
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使用默认的 SFC 设置 True（默认）：通过此选项，在 PLC project
properties [} 98]（PLC 项目属性）中定义的默认值
可被应用于当前所选对象并在该对象的 Properties
（属性）视图中显示。
FALSE：此选项允许您配置特定于此 SFC 对象的有效
SFC 设置。

仅计算活动转换 真：TwinCAT 仅为当前激活的转换生成代码。
假（默认）：TwinCAT 为所有转换生成代码。所有转
换的状态均以颜色在线显示（真为深蓝色，假为浅蓝
色）。

SFC 标志 隐式生成变量（标志），用于控制和监控 SFC 图中的
流程。
使用：使用相应变量。
声明：自动创建相应变量。
使用声明：创建并使用变量。

CFC 设置

TwinCAT 3.1 Build 4026 及以上版本可用

该区域设置所选 CFC 对象的执行顺序模式。在 CFC 编辑器中，您可以自由定位元素，从而定位网络。为了避
免 CFC 编程块的执行顺序不确定，有 2 种模式可供选择。

显式执行顺序 假（默认）：自动数据流模式
真：显式执行顺序模式

自动数据流模式

在这种模式下，根据数据流自动设置执行顺序，如果存在不明确的情况，则根据网络拓扑进行设置。编程块和
输出端在内部编号。上层网络先于下层网络执行，左侧网络先于右侧网络执行。
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优势：自动定义的执行顺序可以优化时间和周期。在开发过程中，您不需要任何有关内部管理的执行顺序的信
息。

CFC 编辑器中的元素不带标记和编号。无法手动更改执行顺序。对于带有反馈的网络，您可以额外设置 1 个起
点。

在菜单 CFC > Execution order（CFC > 执行顺序）中，以下命令在此模式下可用：
• 命令显示执行顺序 [} 196]
• 命令设置反馈开始 [} 196]

显式执行顺序模式

在这种模式下，您可以显式设置执行顺序。为此，在 CFC 编辑器中显示的元素带有标记和编号，并提供可令
您确定顺序的菜单命令。

下列命令在菜单 CFC > Execution order（CFC > 执行顺序）中可用：
• 命令：移动到开始 [} 197]
• 命令：移动到结束 [} 197]
• 命令：向前移动一位 [} 197]
• 命令：向后移动一位 [} 198]
• 命令：设置执行次序 [} 198]
• 命令：按数据流排序 [} 198]
• 命令：按拓扑结构排序 [} 199]

对于 Build 4026 之前的版本，这是 CFC 编程块的通常行为。请注意，您必须自行调整执行顺序并自
行判断后果和影响。为此，系统会不断显示执行顺序。

5.4.4 命令属性（PLC 项目）

符号：

功能：此命令可打开 1 个编辑器窗口，其中显示和定义项目的属性以及其他与项目相关的信息。

调用：PLC 项目对象（<PLC project name> 项目）的上下文菜单或 Project（项目）菜单

要求：打开 1 个项目。

TwinCAT 将 PLC 项目属性直接存储在 PLC 项目中。

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

另请参见：
• PLC 文档：--- FEHLENDER LINK ---

5.4.4.1 类别：通用

类别 Common（通用）包含项目文件的一般信息和元信息。TwinCAT 使用此信息创建 Properties（属性）
选项卡中的密钥。例如，如果 Company（公司）文本字段包含名称“Company_A”，Properties（属性）
选项卡包含值为“Company_A”的 Company（公司）密钥。
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项目信息

对于库项目，必须输入公司、标题和版本才能安装库。
公司 创建该项目（应用程序或库）的公司的名称。除了库类别之外，它还被用于库的存

储排序
标题 项目标题
版本 项目版本，例如“0.0.0.1”
已发布 ：启用修改保护。

后果：当您现在编辑项目时，将出现 1 个提示询问您是否想要更改项目。如果您的
回答是 Yes（是），则当再次编辑项目时，提示将不再出现。

库类别 您可在库的存储库对话框中进行库项目类别的排序。如果未指定类别，则库会被分
配到类别“Other”（其他）。如要将库分配到其他类别，则必须定义该类别。
在 1 个或多个 XML 格式的外部描述文件中定义库类别。如要分配库，您可以调用
此类文件或调用另一个已经从描述文件中获取类别信息的库文件。
要求：该项目是 1 个库项目。
Library Categories（库类别）对话框打开，您可在该对话框中添加库类别。

默认命名空间 库的命名空间的默认设置为库标题。或者，可显式定义不同命名空间，通常在库生
成期间在项目信息中为库定义，或者在库引用的 Properties（属性）对话框中进
行定义，以便在项目中本地使用库。
库的命名空间必须用作标识符的前缀，以便在项目中能够多次明确访问存在的模
块，或者库属性强制使用此前缀：LanguageModelAttribute“qualified-access-
only”（“对库模块或变量的明确访问”）。
如果您在此处没有定义标准命名空间，则库文件的名称将自动用作命名空间。

占位符 此时，可以指定占位符的默认名称，该名称代表或引用此库。如果此时未明确指定
占位符，则库占位符名称的默认设置将与库标题相对应。

作者 项目作者
描述 项目的简要描述（例如，内容、功能、一般信息，例如“仅供内部使用”等）

库特性
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创建全局版本结构 ：在 PLC 项目中创建全局变量列表，其中包含版本信息。全局变量列表会在保
存过程中进行更新。

自动生成库信息 POU ：在项目树中自动创建“函数”类型的 POU 对象，它们可用于访问应用程序中
的项目属性。在这种情况下，将为属性 Company（公司）、Title（标题）和
Version（版本）生成特殊函数（F_GetCompany、F_GetTitle、
F_GetVersion）。函数会在保存过程中进行更新。

文档格式 选项：
• TwinCAT 3.1 Build 4024 及以下版本：reStructuredText
• TwinCAT 3.1 Build 4026 及以上版本：TcDocGen
在库创建期间，对应于特殊格式的注释在此自定义视图中重新构建，并在库管理器
的 Documentation（文档）选项卡中显示。这会打开库文档的更多选项。

允许对已编译的库进行隐
式检查

TwinCAT 3.1 Build 4026 及以上版本可用

：TwinCAT 也会对受保护库（*.compiled-libraries）中的功能块执行隐式检
查。
要求：在 PLC project properties（PLC 项目属性）中的 Compiler definitions
（编译器定义）字段（类别 Compile（编译））中输入编译器定义
“checks_in_libs”。
另请参见：使用功能块进行隐式检查

强制对库访问进行
Qualified_only

TwinCAT 3.1 Build 4026 及以上版本可用

：该库中的对象只能与该库的命名空间规范一起使用。
另请参见：属性“qualified_only”

允许作为库引用 TwinCAT 3.1 Build 4026 及以上版本可用

：你可以将一个PLC项目作为库文件，引用到另一个PLC项目中。
另请参见：使用 PLC 项目作为引用库

库类别对话框

类别列表 分配至库项目的类别列表。类别列表可以源于多个来源。输入所有需要的类别后，
通过 OK (确定) 确认对话框。

添加 显示命令 From Description File...(从描述文件...) 和 From Other Library...(从
其他库...)。

删除 TwinCAT 删除所选类别。
从描述文件... Select Description File (选择描述文件) 对话框出现，可在其中选择扩展名为

*.libcat.xml 的描述文件。文件包含命令类别。通过 Open (打开) 退出对话框后，
TwinCAT 将应用这些类别。

从其他库... Select Library (选择库) 对话框出现，可在其中选择待采用命令类别的库
(*.library)。通过 Open (打开) 退出对话框后，TwinCAT 将应用这些类别。

确认 TwinCAT 提供类别作为项目信息，并在 Library Categories (库类别) 字段中显
示。

取消 关闭对话框。过程中止。



参照用户界面

TE1000 95版本： 2.15.0

另请参见：
• PLC 文档：
• PLC 文档：使用库

5.4.4.2 类别编译

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

类别“Compile”（编译）用于配置编译器选项。

设置
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编译器定义 您可以在此处输入编译器定义/“定义”（请参见 {define} 语句）和编译应用程序
的条件（条件编译）。
有关可用条件编译指示的说明，请参见“条件编译指示”部分。在此处也可以输入
此类编译指示中所用的表达式 expr。可以通过逗号分隔列表的形式输入若干条目。

系统编译器定义 TwinCAT 3.1 Build 4024 及以上版本可用
在PLC项目中编译器定义 [} 109]已经在系统管理器的设置中进行了配置。这些配置
会自动应用到当前的项目中，无需再次手动设置。

下载应用程序信息 TwinCAT 3.1 Build 4024 及以上版本可用
情景：您正在向控制器加载 1 个 PLC 项目，该项目与控制器中已存在的项目不同。
在这种情况下，会出现 1 个包含“Details”（详细信息）按钮的消息窗口。使用
此按钮可打开“Application information”（应用程序信息）窗口，您可以通过
该窗口查看当前 PLC 项目与控制器上的 PLC 项目之间的区别。其中包括比较功能
块的数量、数据和存储位置。
“Application information”（应用程序信息）窗口包含对各项区别的简要描
述，例如：
• MAIN 声明已更改
• 在 MAIN 中已插入变量 fbMyNewInstance
• FB_Sample 的方法/动作的数量已更改

（默认）：如果启用此设置，则会将 PLC 项目内容的相关信息加载到 PLC 上。
这使得可以对当前PLC项目和控制器上的PLC项目进行扩展检查。扩展检查选项的
不同之处在于，“Application information”（应用程序信息）窗口包含 1 个附
加的“Online comparison”（在线比较）选项卡，该选项卡会显示树形比较视
图。该视图会告知您哪些 POU 已更改、删除或添加。当您执行“Application
information”（应用程序信息）窗口下部区域中的蓝色下划线命令时，就会显示
该附加选项卡（“应用程序并非最新版本。立即生成代码以显示在线比较？”）。

生成 tpy 文件 TwinCAT 3.1 Build 4024 及以上版本可用
tpy 文件包含项目、路由、编译器和目标系统信息等。它是对 TwinCAT 2 PLC 项目
进行说明时所使用的格式。为了确保与现有应用程序兼容，如有需要，可为
TwinCAT 3 PLC 项目创建此文件。

（默认）：在创建 PLC 项目时，不会创建与该项目相关的 tpy 文件。

：在创建 PLC 项目时，会创建与该项目相关的 tpy 文件，并将其存储在项目文
件夹中。

请注意，该选项的值和配置可用性取决于是否将 TPY 文件配置为目标文件（请参见
“设置选项卡 [} 111]”）。
• 如果启用 TPY 文件作为目标文件，则会发生以下情况：

◦ TwinCAT 会记住“Generate tpy file”（生成 tpy 文件）选项的当前状态（=
“原始值”，见下文。）。

◦ 如果未发生这种情况，则会在下一次创建项目时自动激活“Generate tpy
file”（生成 tpy 文件）选项。

◦ 此外，“Generate tpy file”（生成 tpy 文件）选项还会显示为灰色，因此，
只要将 TPY 文件配置为目标文件，用户就无法禁用该选项。

• 如果随后禁用 TPY 文件作为目标文件，则会发生以下情况：
◦ 下次创建项目时，将为“Generate tpy file”（生成 tpy 文件）选项分配其

“原始值”（见上文）。
◦ 此外，该选项不再显示为灰色，用户可以再次进行配置。
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在 TMC 文件中添加声明
的初始化值

TwinCAT 3.1 Build 4026.12 及以上版本可用

（默认）：将声明的初始化值保存在 TMC 文件中。例如，如果其他应用程序需
要初始化值，可使用此选项。

：声明的初始化值不保存在 TMC 文件中。这样可以减少 TMC 文件的大小并缩
短编译时间，尤其是当 PLC 项目中的声明包含大量初始化值时。
示例：
VAR
    aSample : ARRAY[1..10] OF INT := [2, 38, 5, 9, 74, 62, 87, 3, 16, 4];
END_VAR

在 TMC 文件中添加 POU
和 DUT 声明的相关注释

TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：将 POU 和 DUT 声明上方的注释与数据类型一起存储在 TMC 文件
中。例如，如果其他应用程序需要注释，可使用此选项。

：POU 和 DUT 声明上方的注释不存储在 TMC 文件中。这样可以减少 TMC 文
件的大小并缩短编译时间，尤其是当注释中包含对 POU 和 DUT 的详细描述时。
Sample：
// This function block represents an axis
FUNCTION_BLOCK FB_Axis
…

解决方案选项

编译器版本 定义了 TwinCAT 在编译期间和编译加载期间使用的编译器版本。
请注意，该设置不会替代远程管理器。
如果 PLC 项目是应用程序项目，在处理不同版本时，应始终使用远程管理器。
在使用远程管理工具的情况下，编译器的版本应该设置为最新的版本。
编译器版本设置只有当你的PLC项目是一个库项目并且需要管理不同版本时才适
用。
建议将库保存为最终要使用的最旧版本。为此，必须将编译器版本设置为相应的固
定版本（例如，“3.1.4018.0”）。

最大警告数 指的是 TwinCAT 在“Error List”（错误列表）视图中发布的警告的最大数量。
在“Project Settings”（项目设置）对话框的类别“Compiler warnings”（编
译器警告）中定义所显示编译器警告的选择。

替换常量 ：TwinCAT 会直接加载每个标量类型常量的值，也就是说，不包括 STRING、
ARRAY 或结构的值。在在线模式下，TwinCAT 可在声明编辑器或监控窗口中用一
个符号标识这些常量的值。在这种情况下，无法通过 ADR 运算符进行访问（例
如，强制或写入这些常量的值）。

（默认）：可以访问常量。计算时间略有增加。

另请参见：
• 类别：编译器警告 [} 103]

5.4.4.3 授权类别

保留以供将来使用！
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注意：用户目前必须始终在库代码中查询自己库的 OEM 授权。请参见在 PLC 应用程序中的查询 OEM 授权。

5.4.4.4 类别：统计

Statistic (统计) 类别提供关于项目中存在多少不同类型对象的统计信息。

5.4.4.5 类别：SFC

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

SFC 类别用于配置 SFC 对象的设置。每个新 SFC 对象在其属性中自动具有已配置的设置。
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标签选项卡

隐式生成变量 (标志)，用于控制和监控 SFC 图中的流程。
使用

：使用相应变量。
声明

：自动创建相应变量。否则，如果计划使用 (设置使用)，则用户必须声明变
量。

自动声明的标志变量出现在 SFC 编辑器的声明部分中，但仅在在线模式下适用。

构建选项卡

代码生成

仅计算活动转换
：TwinCAT 仅为当前活动的转换生成代码。

另请参见：
• --- FEHLENDER LINK ---
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5.4.4.6 类别：可视化

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

Visualization (可视化) 类别用于为可视化类型的对象配置项目范围的设置。

常规选项卡

可视化目录

文本列表文件 目录，包含项目中可用于配置不同语言文本的文本列表。例如，在导出或导入文本
列表时，TwinCAT 使用此目录。

点击  打开 Find Folder (查找文件夹) 对话框，可通过此对话框选择文件系统中
的目录。

图像文件 目录，包含项目中可用的图像文件。多个文件夹以分号分隔。例如，TwinCAT 在
导出或导入图像文件时使用此目录。

点击  打开 Find Folder (查找文件夹) 对话框，可通过此对话框选择文件系统中
的目录。

扩展设置
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在所有元素属性中启用属
性处理 ：还可以在其属性中配置可视化元素，其中可以选择具有  属性的 IEC 变

量。然后，TwinCAT 在编译可视化时生成用于属性处理的附加代码。

要求：IEC 代码至少包含一个类型接口属性的对象，即属性 。

要求：Visible (可见) 启用。

5.4.4.7 类别：可视化配置文件

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

通过 Visualization Profile (可视化配置文件) 类别，可以设置可视化配置文件。

可视化配置文件

特定配置文件 TwinCAT 在项目中使用的配置文件，确定项目中可用的可视化元素。
选择列表包含所有之前安装的配置文件。

5.4.4.8 类别静态分析

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。
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类别 Static analysis（静态分析）定义了在静态代码分析中考虑的检查。

轻量静态分析：
• 如果您尚未激活附加的 TE1200 工程授权，则您可以使用免授权版本的静态分析（轻量静态分析），其

中包含一些编码规则。免费的轻量版本使您能够熟悉产品的基本操作，例如，基于 1 套精简的功能。
• 有关轻量静态分析的更多信息，请参见：

PLC 文档：对 PLC 项目进行编程 > 检查语法和分析代码 > --- FEHLENDER LINK ---

全量静态分析：
• 如果启用了额外的 TE1200 工程授权，则可使用全量静态分析功能（保存和加载设置、100 多条编码规

则、命名规范、度量、禁止符号）。
• 有关全量静态分析的更多信息，请参见：

TE1200 静态分析。

5.4.4.9 类别：部署

Deployment (部署) 类别用于设置在安装和启动应用时执行的命令。

以下事件可用，之后可以调用列表中列出的命令：

启用配置 启用配置后，将调用所需命令。
Plc 下载 将 PLC 应用下载到目标系统后，将调用所需命令。
Plc 在线更改 在线更改成功后，将调用所需命令。
Plc 编译后 编译 PLC 应用后，将调用所需命令。

可以执行以下命令：

复制 将参数 1 (源路径) 中的文件复制到参数 2 (目标路径) 中指定的位置。
执行 执行参数 1 下列出的应用或脚本。

源路径和目标路径可能包含虚拟环境变量，而 TwinCAT 会相应地进行解析。

支持以下环境变量：
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虚拟环境变量 注册表值 默认值
%TC_INSTALLPATH% InstallDir C:\TwinCAT\3.x \
%TC_TARGETPATH% TargetDir C:\TwinCAT\3.x \Target\
%TC_BOOTPRJPATH% BootDir C:\TwinCAT\3.x \Boot\
%TC_RESOURCEPATH% ResourceDir C:\TwinCAT\3.x

\Target\Resource\
%SOLUTIONPATH% - 解决方案文件的位置

注册表值存储在注册表中的以下项下：\HKLM\Software\Beckhoff\TwinCAT3。

示例：

在以下示例中，文件 SampleFile.xml 从解决方案的配置项目子文件夹复制到目标系统的文件夹 C:\plc\config
中。

5.4.4.10 类别：编译器警告

Compiler Warnings (编译器警告) 类别用于选择编译运行期间 TwinCAT 在消息窗口中显示的编译器警告。

可以在 Compile (编译) 类别中指定所列出的最大警告数。

另请参见：
• 命令构建 PLC 项目 [} 115]
• 类别编译 [} 95]
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5.4.4.11 类别 UML

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

在类别 UML 中，您可以更改 UML 编译器版本。此设置仅在使用 UML 状态图时相关。

有关配置选项的更多信息，请参见 TF1910 TC3 UML 文档的“UML 编译器版本”部分。

5.4.4.12 高级类别

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

类别“Advanced”（高级）用于配置高级属性。

写入选项

文件版本 1.2.0.0（或更高）与 TwinCAT 3.1 < Build 4024 在工程上不兼容
请注意，不能将以文件版本 1.2.0.0（或更高）保存的对象加载到低于 TwinCAT 3.1.4024 的开发环境
版本中！
由于在使用可选的 Base64 格式时，对象会自动以文件版本 1.2.0.0 保存，因此无法使用低于
TwinCAT 3.1.4024 的开发环境版本加载 Base64 格式的对象。
如果 1 个 PLC 项目包含文件版本为 1.1.0.1 的对象和文件版本为 1.2.0.0 的对象，则 1.1.0.1 对象将以
低于 TwinCAT 3.1.4024 的开发环境版本加载。未加载文件版本为 1.2.0.0 的对象。
使用 XAE 版本 TwinCAT 3.1.4024 或更高版本，可以将以文件版本 1.2.0.0 保存的文件的文件版本重
置为 1.1.0.1。
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将对象内容写为
（“Write object
content as”）

TwinCAT 3.1 Build 4024 及以上版本可用
背景信息：
从 Build 4024 版本开始，Base64 引入了 1 种新的存储格式，下列 PLC 对象可选
择使用该存储格式：
• POU（程序组织单元）的主体是用图形化编程语言编写的。

◦ 顺序功能图 (SFC)
◦ FBD/LD/IL（功能块图/梯形图/指令表）
◦ CFC（连续功能图和面向页面的 CFC）
◦ UML 类图和状态图

• 带有以图形化实现语言编程的子元素（例如，动作、方法）的 POU（有关图形
语言的信息，请参见第 1 个关键点）

• 可视化
• 可视化管理器
• 文本列表
• 配方管理器
• 图像池
到目前为止，这些对象默认以 XML 格式保存。
从 Build 4024 版本开始，您可以配置应该将这些对象类型保存为 XML 或Base64。
Base64 相对于 XML 的优点：
与 XML 相比，Base64 可实现压缩存储。因此，通过文件访问这些对象可以提高性
能，例如，这种方法在加载项目或移动、复制对象时特别有用。
标准存储格式的设置选项：
对于 PLC 项目，PLC 项目属性中的设置“Write object content as”（将对象内容
写为）可用于定义上述对象类型的默认存储格式。
选择的标准存储格式只会用于新添加的对象（例外：不适用于新添加的 POU 子对
象。示例：将 POU 保存为 XML，并将标准存储格式配置为 Base64。如果随后在
POU 中添加图形子对象，那么POU的存储格式以及这个子对象的存储格式仍然保
持为XML格式）。
在更改和保存非标准存储格式的现有对象时，其存储格式不会自动更改。可通过
“Properties”（属性）窗口单独更改现有对象的存储格式（见下文）。或者，在
更改标准存储格式时，还可以选择对所有现有对象采用新选定的存储格式。如果在
此时更改存储格式，则会出现相应的问询窗口。
设置“Write object content as”（将对象内容写为）可提供以下选项：
• XML（默认）：上述 PLC 对象默认以 XML 格式保存。

◦ 使用此存储格式的对象按文件版本 1.1.0.1 进行存储。
• Base64：上述 PLC 对象默认以 Base64 格式保存。

◦ 使用此存储格式的对象按文件版本 1.2.0.0 进行存储。
请注意，不能使用低于 TwinCAT 3.1.4024 版本的开发环境加载文件版本为
1.2.0.0（或更高）的对象！

存储格式的单独设置选项：
对于上述对象类型，可在对象的“Properties”（属性）窗口中单独配置该对象的
存储格式。有关更多信息，请参见关于属性 [} 88]的描述（格式属性）。
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在文件中写入产品版本
（“Write product
version in files”）

TwinCAT 3.1 Build 4024 及以上版本可用
产品版本表示使用哪个插件版本来保存 PLC 文件（例如，功能块）。该复选框的设
置对整个项目有效，并且是该 PLC 项目中所有已修改或新添加的 PLC 对象的默认
设置。

（默认）：不会将产品或插件版本写入文件。
• 如果您将该设置从启用改为禁用，则会出现 1 个问询窗口，您可以在其中选择是

否从所有现有文件中移除产品版本信息。
• 禁用选项的用例：如果您对产品版本不感兴趣，则可以使用该设置。这样可以最

大限度地减少源代码管理系统对文件的更改。

 将产品或插件版本写入文件（在XAE中看不到这个版本信息；只有在文件级别
进行分析时才会显示出来）。
• 如果您将该设置从禁用改为启用，则会出现 1 个问询窗口，您可以在其中选择是

否将产品版本添加到所有现有文件中。
• 启用选项的使用场景：例如，可以使用该设置将文件版本信息包含在文件中，以

便进行调试或跟踪。
• 请注意以下几点：如果以不同的产品版本保存文件，会导致该文件发生更改，在

使用源代码管理系统时会显示文件存在差异。
使用配置文件写入对象内
容

配置文件定义了对象的保存格式。例如，在 Build 4024 中，为 PLC HMI 添加了新
功能。因此，用 Build 4024 保存的可视化文件无法直接用旧版本打开。如果您在
此处设置了 4022 配置文件，可视化文件将以相应的格式保存，并可使用 Build
4022 打开。
要求：例如，若要在下拉菜单中显示 4022 配置文件，则必须安装 4022 远程管理
器，或者通过先前的 4022 XAE 安装程序安装当前最新的 4024 XAE。

将书签写入文件 TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：仅将书签保存在 Visual Studio 的 .suo 文件中。从项目目录中删除
已创建的 .bookmarks 文件。

：同时将 Visual Studio 项目用户选项文件（.suo）中存储的书签写入单独的文
件。该文件以 .bookmarks 结尾，位于项目目录中。因此，它也是已知归档选项的
一部分。
新建 PLC 项目时，是否将书签存储在单独文件中的全局默认设置请参见“对话框选
项 - 写入选项 [} 176]”。在创建新 PLC 项目时，这个设置的值会被传递到本地项
目设置中。

多用户选项

使用 Multiuser
（“Use Multiuser”）

TwinCAT 3.1 Build 4024 及以上版本可用

（默认）：不启用 PLC 项目的多用户功能。

：启用 PLC 项目的多用户功能。
另请参见多用户文档中的更多信息。

多用户 URL TwinCAT 3.1 Build 4026 及以上版本可用
相关描述见后文。

更新父节点 TwinCAT 3.1 Build 4026 及以上版本可用
相关描述见后文。

解决方案选项
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安全在线模式
（“Secure Online
Mode”）

：（默认）：出于安全考虑，始终会提示用户在调用以下命令时确认执行这些
命令。
• 激活配置
• 在配置/运行模式下重启 TwinCAT 系统
• 冷复位
• 初始值复位

：除了上述命令之外（默认出现确认提示），还将提示您确认以下命令。
• 登录
• 开始
• 停止
• 单循环
• 写入值
• 强制值
• 释放值

自动更新可视化配置文件 可通过此选项配置可视化配置文件的自动更新操作。
当您打开使用过时可视化配置文件的 PLC 项目时，会在消息窗口中出现警告
（“New Version found for Visualization profile”）（发现可视化配置文件的新
版本）。

（默认）：如果禁用了“Autoupdate Visu Profile”（自动更新可视化配置文
件）选项，可视化配置文件版本不会自动更改。您可以双击警告“New Version
found for Visualization profile”（发现可视化配置文件的新版本），打开
ProfileUpdate 对话框，在该对话框中，您可以手动更改可视化配置文件版本。

：在这种情况下，如果启用了“Autoupdate Visu Profile”（自动更新可视化
配置文件）选项，会将可视化配置文件版本自动设置为最新版本。在此类可视化配
置文件版本自动更新后，消息窗口中将显示相应的警告（例如，“Visualization
profile set from ‘TwinCAT 3.1 Build 4020.10’ to ‘TwinCAT 3.1 Build
4022.0’”（已将可视化配置文件从“TwinCAT 3.1 Build 4020.10”设置为
“TwinCAT 3.1 Build 4022.0”））。

自动更新 UML 配置文件 可通过此选项配置 UML 编译器版本的自动更新操作。
如果您打开使用过时 UML 编译器版本的 PLC 项目，会在消息窗口中显示相应的警
告（“new version for UML found”（发现 UML 的新版本））。

（默认）：如果禁用了“Autoupdate Uml Profile”（自动更新 UML 配置文
件）选项，UML 编译器版本不会自动更改。双击警告“new version for UML
found”（发现 UML 的新版本），打开 ProfileUpdate 对话框，在该对话框中，您
可以手动更改 UML 编译器版本。

：在这种情况下，如果启用了“Autoupdate Uml Profile”（自动更新 UML
配置文件）选项，会将 UML 编译器版本自动设置为最新版本。如果 UML 编译器版
本自动更新，消息窗口中将显示相应的警告（例如，“UML set from ‘4.0.2.0’
to ‘4.0.2.1’”（已将 UML 从“4.0.2.0”设置为“4.0.2.1”））。
有关更多信息，请参见“UML 编译器版本”。
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写入行 ID TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：不生成单独的行 ID。在这种情况下，机器代码指令的分配和断点处
理会使用行号。因此，对于空格或注释等更改，需要进行在线更改。

：会为项目的 POU 生成并存储行 ID（TwinCAT 3.1 Build 4024 及以下版本的
默认操作）。行 ID 可用于将代码行分配给机器代码指令，在进行断点处理等操作
时需要使用行 ID。
新建PLC项目时，全局默认设置“写入行ID”，请参见“对话框选项 - 写入选项
[} 176]”。在创建新 PLC 项目时，这个设置的值会被传递到本地项目设置中。

兼容性

将 PLC 项目转换为先前的
TwinCAT 版本

TwinCAT 3.1 Build 4026 及以上版本可用
在打开的对话框中，您可以选择 PLC 项目应该转换的 TwinCAT 版本
（TwinCAT 3.1 Build 4022 或 4024）。使用“Convert”（转换）确认转换之
后，项目将会关闭并保存为与所选版本兼容的版本。
请注意，在转换过程中，项目数据将会更改，较新版本的设置和属性将会丢失。因
此，该转换不适合在不同版本之间进行多次切换。

将事件写入事件日志

您可以使用以下 2 个选项来配置是否要记录用户事件，以及记录何种类型的用户事件。以下事件属于用户事
件：

• 登录
• 退出
• 下载
• 在线更改
• 启动 PLC 项目
• 停止 PLC 项目
• 单循环
• 冷复位
• 初始值复位
• 设置断点
• 删除断点

运行时会将事件发送至 EventLogger。此外，如果将 EventLogger 选项“Output as Task Item”（作为任
务项目输出）设置为 True，将会在消息窗口（错误列表）中输出事件。

如果您更改了下述选项，下次登录时需要进行在线更改。设置随即生效。

信息 TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：在发生成功的用户事件时，不记录任何消息。

：如果上述用户事件之一成功发生，那么与此同时将会记录此过程的相应信
息。

错误 TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：当用户事件失败时，不记录任何消息。

：如果在上述用户事件之一发生时出现错误，那么与此同时将会记录此失败过
程的相应信息。例如，如果因在运行时出错而导致登录失败，就会执行此操作。

常规
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允许在 1 个解决方案中多
次出现具有相同 ID 的
（相同）对象

（或“Allow (identical)
objects with the same
ID multiple times in one
solution”）

（默认）：PLC 对象（例如，POU）通过其 GUID 进行识别，该 GUID 在整个
解决方案中只分配 1 次。在通常使用情况下，该选项可以且应该保持禁用状态。

：该激活的选项仅适用于在 1 个解决方案中多次存在具有相同 ID/GUID 的对象
的情况。在这种情况下，必须更改对象的标识类型，以便将 PLC 对象的 GUID 链接
至 PLC 项目的 GUID（使用 XOR）。这样可以避免在不同项目中多次使用同一个对
象时更改其GUID。
信息：
• 如果您更改了选项的状态，则必须重新加载项目。下次登录时也需要进行下载。
• 如果激活该选项，该 PLC 项目中所有对象的标识类型都会发生更改。
• 如果激活该选项，则无法使用或无法充分使用以下 PLC 功能：

◦ 可视化
◦ UML SC
◦ 安全管理

该选项已重命名为 TwinCAT 3.1 Build 4026.x。先前的名称为：“Minimize ID
changes in TwinCAT files”（最小化 TwinCAT 文件中的 ID 更改）或“Minimize
ID changes in TwinCAT files”（最小化 TwinCAT 文件中的 ID 更改）。该选项的
操作保持不变。

5.4.5 PLC 项目设置
功能：此命令可打开编辑器，可在其中定义项目设置。

调用：在 Solution Explorer（解决方案资源管理器）中双击 PLC 项目

另请参见：
• PLC 文档：

5.4.5.1 项目选项卡
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项目名称 PLC 项目的名称
Id PLC 项目的 ID
项目路径 PLC 项目存储位置路径
项目类型 项目类型
端口 运行时系统的 AMS 端口编号
项目 Guid PLC 项目的 GUID
加密 启动项目的加密

• 无启动项目加密（默认）
• 加密启动项目

自动运行启动项目
 在启动 TwinCAT 运行时环境后，将自动加载并运行 PLC 启动项目。

该设置直接传输到当前选定的目标系统。设置未保存在 TwinCAT 项目中。
在解决方案资源管理器中，此选项对应于 PLC 项目节点的上下文菜单中的
Autostart Boot Project（自动运行启动项目）命令。

符号映射
 符号映射已启用。

强制多实例
 用于登录 PLC 项目多实例的选项已启用。

注释 注释框
编译器定义（TC3.1 Build 4024 及以上可用）
手动 在此处，您可以在系统管理器级别定义自己的编译器定义，并将其传递给 PLC

项目。在 PLC 项目属性中的编译类别下，可将这些定义作为系统编译器定义
[} 95]输入。

隐式
 所选项目变体的名称以及项目变体所属的所有组都会被自动设置为编译器

定义，并传递给 PLC 项目。在 PLC 项目属性中的编译类别下，可将这些定义
作为系统编译器定义 [} 95]输入。
注意：为了激活该复选框，必须启用变体管理的定义。

另请参见：
• 变体管理：概念：集成到 PLC 项目中
• 命令属性（PLC 项目）：类别编译：系统编译器定义 [} 95]

https://infosys.beckhoff.com/content/1031/variant_management/6325854219.html
https://infosys.beckhoff.com/content/1031/variant_management/6325752587.html
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5.4.5.2 设置选项卡

目标存档

在 Target Archive（目标存档）分组框中，您可以指定在创建启动项目时需与其他数据一同传输至目标系统
的信息内容。

登录信息 包含 PLC 项目编译器信息的 COMPILEINFO 文件。
临时抑制 如果用户在登录目标系统时同时取消选择了“Update boot project”（更新启动

项目）选项，则暂时不会将 COMPILEINFO 文件加载到目标系统中。这样可加快
下载/在线更改的速度。

项目源 PLC 项目源代码文件的可读源代码形式。
编译的库 在 PLC 项目中以编译形式使用的库。
源库 在 PLC 项目中以可读源代码形式存在的库。

文件/电子邮件存档

在 File/E-Mail Archive（文件/电子邮件存档）分组框中，您可以指定在存档 PLC 项目 [} 50]、TwinCAT 项目
[} 246]或解决方案 [} 48]时需存储的信息。如果勾选激活相应复选框，下表中描述的文件将被存入项目存档包
中。

登录信息 包含 PLC 项目编译器信息的 COMPILEINFO 文件。
项目源 PLC 项目源代码文件的可读源代码形式。
编译的库 在 PLC 项目中以编译形式使用的库。
源库 在 PLC 项目中以可读源代码形式存在的库。
核心转储 核心转储文件位于 PLC 项目目录中，而编译信息文件位于项目目录中的

“_CompileInfo”文件夹中。
注意：如果激活核心转储 [} 137]设置，编译信息文件也会被保存到存档中，因为
需要具备这些文件才能使用核心转储。
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源代码传输
如果您已将目标设备或文件/电子邮件的存档设置配置为包含项目源代码和/或源库，请注意，在移交/
交付目标系统时或在移交文件/电子邮件存档时，项目源代码和/或项目中使用的源库（*.library）将
以可读源代码形式包含在 ZIP 存档文件中。
在配置上述设置以及存储和引用库（区分*.library 与 *.compiled-library）时，请留意这一点。
有关库管理的更多信息，请参见 使用库 部分。
有关源代码加密的信息，请参见安全管理文档。

目标文件

在 Target Files（目标文件）分组框中，您可以设置在目标系统上创建启动项目时需传输至 \Boot\Plc 文件夹
的信息。

TMC 文件 PLC 项目的 TMC 文件（TwinCAT 模块类）
TPY 文件 TPY 文件（包含项目信息、路由信息、编译器信息、目标系统信息等信息）

启动项目

TwinCAT 3.1 Build 4026 及以上版本可用

在 Boot Project（启动项目）分组框中，您可以设置目标系统上的启动项目在下载或在线更改时是否应默认
进行更新。若在项目修改后弹出的登录对话框中勾选或取消勾选对应的复选框（请参见 命令登录 [} 142]），
此处定义的默认设置将被一次性覆盖。

在线更改时更新启动项目 进行在线更改时默认更新目标系统上的启动项目。
下载时更新启动项目 进行下载时默认更新目标系统上的启动项目。

目标行为

在 Target Behavior（目标行为）分组框中，您可以设置目标系统如何处理断电保持数据以及指针和引用。

清除无效的断电保持数据 已存储的断电保持数据备份将被忽略。这样可确保不接受任何无效数据，而是将
其丢弃。
请参见：断电保持数据备份 [} 112]

恢复已移动的指针/引用 TwinCAT 3.1 Build 4026 及以上版本可用
进行在线更改期间，所有 PLC 指针的值均会自动更新，确保各指针指向的变量或
对象与在线修改前保持一致。这意味着，即使指针指向的变量处于在线更改期间
被移动到不同的内存位置，指针在在线更改后也仍然有效。
由于更新指针需要时间，停用该选项可以加快在线更改的执行速度。在这种情况
下，无法保证指针的持续有效性。因此，您应该实施一种用于手动更新指针的机
制。
参见：指针

断电保持数据备份

在 TwinCAT 系统停止/关闭期间，断电保持数据会定期存储在 TwinCAT\Boot 文件夹的 .bootdata 文件中。
在下一次系统启动时（TwinCAT 运行模式），将读取此文件，并使用该文件中的值初始化运行时系统中的断
电保持变量。系统将 .bootdata 文件重命名为 .bootdata-old。

如果包含断电保持数据的文件 (.bootdata) 不存在，会在系统启动时读取断电保持数据的备份文件
(.bootdata-old)。这是一种例外情况，但也有可能会发生，例如当未配备不间断电源的 IPC 遇到断电且
TwinCAT 无法正常关闭时。

• 如果可以预见备份文件的内容在新系统启动时无法使用，可以启用选项“Clear Invalid Persistent
Data”（清除无效的断电保持数据），忽略备份文件。例如，如果批处理信息或工具数据已存储在生产
设施中并且必须处于最新状态，便可能出现这种情况。

https://infosys.beckhoff.de/content/1033/tc3_security_management/index.html?id=7483858625300352472
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• 如果因在线更改导致断电保持数据结构（其程序代码中的数据类型或符号路径）发生改变，后续加载过
时持久数据文件的操作则毫无意义。在这种情况下，应该提前启用“Clear Invalid Persistent Data”
（清除无效的断电保持数据）选项。

在这两种情况下，还应确保当前断电保持数据文件处于可用状态。为此，可以使用 FB_WritePersistentData
(PLC Lib Tc2_Utilities) 等功能块和防止突然断电的不间断电源保护。

在使用断电保持数据时，务必对全局结构 PlcAppSystemInfo 中的相应标志（BootDataLoaded 和
OldBootData）进行评估（参见“系统 > 全局数据类型”文档）。

如果常规文件和备份文件均无法加载，或者二者均不存在，标记为 PERSISTENT 的变量将使用显式指定的初
始化值或通过标准初始化以与其他“普通”变量相同的方式重新初始化。

另请参见：
• PLC 文档：

5.5 构建

5.5.1 命令构建解决方案

符号：

功能：此命令可启动解决方案中包含的所有项目的编译过程或代码生成。

调用：Build（构建）菜单或解决方案的上下文菜单

要求：选择解决方案。

解决方案中包含的所有项目依次进行编译。这也涉及到在 TwinCAT 项目下集成的项目（PLC、C++ 等）。在
命令构建 PLC 项目 [} 115] 部分中描述了针对 PLC 项目执行的步骤。

5.5.2 命令重建解决方案
功能：此命令可启动解决方案中包含的所有项目的编译过程，即使之前编译时没有错误也不例外。

调用：Build（构建）命令或解决方案的上下文菜单

要求：选择解决方案。

在重建解决方案时，首先要对其进行清除（另请参见：命令清除解决方案 [} 113]），然后再进行构建（另请
参见：命令构建解决方案 [} 113]）。

另请参见：
• 命令重建 PLC 项目 [} 115]

5.5.3 命令清除解决方案
功能：此命令可开始清除解决方案中包含的所有项目。

调用：Build（构建）菜单或解决方案的上下文菜单

要求：选择解决方案。
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依次清除解决方案中包含的所有项目。这也涉及到在 TwinCAT 项目下集成的项目（PLC、C++ 等）。在 命令
清除 PLC 项目 [} 115] 部分中描述了针对 PLC 项目执行的步骤。

5.5.4 命令检查所有对象
功能：此命令可启动编译运行，即对 PLC 项目的项目树中的所有对象进行语法检查。这在创建库或处理库项
目时非常有用。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目对象（<PLC project name> 项目）的上下
文菜单

与只检查所用对象的 命令构建 PLC 项目 [} 115] 不同，在执行该命令时，将会检查 PLC 项目中所有对象的语
法。

该命令不会导致代码生成。在项目目录中未创建包含编译运行信息的文件。

5.5.5 命令构建 TwinCAT 项目

符号：

功能：此命令可启动当前活动的 TwinCAT 项目的编译过程或代码生成。

调用：如果当前选择的是 TwinCAT 项目，则调用 Build（构建）菜单，或 TwinCAT 项目的上下文菜单

要求：选择 TwinCAT 项目。

TwinCAT 项目中包含的所有项目（PLC、C++ 等）依次进行编译。在 命令构建 PLC 项目 [} 115] 部分中描述了
针对 PLC 项目执行的步骤。

另请参见：
• 命令重建 TwinCAT 项目 [} 114]

5.5.6 命令重建 TwinCAT 项目
功能：此命令可启动当前活动的 TwinCAT 项目的编译过程或代码生成，即使上次编译时没有错误也不例外。

调用：如果当前选择的是 TwinCAT 项目，则调用 Build（构建）菜单，或 TwinCAT 项目的上下文菜单

要求：选择 TwinCAT 项目。

在重建项目时，首先要对 TwinCAT 项目进行清除（另请参见：命令清除 TwinCAT 项目 [} 114]），然后再进
行构建（另请参见：命令构建 TwinCAT 项目 [} 114]）。

5.5.7 命令清除 TwinCAT 项目
功能：此命令可删除当前活动的 PLC 项目的本地编译信息，并更新所有对象的语言模型。

调用：如果当前选择的是 TwinCAT 项目，则调用 Build（构建）菜单，或 TwinCAT 项目的上下文菜单

要求：选择 TwinCAT 项目。

TwinCAT 项目中包含的所有项目（PLC、C++ 等）依次进行清除。在 命令清除 PLC 项目 [} 115] 部分中描述了
针对 PLC 项目执行的步骤。
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另请参见：
• 命令重建 TwinCAT 项目 [} 114]

5.5.8 命令构建 PLC 项目

符号：

功能：此命令可启动当前活动的 PLC 项目的编译过程或代码生成。

调用：如果当前选择的是 PLC 项目，则调用 Build（构建）菜单，或者 Solution Explorer（解决方案资源管
理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

要求：选择 PLC 项目。

在编译期间，TwinCAT 对 PLC 项目中所用的所有对象执行语法测试。当您想要用更改后的程序记录项目时，
始终自动执行编译程序。检查完成后，TwinCAT 会在 Error List [} 81]（错误列表）视图中显示任何错误消息
或警告。

此外，在构建项目时会创建 PLC 项目的编译信息，并将其保存在解决方案中的本地文件（*.compileinfo）
中。

如果自上次无错编译过程后程序未更改，则不会重新编译。如果无论如何都要执行语法测试，请使用 命令重
建 PLC 项目 [} 115]。

5.5.9 命令重建 PLC 项目
功能：此命令可启动当前活动的 PLC 项目的编译过程或代码生成，即使上次编译时没有错误也不例外。

调用：如果当前选择的是 PLC 项目，则调用 Build（构建）菜单，或者 Solution Explorer（解决方案资源管
理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

要求：选择 PLC 项目。

在重建项目时，首先要对项目进行清除（另请参见：命令清除 PLC 项目 [} 115]），然后再进行构建（另请参
见：命令构建 PLC 项目 [} 115]）。

5.5.10 命令清除 PLC 项目
功能：此命令可更新当前活动的 PLC 项目中的所有对象的语言模型。

调用：如果当前选择的是 PLC 项目，则调用 Build（构建）菜单，或者 Solution Explorer（解决方案资源管
理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

前提条件：选择 PLC 项目。

如果清除 PLC 项目，则只更新 PLC 项目中的所有对象的语言模型。目标系统上的编译信息将会保留。

另请参见：
• 命令重建 PLC 项目 [} 115]

5.6 调试

5.6.1 命令：新断点

符号：
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功能：此命令打开 Breakpoint Properties (断点属性) 对话框。

调用：Debug (调试) 菜单，Breakpoint (断点) 视图中的按钮  New (新) (PLC > Window (窗
口) > Breakpoints (断点) )。

要求：PLC 项目处于在线模式。

在线模式下，命令 Toggle Breakpoint (切换断点) 可用于直接在当前光标位置设置新断点。

另请参见：
• 命令：切换断点 [} 119]
• PLC 菜单：命令：断点 [} 131]
• PLC 文档：使用断点

断点属性对话框

立即启用断点
 断点已激活。

 断点未激活。如要稍后激活，可点击 Breakpoints（断点）视图中的

 按钮。

条件选项卡

该对话框定义程序执行应在断点处停止的条件。

任务
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仅在以下任务之一中遇到断点时
中断 ：TwinCAT 仅在某些任务达到时评估断点。所需任务必须激活。

例如，您可以定义单个“调试任务”，从而防止在调试期间也使用该功能块
的其他任务受到影响。

命中次数

命中次数 始终断开：程序始终在此断点处停止。
替代方案：当断点如以下定义的频率命中时，程序在断点处停止（输入所需
命中次数或从次数列表中选择）：
• 在命中次数达到……时断开
• 在命中次数达到……倍数时断开
• 在命中次数大于或等于……时断开

条件

如果为 TRUE，断开 条件断点的定义。仅可在在线模式下输入条件。

：TwinCAT 评估指定条件，并在结果为 TRUE 时在此断点处停止程序。
可输入有效的 Boolean 表达式作为条件。示例：x>100、x[y]=z、a AND b、
boolVar。

即使条件不为 TRUE，使用条件断点也会减慢代码执行速度。

位置选项卡
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POU 要在其中定位断点的活动 PLC 项目的功能块。
位置 POU 中的断点位置。以行号和列号（文本编辑器）或网络或项目编号的形式

指定。
实例 对于功能块，您必须指定在实现中还是在实例中设置断点

 TwinCAT 在实例中设置断点。通过此选项，您可以选择实例路径。

 TwinCAT 在实现中设置断点。

执行点设置选项卡

在这里，现有的断点可以转换为执行点。

执行点（执行不会在断点处停
止） ：断点成为执行点。此时执行不会停止，但会执行指定代码。

已启用： ，已禁用：
执行以下代码 达到执行点时执行的代码。

不可使用循环结构（For，While）以及 IF 或 CASE 表达式。
打印设备日志中的消息 此选项不可用。

另请参见：
• PLC 文档：使用断点
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5.6.2 命令：编辑断点

符号：

功能：此命令打开 Breakpoint Properties (断点属性) 对话框。

调用：Debug (调试) 菜单，Breakpoints (断点) 视图中的按钮  (PLC > Window (窗口)  > Breakpoints
(断点))

要求：PLC 项目处于在线模式。光标位于断点上。

另请参见：
• 命令：新断点 > 断点属性对话框 [} 116]
• PLC 文档：使用断点

5.6.3 命令：启用断点

符号：

功能：此命令启用禁用的断点。

调用：Debug (调试) 菜单，Breakpoints (断点) 视图中的按钮  (PLC > Window (窗
口)  > Breakpoints (断点))

要求：PLC 项目处于在线模式。光标位于禁用的断点上。

另请参见：
• PLC 文档：使用断点

5.6.4 命令：禁用断点

符号：

功能：此命令禁用已启用的断点。

调用：Debug (调试) 菜单，Breakpoints (断点) 视图中的按钮  (PLC > Window (窗
口)  > Breakpoints (断点))

要求：PLC 项目处于在线模式。光标位于已启用的断点上。

另请参见：
• PLC 文档：使用断点

5.6.5 命令：切换断点
热键：[F9]

功能：此命令设置断点或删除现有断点。

调用：Debug (调试) 菜单

要求：PLC 项目处于在线模式。光标位于断点上。
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另请参见：
• PLC 文档：使用断点

5.6.6 命令：单步跳过

符号：

快捷键：[F10]

功能：此命令可执行程序当前所处的指令，并在编程块中的下一条指令之前停止。

调用：Debug（调试）菜单、TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：PLC 项目处于在线模式。程序处于停止位置（调试模式）。

如果要执行的指令包含调用（来自程序、功能块实例、函数、方法或动作），则在 1 个步骤中可以完全遍历下
级编程块，然后程序返回到调用位置。在下一语句（下一行代码）之前停止。

选择命令 Single step（单步），跳转到下级功能块并逐步执行。

另请参见：
• 命令：单步跳入 [} 120]
• PLC 文档：

5.6.7 命令：单步跳入

符号：

快捷键：[F11]

功能：此命令可执行程序当前所处的指令，并在下一条指令之前停止。

调用：Debug（调试）菜单、TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：PLC 项目处于在线模式。程序处于停止位置（调试模式）。

如果要执行的语句包含调用（来自程序、功能块实例、函数、方法或动作），则程序会跳转到该下级编程块。
其代码在 1 个单独的编辑器中显示。在执行第 1 条指令后，程序会在下一条指令之前停止。然后，新的当前停
止位置就会出现在被调用的编程块中。

选择命令 Step over﻿（单步跳过），留在当前活动的编程块中并一步完成调用。

另请参见：
• 命令：单步跳过 [} 120]
• PLC 文档：逐步处理程序（步进）

5.6.8 命令：单步跳出

符号：

快捷键：[Shift] + [F11]

功能：此命令可执行程序，直到下一次返回，然后停止。

调用：Debug（调试）菜单、TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：PLC 项目处于在线模式。程序处于停止位置（调试模式）。
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如果当前停止位置在下级编程块中，则程序会运行至结束。然后，程序跳回到调用编程块中的调用位置，并停
在那里（在调用行中）。

如果当前停止位置在主程序中，则编程块将运行至结束。然后，程序跳回至起点（编程块中第 1 行代码处的程
序起点）并停止。

另请参见：
• PLC 文档：逐步处理程序（步进）

5.6.9 命令运行至光标处

符号：

功能：此命令可将程序执行到标有光标的位置。

调用：上下文菜单

要求：PLC 项目处于在线模式。程序处于停止位置（调试模式）。您已经用光标标记任何编程块中的任何 1 行
代码。

在 1 个步骤中执行当前停止位置和光标位置之间的指令。然后，在光标位置停止执行，光标位置成为下一个停
止位置。请注意，您放置光标的代码行已到达，但并未执行。

另请参见：
• PLC 文档：逐步处理程序（步进）

5.6.10 命令：显示下一语句

符号：

功能：此命令可显示将在下一步执行的程序语句。

调用：Debug（调试）菜单

要求：PLC 项目处于在线模式。程序处于停止位置。保持位置在您看不到的代码行中。

该命令会使当前停止位置的窗口（在代码中为黄色，并用符号  标记）进入活动状态，并显示停止位置。如
果您打开多个编辑器，而保持位置隐藏在处于非活动状态的编辑器中，这将非常有用。

另请参见：
• PLC 文档：逐步处理程序（步进）

5.6.11 命令设置下一语句

符号：

功能：此命令可决定下一步执行哪个语句。

调用：上下文菜单

要求：PLC 项目处于在线模式。程序处于停止位置（调试模式）。您已经用光标标记任何编程块中的任何 1 行
代码

标有光标的代码行将成为当前停止位置，而不执行跳转到的语句或中间语句。

另请参见：
• PLC 文档：逐步处理程序（步进）
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5.7 TwinCAT

5.7.1 命令激活配置

符号：

功能：此命令可启用新配置。先前的旧配置将被覆盖。

调用：菜单 TwinCAT、TwinCAT XAE Base toolbar options（TwinCAT XAE 基础工具栏选项）

在执行该命令后出现的确认窗口中，您可以设置是否应该为 TwinCAT 项目中的所有 PLC 项目激活 Autostart
boot project（自动运行启动项目）设置。

另请参见：
• 命令：激活启动项目 [} 249]
• 命令：自动运行启动项目 [} 249]

5.7.2 命令：重启 TwinCAT 系统

符号：

功能：此命令在运行模式下启动 TwinCAT。

调用：菜单 TwinCAT、TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)

5.7.3 命令：重启 TwinCAT (配置模式)

符号：

功能：此命令在配置模式下启动 TwinCAT (配置模式)。

调用：菜单 TwinCAT、TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)

5.7.4 命令：重新载入设备

符号：

功能：此命令加载创建的 I/O 设备。

调用：菜单 TwinCAT、TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)

5.7.5 命令：扫描

符号：

功能：此命令启动设备扫描。系统搜索可用的 I/O 设备、连接“盒”以及总线模块和 IP-Link 扩展模块 (如果适
用)。

调用：菜单 TwinCAT、TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)
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要求：在 Solution Explorer (解决方案资源管理器) 中的 TwinCAT 项目结构中选择“I/O”对象。

5.7.6 命令：切换自由运行状态

符号：

功能：此命令将查找到的 I/O 设备设置为自由运行模式。这意味着，例如，总线端子可将 I/O 通道设置 (写入)
为特定状态，而无需处于活动状态的 PLC 项目或其他触发任务。

调用：菜单 TwinCAT、TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)

要求：系统当前处于配置模式。

如果目标系统之前处于运行模式，则必须先执行一次命令 Reload Devices (重新加载设备)，然后才
能将设备 I/O 驱动程序设置为自由运行状态。

5.7.7 命令：显示在线数据

符号：

功能：此命令连接所选目标系统，并在相应视图中显示目标系统上启用的参数值和设置。

调用：菜单 TwinCAT、TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)

5.7.8 命令：选择目标系统
功能：下拉列表，选择控制应用的目标设备。

调用：TwinCAT XAE Base Toolbar Options (TwinCAT XAE 基础工具栏选项)

选择 <Local> 可将控制代码直接加载至编程设备的本地运行时。如果希望选择其他目标设备，请从下拉列表中
选择 Choose Target System (选择目标系统)。

5.7.9 命令：显示子项

符号：

功能：此命令在设备概览视图中显示元素的子元素及其属性和值。命令可以启用或禁用。该命令不涉及
TwinCAT 项目树中元素的表示。

调用：菜单 TwinCAT, TwinCAT Base XAE toolbar options (TwinCAT，TwinCAT Base XAE 工具栏选项)
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5.7.10 命令软件保护

符号：

功能：此命令可打开 Software Protection（软件保护）对话框。

调用：TwinCAT 菜单

在 Software Protection（软件保护）对话框中，您可以定义 TwinCAT 项目的安全性和用户设置。

有关安全性和用户设置的更多信息，请参见软件保护文档。

5.7.11 命令隐藏禁用项目

符号：

功能：此命令可以使禁用的对象在整个项目树中不可见并再次可见。通过这种方式，可以将显示限制为活动的
对象，从而提高项目树内的清晰度。

调用：菜单 TwinCAT、TwinCAT XAE Base toolbar options（TwinCAT XAE 基础工具栏选项）

5.8 PLC

5.8.1 窗口

5.8.1.1 命令：打开内存扫描

功能：此命令打开内存扫描视图。可在该视图中针对特定的字面值扫描整个内存或内存的某个区域。找到的内
存位置会随内存区域及内存位置相关信息一同显示在视图中。

调用：菜单 PLC > Window（PLC > 窗口）

前提条件：应用程序已加载并连接至控制单元。
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查看内存扫描

值 要搜索的值。
值类型 值的数据类型

如果数据类型与输入的值不匹配，则以红色的感叹号标识进行指示。
内存扫描选项
区域 要搜索的内存区域。
对齐方式 搜索的内存对齐方式

系统仅会检查可被该值整除的地址。

5.8.1.2 命令：显示内存视图

符号：

功能：此命令可打开内存视图。在这里，您可以以在线模式显示控制器的内存转储。在该视图中，您可以配置
应显示哪个应用程序和哪个区域的内存。

调用：菜单“PLC > Window”（PLC > 窗口）

要求：原则上，控制器可支持该功能。至少加载 1 个应用程序，且该应用程序处于在线模式。

应用程序因不小心的更改而崩溃
您可以覆盖内存视图中显示的字节，并将更改传输到控制器。TwinCAT 不会检查是否允许进行更
改。
不小心的更改会导致应用程序崩溃！

您可以指定内存转储的绝对起始地址，例如通过输入指针变量的地址值。或者，也可以通过指定区域和偏移量
来指定相对于控制器内存区域的起始地址。在内存视图中，可以导航到相邻的内存段，并将内存转储保存在文
件中。可以通过十六进制格式覆盖数据，并将更改传输到控制器。工具栏上的命令可以帮助您完成这些操作。

例如，如果在进行故障排除时逐步执行应用程序，TwinCAT 会不断更新内存转储视图。

窗口的一般结构：
• 内存转储会在左侧显示内存的十六进制地址。
• 中间以十六进制格式显示数据，每列显示 2 个字节。
• 右侧以文本形式显示数据。不属于可显示字符的数据显示为“.” （点）。

提示：如果将光标放在十六进制数据中，可以右键单击（复制地址命令）这些数据，将这些数据的地址复制到
剪贴板中。

对内存视图的解释说明如下。接下来将介绍以下用例：
• 通过变量来设置内存转储的起始地址
• 通过指定内存区域来设置内存转储的起始地址
• 编辑数据
• 对活跃应用程序进行内存检查
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内存视图

Application（应用程
序）

选择要显示内存视图的 PLC 项目。必须通过此项目登录控制器。不一定必须是“活
跃的 PLC 项目”。

Area（区域） • Absolute（绝对值）：内存直接完全寻址。地址位于其旁边的输入字段中。
• Area <i>（区域 <i>）：控制器的内存区域，从区域 0 开始。不显示专用于代码

的内存区域。
Address（地址） 核心转储的绝对起始地址

要求：在“Area”（区域）中选择“Absolute”（绝对值）。
Offset（偏移） 所选内存区域的地址偏移量，以字节为单位，例如 0x0200、16#0200 或十进制数

512
要求：在“Area”（区域）中选择内存区域，例如区域 0。TwinCAT 会提供所有当
前所用内存区域以供选择。不显示专用于代码的内存区域。
查找变量地址：显示用于选择 IEC 变量的输入助手。如果已选择变量，TwinCAT
将通过变量地址预设起始地址。
加载/更新内存视图

显示上一内存段：导航至上一内存段

显示下一内存段：导航至下一内存段

注意 TwinCAT 不会检查是否允许进行更改。如果不小心进行更改，可能会导致应
用程序崩溃
加载对 PLC 的更改：TwinCAT 将新数据传输至控制器。
要求：已在内存视图中覆盖了 1 个或多个字节。
保存存储内容至文件：显示“Save memory content as binary file”（以二进制
文件保存存储内容）对话框。选择 1 个位置。

列 内存转储十六进制格式的列数，位于窗口中间。选择“Auto”（自动）后，列数会
根据窗口大小进行调整。

通过变量来设置内存转储的起始地址
ü 您已将应用程序加载到控制器，并且已登录该应用程序。您想将某一特定变量的地址指定为内存转储的起

始地址。
1. 选择命令“View → Show Memory View”（视图 → 显示内存视图）。

ð 内存视图打开。
2. 在“Area”（区域）中输入变量地址。可以直接输入地址，例如从指针变量的值中输入，也可以使用输入

助手  选择变量。
ð “Absolute﻿”（绝对值）选项会自动设置。
ð TwinCAT 以变量地址周围的绝对区域显示内存转储。
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通过指定内存区域来设置内存转储的起始地址
ü 您已将应用程序加载到控制器，并且已登录该应用程序。您想将某一特定内存区域的起始地址和偏移量指

定为内存转储的起始地址。
1. 选择命令“View → Show Memory View”（视图 → 显示内存视图）。

ð 内存视图打开。
2. 例如，在“Area”（区域）中选择“Area 0”（区域 0）选项。可选区域的列表将视设备而定。
3. 在“Offset”（偏移）中输入所需的起始地址偏移量。例如：“512”。

提示：必须填写该字段。如果不需要偏移，请输入 0。
ð TwinCAT 显示内存区域 0 + 512 的内存转储。

编辑数据

您可以覆盖内存视图中显示的字节，并将更改传输到控制器。TwinCAT 不会检查是否允许进行更
改。如果不小心进行更改，可能会导致应用程序崩溃！

ü 您已将应用程序加载到控制器，并且已登录该应用程序。
1. 执行上文“通过指定内存区域来指定起始地址”的说明中的第 1–3 步。
2. 在内存视图中，点击数据十六进制格式的 1 个字节并输入新值。

ð 覆盖先前值的新值以红色字体显示。

3. 点击  按钮。
ð TwinCAT 将该数据传输至控制器。

对活跃应用程序进行内存检查

请参见：“检查活跃应用程序内存”命令 [} 127]

5.8.1.3 命令：显示内存使用情况

功能：此命令打开内存使用情况视图。在此视图中，可显示所选应用程序的内存使用情况。因此，您可以查看
可用内存的使用情况，例如，在开发过程中观察内存分配状况。

调用：菜单 PLC > Window（PLC > 窗口）

前提条件：应用程序已加载并连接至控制单元。

查看内存使用情况

应用程序 选择列表包含当前已连接控制单元上的应用程序。
刷新所选应用程序的视图。

打开标准的 Save As（另存为）对话框，可将显示的内存使用情况另存为计算机文件系统
中的 *.csv 文件。

5.8.1.4 “检查活跃应用程序内存”命令

功能：该命令可对活跃应用程序的内存区域进行检查。需对内存进行各种检查。结果会显示在信息窗口中。

调用：PLC > Window（PLC > 窗口）菜单

要求：至少加载 1 个应用程序，且该应用程序处于在线模式。

对活跃应用程序的内存区域进行以下检查：
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• BOOL 变量是否有定义值。
• STRING 和 WSTRING 变量是否已终止。
• 枚举变量是否具有有效值。
• 子区域类型的变量是否具有有效值。
• 常量块类型（STRUCT、ARRAY 等）的变量与其初始化值相比，是否保持不变。
• 函数指针地址是否具有内部一致性。
• 项目中的函数指针是否指向由 TwinCAT 3 PLC 管理的内存。是否已排除指向库块或外部块的函数指针；

可将这些函数指针存储在外部内存中。
• 指向某种类型的指针会指向这种类型的内存位置。
• 指针是否指向地址或根据类型分级进行对齐、或为 0 或 -1 的内存位置。
• 接口变量和函数表格指针是否具有内部一致性。
• 编译块的代码是否保持不变。

注意：带有断点的编译块不在检查范围内，因为会在运行时对这些块的代码进行操作。

检查结果将显示在消息窗口中。若违反检查标准，将会显示警告。

如果双击某个警告，则会显示内存视图，相关位置会以橙色突出显示。也可以通过“命令：显示内存视图
[} 125]”打开内存视图。

可要求使用“memory_check”属性进行检查。

5.8.1.5 命令：监视列表 <n>

符号：

功能：此命令打开视图 Watch List <n> (监视列表 <n>)。您可以使用项目中的变量填充监视列表，以便能够
在单个视图中以在线模式监控、强制或写入这些变量的值。n 可以为 1、2、3、4，表示最多可以配置四个监
视列表。

调用：菜单 PLC > Window (PLC > 窗口)

另请参见：
• PLC 文档：使用监视列表

5.8.1.6 命令：监视所有强制执行

符号：

功能：此命令可打开 Watch all forces（监视所有强制执行）视图，这是特殊形式的监视列表。

调用：PLC > Window（PLC > 窗口）菜单

要求：在离线或在线模式下打开 PLC 项目。

该视图包含列表中当前准备强制执行的 PLC 项目的所有变量以及 PLC 项目的所有强制执行变量。在列表中，
您可以执行在其他监视列表中可能执行的动作。

显示所有强制执行

以表格形式显示已经强制执行或准备强制执行的应用程序的所有变量
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表达式 变量名
数据类型 变量的数据类型
值 变量的当前强制值
准备值 为强制执行准备的值
在周期开始时被覆盖的值 对于输入，在执行用户代码之前，实际值已被强制值覆盖。因此，这就是实际

值。
对于输出，这是强制值。

在周期结束时被覆盖的值 对于输出，这是在周期中计算出的值。但是，在周期结束时，该值会被强制值
覆盖。
对于输入，这是强制值。

此外，Unforce（取消强制）选择菜单包含以下命令：
• Unforce and keep all selected values（取消强制并保留所有选定值）：对于列表中的所有选定条

目，变量将被设置为强制值，并取消强制。
• Unforce and restore all selected values（取消强制并保存所有选定值）：对于列表中的所有选定条

目，变量将被重置为强制之前的值，并取消强制。

另请参见：
• PLC 文档：强制和写入变量
• PLC 文档：使用监视列表

5.8.1.7 命令：交叉引用表

符号：

功能：此命令打开 Cross Reference List (交叉引用列表) 视图。

调用：菜单 PLC > Window (PLC > 窗口)

交叉引用列表视图

此视图显示项目中符号的交叉引用列表。符号可以是变量、POU（程序、功能块、函数）或用户特定的数据类
型（DUT）。

交叉引用列表基本上提供 2 种类型的搜索：
• 文本搜索：输入符号名称可显示项目中与该名称相关的所有符号的交叉引用。如果找到多个具有相同名

称的符号，则可通过上下文菜单将显示范围限制为单个声明。
• 声明搜索：通过输入助手或输入限定路径可以选择符号，例如 MAIN.nVar。之后，即使存在具有相同名

称的其他符号，也只会显示该符号的使用位置。

工具栏
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名称 
（输入字段）

符号名称（变量名、功能块名称、DUT 名称）
可能的条目：

• 通过输入助手（  按钮）选择声明的符号
• 手动输入符号名称。

通过  按钮或 [Enter] 键触发搜索。
您可以使用占位符“*”（任意数量的字符）或“?” （任意字符）与用于文本搜索的
变量标识符的子字符串的组合。如果您想要搜索 IEC 地址，可使用“%”。示例：
“%MW8”、“%M*”

视图 Cross Reference List（交叉引用列表）之外的其他选项：
• 如果在编辑器中选择声明符号的名称，或者光标位于名称中，则使用上下文菜单命令

Find All References（查找所有引用）。
• 如果在编辑器中选择声明符号的名称，或者光标位于名称中，则自动进行。如果在项

目树中选择对象，也可以进行自动搜索。
要求：Cross Reference List（交叉引用列表）视图已打开，TwinCAT 选项
Automatically list selection in cross reference view（在交叉引用视图中自动选
择列表）（Smart Coding（智能编码）类别）已激活。

以下条目有效：
• 变量名，简单或限定：例如，“nVar”、“MAIN.nVar”
• 功能块名称：例如，“MAIN”、“FB_MyFB”
• DUT 名称：例如，“ST_MySTRUCT”
• 字符串与占位符“*”（任意字符）或“?”的组合 （任意字符）：

示例：
“nVar*”匹配 nVar1、nVarGlob2、nVar45 等……
“nVar?” 匹配 nVar1、nVar2、nVarX 等，但不匹配 nVarGlob2、nVar45 等

• “%<IEC address>”：TwinCAT 搜索已分配给该地址的变量并直接访问内存。
示例：“%QB0”、“%Q0 := 2”

输入字符串开头和结尾的大写/小写和空格将被忽略。
打开输入助手，以选择符号。

查找交叉引用：执行搜索。

定义搜索字符串的列

筛选器 
（输入字段）

要在所选列中搜索的字符串
找到的位置被标记为黄色。没有该字符串的交叉引用将被隐藏。
显示上一个交叉引用的源位置

显示下一个交叉引用的源位置

将结果限制为当前声明
当发现 1 个符号有多个声明时可用。限制显示为您刚刚在列表中选择的声明。
显示所选交叉引用的源位置：焦点跳转到符号的使用位置。

打印交叉引用列表：显示用于设置打印作业的标准对话框。

找到交叉引用表
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符号 符号（变量、POU、DUT）的位置按其声明分组。声明位置构成根节点，项目中的使用
点在其下方缩进。系统会显示该符号在使用时的准确表达式。
示例：如果项目中有 1 个全局变量“nVar”，且功能块中有 1 个局部声明的变量
“nVar”，则在交叉引用的文本搜索后，在列表中会出现 2 个根节点条目，变量
“nVar”的相应使用点在下方显示。

功能块 例如，功能块名称、DUT 名称；在任务配置中功能块调用的情况下还有任务名称。
变量 纯变量名。示例：“nVar”。
访问 在使用时访问变量的类型：

声明/读取/写入/调用。
指针特例：在搜索“nVar1”时，类型赋值 pSample := ADR(nVar1) 显示为 Write |
 Address（写入|地址）。原因：在搜索“nVar1”时，不显示对“pSample”的任何写
入访问。通过指针变量也可以进行写入访问。

上下文 使用变量的上下文。
示例：“nVar := 1”

类型 变量的数据类型。
地址 IEC 地址，如果分配至变量。

示例：“AT%QB0”
位置 相关 POU 编辑器内的使用位置：例如，行号、网络编号、声明部分或实现部分。

示例：“第 1 行，第 1 列（Impl）”或“第 9 行（Decl）”。
对象 POU 名称 + 方括号内使用点的完整路径。

示例：“MAIN [TwinCAT_SampleProject: PLC: SamplePLCProject]”
注释 注释，如果存在于变量声明中。

搜索将返回项目中以及已插入未编译库中的所有位置。

交叉引用列表的上下文菜单中的命令

显示源代码位置 打开受影响的功能块并标记使用位置：对于根条目，标记声明；对于其下面的子条
目，标记各自的使用位置。或者，您也可以双击 1 行。

将结果限制为当前声明 如果找到多个声明，则将结果显示限制为所选符号声明。
全部展开 列表显示所有单个位置。
全部折叠 列表只显示所有位置的根节点。

另请参见：
•
•
•
• PLC 文档：使用交叉引用列表查找出现

5.8.1.8 命令：断点

符号：

功能：此命令打开 Breakpoints (断点) 视图。

调用：菜单 PLC > Window (PLC > 窗口)

断点视图

该视图提供了应用的所有已定义断点的概述。视图中提供了所有断点命令。
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当前断点表

应用 从列表中选择所需的 PLC 项目。
POU 包含断点的功能块名称。
位置 POU 中的断点位置

• 文本编辑器：行号和列号
• 图形编辑器：网络或元素编号
如果是功能块，则“(Impl)”表示断点在功能块的实现中，而不是在实例中。

实例路径 断点位置的完整对象路径。
任务 断点有效执行的任务名称。如果没有限制，则显示“(all)”。
条件 • 始终中断：未定义其他启用条件。断点始终处于活动状态。

• 布尔表达式。表达式必须返回 TRUE 才能使断点处于活动状态。
计数次数条件 指示断点应生效的时间 (其中依赖于计数次数)。
当前计数次数 指定在执行期间断点已经传递 (“计数”) 的频率。

工具栏

新断点
(对应于 Debug (调试) 菜单中的命令
命令：新断点 [} 115])

打开 Breakpoint Properties (断点属性) 对话框

清除断点 删除断点。
不要将此命令与禁用命令混淆。

启用/禁用断点
(对应于 Debug (调试) 菜单中的命令
命令：启用断点 [} 119]和命令：禁
用断点 [} 119])

在“启用”和“禁用”状态之间切换断点或执行点。

•  断点已启用

•  断点已禁用

•  执行点已启用

•  执行点已禁用
与 Clear breakpoint (清除断点) 相反，禁用的断点仍保留
在列表中，而且可以再次启用。

属性 打开 Breakpoint Properties (断点属性) 对话框以编辑断
点参数。在在线模式下，可以在此处将断点转换为执行
点。

转到源代码位置 打开相应功能块的在线视图。光标位于断点位置。

删除所有断点 删除应用的所有断点和执行点。列表已清空。不要与禁用
混淆！

启用所有断点 启用所有当前禁用的断点和执行点。

禁用所有断点 禁用所有当前启用的断点和执行点。这些点保留在列表
中，且可以重新启用。

另请参见：
• 命令：新断点 > 断点属性对话框 [} 116]
• 命令：切换断点 [} 119]
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• PLC 文档：使用断点

5.8.1.9 命令：调用栈

符号：

功能：此命令打开 Call Stack (调用堆栈) 视图。

调用：菜单 PLC > Window (PLC > 窗口)

调用堆栈视图

如果要逐步运行程序，该视图十分有用。视图显示当前到达的位置以及完整的调用路径。

应用 控制当前达到的程序块的活动 PLC 项目名称。
任务 控制当前达到的程序块的任务名称。

POU 程序执行所在程序块的名称。
列表中第一行描述了当前的执行位置。通过黄色箭头进行标记。如果此位置在另一
功能块调用的功能块中，则在第二行中描述调用位置。如果调用端被另一功能块调
用，则在第三行中描述此调用位置，依此类推。

位置 位于程序执行所在程序块内的位置
• 文本编辑器的行号和列号
• 图形编辑器的网络或元素编号

实例路径 执行程序的实例。

如果未使用任何调试功能，则调用堆栈也可在脱机模式和正常在线模式下使用。在这种情况下，其包含在逐步
执行期间显示的最后位置，但是以“灰色”字体显示。

与 Call Stack (调用堆栈) 视图相反，Call Tree (调用树) 视图随时提供关于功能块的调用信息。

另请参见：
• PLC 文档：使用断点

5.8.1.10 命令：调用树

符号：

功能：此命令打开 Call Tree (调用树) 视图。

调用：菜单 PLC > Window (PLC > 窗口)

调用树视图

编译应用前，可以随时使用调用树。它是功能块的调用端和调用的静态表示，可以显式指定。这意味着调用树
始终包含两个根节点，在这些根节点下，相应的调用序列显示为连续缩进条目。在此树视图中可以快速识别递
归调用。
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功能块 (2) MAIN 的调用树 (1) 示例：

• (3) 节点“<function block name> 被调用：”
• (4) 节点“<function block name> 调用：”

POU 名
通过从其他视图拖动或使用  按钮手动输入程序块的名称。
选择列表包含最后输入的功能块名称。

工具栏和键盘操作

<  查找功能块 TwinCAT 搜索“功能块名称”中指定的功能块，并显示其调用端和调用。

 从输入助手获取功能
块

Input Assistant (输入助手) 对话框出现，用于选择功能块调用或实例调用。选择
后，调用树将自动更新。

 显示所选功能块的源
代码位置

TwinCAT 跳转到程序源代码中所用功能块的位置。

 显示下一功能块的源
代码位置

 显示上一功能块的源
代码位置

调用树中的选择跳转到调用结构中的下一或上一功能块。同时，在相关编辑器中打
开相应的源代码位置。
双击“调用树”中的条目也可打开相应的源代码位置。

显示调用树

位置 对于调用树中的根节点：功能块声明 (“Decl”) 的行号。
对于根节点下的调用端和调用：取决于实现语言、行号、列号、位置网络号。

当前在树中所选条目的上下文菜单

全部折叠 除两个根节点外，调用树中的扩展条目将被折叠。
显示源代码位置 TwinCAT 跳转到程序源代码中所用功能块的位置。
设置为新根节点 调用树中的所选条目以“功能块名称”显示。树将自动适应新的根节点。

相比始终为功能块提供调用信息的静态调用树，Call Stack (调用堆栈) 视图用于在逐步处理程序期间
的即时信息。调用堆栈始终显示当前到达位置的完整调用路径。
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5.8.1.11 命令在线更改内存保留设置

功能：此命令可打开 Online Change Memory Reserve（在线更改内存保留）视图。

调用：菜单 PLC > Window（PLC > 窗口）。

该视图用于为功能块的在线更改配置内存保留。

浏览应用程序 • 搜索所选 PLC 项目中的功能块，并在 Function
blocks（功能块）区域中显示它们

• 在再次编译 PLC 项目之后，更新 Function blocks
（功能块）区域

• 在在线更改之后，更新 Function blocks（功能块）
区域

打开的 TwinCAT 项目的 PLC 项目选择列表 选择要在该视图中显示和/或编辑其功能块的 PLC 项目

功能块：

全部 显示所选 PLC 项目的所有功能块。
无内存保留 显示内存保留为 0 字节的所有功能块。
<Memory reserve> 字节 显示具有在 memory reserve（内存保留）中定义的字

节数的所有功能块。
关于功能块的信息
在选择用于配置内存保留的功能块时，也可以进行多项选择。
功能块 功能块的名称
大小 功能块的大小

功能块实例的大小
以字节为单位的规格

实例数 项目中的功能块的实例数
内存保留 显示功能块的每个实例的内存保留量
所有实例的额外内存 实例数与内存保留的乘积
剩余内存保留 每个功能块实例可用作保留的字节数

设置：

内存保留（以字节为单位） 所选功能块的内存保留的输入字段。
以字节为单位的规格
要求：控制器上尚没有 PLC 项目，或者您已通过点击
Allow editing（允许编辑）区域中的 Allow（允许）按
钮允许更改内存保留。

适用于选择 memory reserve (in bytes)（内存保留（以字节为单
位））将被分配给功能块，Memory reserve（内存保
留）表格列也将更新。
如果选择多个功能块，则会将输入的值分配给每个功能
块。
如要更新 Size（大小）、Number of instances（实例
数）、Additional memory for all instances（所有实
例的额外内存）和 Remaining memory reserve size
（剩余内存保留大小）列，首先要选择 Create >
Create（创建 > 创建），然后点击 Browse
application（浏览应用程序）按钮。
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启用编辑：

启用 输入字段 Memory reserve (in bytes)（内存保留（以
字节为单位））变为可编辑。
该按钮变为 Editable（可编辑）。

信息：

FB 的数量 PLC 项目中功能块的总数
所有实例的额外内存 PLC 项目的所有功能块实例的内存保留总和

以字节为单位的规格

另请参见：
• PLC 文档：对 PLC 项目进行编程 > 为在线更改配置内存保留

5.8.1.12 命令 PLC 书签

符号：

功能：此命令可打开视图 Bookmarks（书签）。

调用：PLC > Window（PLC > 窗口）菜单

 上一个书签 跳转到所选行上一行表格中显示的书签，并在编辑器中打开相应的
POU。

 下一个书签 跳转到所选行下一行表格中显示的书签，并在编辑器中打开相应的
POU。
从表格和相应的 POU 中删除所选书签。

项目书签列表，包含书签、对象和位置信息：

书签 TwinCAT 按照编号升序分配的书签名称：Bookmark_0、Bookmark_2
等。
当您选中书签并点击进入该字段时，它会变成可编辑状态，您可以更改书
签名称。

对象 设置书签的 POU 的名称和项目路径
位置 书签在 POU 中的位置

例如：第 3 行，第 1 列（Impl）
（Impl）：在 POU 的实现部分中
（Decl）：在 POU 的声明部分中

您可以通过拖放来更改书签的顺序。

如果您双击 1 行，则 TwinCAT 会在编辑器中打开相应的对象并跳转到此书签。

另请参见
• 命令上一个书签 [} 139]
• 命令下一个书签 [} 138]
• 设置和使用书签（“PLC”文档）
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5.8.2 核心转储

5.8.2.1 命令生成核心转储

功能：此命令可令 TwinCAT 首先检查目标系统上是否已有核心转储文件。
• 如果目标系统上有核心转储文件，则 TwinCAT 可以为您将该文件加载到项目目录中。对于是否从目标系

统加载核心转储文件的询问，有 3 种不同的回应方式。
◦ 是：如果目标系统的核心转储文件与当前登录的 PLC 项目相匹配，则 TwinCAT 会从目标系统将核

心转储文件加载到项目目录中。随后退出 PLC 项目并使用 命令加载核心转储 [} 137]，您可以打开
该文件。

◦ 否：在项目目录中将会生成 1 个新的核心转储文件。这样做的前提条件是，PLC 项目当前处于断点
或出现异常错误。

◦ 取消：中止生成核心转储文件。
• 如果目标系统上没有可用的核心转储文件，则 TwinCAT 将使用项目目录中的当前 PLC 项目数据启动新

文件的生成。这样做的前提条件是，PLC 项目当前处于断点或出现异常错误。

生成的核心转储文件会直接保存在 PLC 项目目录下：<PLC_project_name>.<PLC_project_GUID>.core

调用：菜单 PLC > 核心转储

要求：PLC 项目处于在线模式。

在目标系统上自动生成核心转储
如果在目标系统上运行的 PLC 项目当前未登录开发环境，则在出现异常错误时，运行时系统会在目
标系统上自动生成核心转储。该文件默认位于目标系统的启动文件夹中（默认情况下，对于
TC3.1.4026.0 以下版本：C:\TwinCAT\3.1\Boot\Plc；对于 TC3.1.4026.0 及以上版本：C:
\ProgramData\Beckhoff\TwinCAT\3.1\Boot\Plc）。如果需要，您可以修改自动创建核心转储的存
储路径，有关更多信息，请参见利用核心转储进行错误分析。
借助命令 Generate core dump（生成核心转储），可将该核心转储文件从目标系统自动加载到本
地项目目录中。还可以将核心转储文件从目标系统复制到开发计算机中。
因此，使用命令加载核心转储 [} 137]显示转储，可用于（后续的）错误分析。

核心转储只能与相关的编译信息文件一起使用
如果您存档或保存核心转储文件，请注意，您必须有相关的项目和相关的编译信息文件
（*.compileinfo 文件，例如，在创建项目时存储在“_CompileInfo”文件夹中），才能加载核心转
储。否则，TwinCAT 以后将无法使用转储。
另请注意此处 设置选项卡 [} 111] 上的设置选项。借助 Core Dump（核心转储）设置，您可以配置
是否将可能位于项目目录下的核心转储文件与可用的编译信息文件一起保存在 TwinCAT 文件存档
中。

另请参见：
• PLC 文档：运行时的 PLC 项目 > 利用核心转储进行错误分析
• 命令加载核心转储 [} 137]

5.8.2.2 命令加载核心转储

功能：TwinCAT 在项目目录中搜索核心转储文件。
• 如果 TwinCAT 在项目目录中找到核心转储文件，则系统会询问您是想要加载该核心转储还是想要浏览转

储文件。
• 如果 TwinCAT 在项目目录中找不到核心转储文件，则您可以浏览其他转储文件。

加载到项目中会导致显示 PLC 项目的在线视图，其中包含在创建核心转储时的 PLC 项目的状态。您可以查看
其中包含的变量值。调用树也可供使用。
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调用：菜单 PLC > 核心转储

要求：应用程序处于离线模式。

核心转储视图只能通过 命令关闭核心转储 [} 138] 命令再次关闭。“Logout”（退出）命令在此视图
中无效。

核心转储只能与相关的编译信息文件一起使用
如果您存档或保存核心转储文件，请注意，您必须有相关的项目和相关的编译信息文件
（*.compileinfo 文件，例如，在创建项目时存储在“_CompileInfo”文件夹中），才能加载核心转
储。否则，TwinCAT 以后将无法使用转储。
另请注意此处 设置选项卡 [} 111] 上的设置选项。借助 Core Dump（核心转储）设置，您可以配置
是否将可能位于项目目录下的核心转储文件与可用的编译信息文件一起保存在 TwinCAT 文件存档
中。

另请参见：
• PLC 文档：运行时的 PLC 项目 > 利用核心转储进行错误分析
• 命令生成核心转储 [} 137]
• 命令关闭核心转储 [} 138]

5.8.2.3 命令关闭核心转储

功能：此命令可关闭当前在开发环境中打开的 PLC 项目的核心转储视图。

调用：菜单 PLC > 核心转储

要求：PLC 项目处于离线模式，您已将核心转储文件加载到项目中。

另请参见：
• PLC 文档：运行时的 PLC 项目 > 利用核心转储进行错误分析

5.8.3 PLC 书签

5.8.3.1 命令启用/禁用书签

符号：

功能：此命令可设置或删除当前位置的书签。

调用：PLC > PLC Bookmarks（PLC > PLC 书签）菜单

要求：POU 在编辑器中打开，光标位于程序行中。

另请参见
• 书签（文档“PLC”）

5.8.3.2 命令下一个书签

符号：

功能：此命令可在 Bookmarks（书签）视图和项目中跳转到下一个书签，并打开相应的 POU。书签跳转的顺
序与 Bookmarks（书签）视图表格中的书签顺序相对应。
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调用：
• 菜单 PLC > PLC Bookmarks（PLC > PLC 书签）

• Bookmarks（书签）视图中的按钮  Next bookmark（下一个书签）

要求：
• 1 个项目已打开
• Bookmarks（书签）视图已打开

另请参见：
• 命令 PLC 书签 [} 136]
• 命令下一个书签（活动编辑器） [} 140]
• 书签（文档“PLC”）

5.8.3.3 命令上一个书签

符号：

功能：此命令可在 Bookmarks（书签）视图和项目中跳转到上一个书签，并打开相应的 POU。书签跳转的顺
序与 Bookmarks（书签）视图表格中的书签顺序相对应。

调用：
• 菜单 PLC > PLC Bookmarks（PLC > PLC 书签）

• Bookmarks（书签）视图中的按钮  Previous bookmark（上一个书签）

要求：
• 1 个项目已打开
• Bookmarks（书签）视图已打开

另请参见：
• 命令 PLC 书签 [} 136]
• 命令上一个书签（活动编辑器） [} 140]
• 书签（文档“PLC”）

5.8.3.4 命令清除所有书签

符号：

功能：此命令可删除已打开项目的所有书签。

调用：PLC > PLC Bookmarks（PLC > PLC 书签）菜单

要求：POU 在编辑器中打开，光标位于 POU 中。

另请参见：
• 命令清除所有书签（活动编辑器） [} 140]
• 书签（文档“PLC”）
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5.8.3.5 命令下一个书签（活动编辑器）

符号：

功能：此命令可跳转到活动编辑器中的下一个书签。

调用：PLC > PLC Bookmarks（PLC > PLC 书签）菜单

要求：POU 在编辑器中打开，光标位于 POU 中

另请参见：
• 命令下一个书签 [} 138]
• 书签（文档“PLC”）

5.8.3.6 命令上一个书签（活动编辑器）

符号：

功能：此命令可跳转到活动编辑器中的上一个书签。

调用：PLC > PLC Bookmarks（PLC > PLC 书签）菜单

要求：POU 在编辑器中打开，光标位于 POU 中

另请参见：
• 命令上一个书签 [} 139]
• 书签（文档“PLC”）

5.8.3.7 命令清除所有书签（活动编辑器）

符号：

功能：此命令可删除活动编辑器中的所有书签

调用：PLC > PLC Bookmarks（PLC > PLC 书签）菜单

要求：POU 在编辑器中打开，光标位于 POU 中。

另请参见：
• 命令清除所有书签 [} 139]
• 书签（文档“PLC”）

5.8.4 命令：下载
功能：此命令编译活动的 PLC 项目，然后将其下载到控制器。

调用：PLC 菜单

要求：PLC 项目处于在线模式。

通过此命令，TwinCAT 执行语法检查并生成程序代码。此代码加载到控制器上。另外，TwinCAT 还在项目目
录中生成编译日志 <projectname>.<devicename>. <application ID>. compileinfo。

在下载期间，除了持久型变量，所有变量都将重新初始化。
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Login (登录) 命令说明解释了登录和加载时可能出现的情况。

如果在试图加载 PLC 项目的同时，已有该项目的相同版本位于控制器上，则会显示以下消息：“The
program is unchanged. Application was not loaded (程序未更改。未加载应用)”。TwinCAT 不会将项目加
载到 PLC 上。

加载时，将在 Output (输出) 视图中显示已执行操作的日志 (创建代码、执行初始化等)。此外，还显示关于存
储区域、代码大小、全局数据和分配存储器的信息。为清晰起见，与在线更改相比，不再列出已更改的功能
块。

另请参见：
• 命令登录 [} 142]

5.8.5 命令在线更改
功能：此命令可用于启动当前活动的 PLC 项目的在线更改。TwinCAT 仅将已在控制器上运行的 PLC 项目的修
改部分重新加载到控制器中。

调用：PLC 菜单

要求：PLC 项目处于在线模式。

在 Clean All（全部清除）和 Clean（清除）命令后无法进行在线更改。清除过程将删除每次生成代码时自动
保存并构成在线更改基础的编译信息（编译日志）。

 警告
由于设备或系统的意外行为而造成的财产和人身损害
在线更改会修改正在运行的应用程序，并且不会导致重新启动。根据不同的受控设备，可能会损坏设备或工
件，或者可能会危及人员的健康和生命。
• 确保新程序代码实现受控系统的所需行为。

项目特定的初始化
在执行在线更改时，由于设备保持其状态，因此不会执行项目特定的初始化（归位等）。为此，新程
序代码可能没有所需的效果。

下载代码中的重大更改
如果在线更改导致下载代码发生重大变化（例如，需要切换变量），则会出现 1 个对话框，提供有关
效果的信息，并允许您取消在线更改。

快速在线更改
对于微小更改（例如在实现部分中，不需要切换变量），执行“快速在线更改”。此时，仅会编译和
重新加载修改后的功能块。特别是，在这种情况下不会生成初始化代码。这也意味着不会生成带
“init_on_onlchange”属性的初始化变量代码。通常情况下这不会产生影响，因为该属性一般用于
对带地址的变量进行初始化。但是，快速在线更改不会导致变量地址发生变化。
如要确保将 init_on_onlchange 属性应用于整个应用程序代码，可通过编译器定义
no_fast_online_change 禁用 PLC 项目的快速在线更改功能。为此，可在 PLC 项目属性的 Compile
[} 95]（编译）类别中插入定义。

“init_on_onlchange”属性对单个 FB 变量没有影响
属性“init_on_onlchange” 仅适用于功能块的全局变量、程序变量和局部静态变量。
如要在在线更改期间重新初始化功能块，务必使用属性来声明功能块实例。对于功能块中的单个变
量，不会对属性进行评估。

指针变量
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指针保留了上一个周期的值。如果指针指向已通过在线更改调整大小的变量，并因此在内存中移动，则指针变
量不再返回变量的正确位置。确保在每个周期中重新分配指针。

在可能产生意外后果的在线更改过程中，TwinCAT 会在 Details（详细信息）对话框中列出已更改的接口、受
影响的变量以及已生成新代码的所有功能块。如果存储位置发生变化，则会显示对话框，指明指针可能存在问
题。

另请参见：
• PLC 文档：对 PLC 项目进行编程

什么会阻止在线更改？

在某些 TwinCAT 动作之后，将无法再在控制器上进行在线更改。此后必须重新下载项目。1 个典型的例子是
进行 Clean（清除）和 Clean all（全部清除）操作后，它们会删除在上一次下载期间所存储的编译信息。不
过，也有一些“常规”的编辑动作会导致您在下次登录时无法进行在线更改。以下动作可能会阻止在线更改：

检查函数 激活或删除检查函数（CheckBounds、CheckRange、CheckDiv 等）。
更改检查函数的接口（包括插入或删除局部变量）。

任务配置 更改配置设置。
项目设置 类别编译 [} 95]：更改 Settings（设置）部分中的编译器定义（替换常量）

高级类别 [} 104]：允许在 1 个解决方案中多次出现具有相同 ID 的对象
功能块属性 更改选项 External implementation（外部实现）
功能块 更改功能块的基本块（EXTENDS FB_Base），或者插入或删除这样的基本块。

更改接口列表（IMPLEMENTS I_Sample）。例外：在列表末尾添加新接口。
数据类型 将变量的数据类型从一 种用户定义的数据类型改为另一种用户定义的数据类型（例

如，从 TON 改为 TOF）。
将数据类型从用户定义的数据类型改为基本数据类型（例如，从 TON 改为
TIME）。
注意：作为 1 种变通方法，应在修改变量数据类型的同时一并修改变量名称。因
此，该变量将作为新变量被初始化，旧变量则被删除。之后便可以进行在线更改。

另请参见：
• 执行在线更改
• 命令登录 [} 142]

5.8.6 命令登录

符号：

功能：此命令可将编程系统（所选 PLC 项目）与目标系统（控制器）连接，从而建立在线操作。在目标系统
上创建 PLC 项目的实例并加载。

调用：PLC 菜单或 TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）或 Solution Explorer（解
决方案资源管理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

要求：PLC 项目无错误，目标系统处于运行模式。

可能的登录情况：
• 控制器尚不存在 PLC 项目：系统将提示您确认下载。
• PLC 项目已在控制器上，且自上次下载后未更改。无需进一步互动即可登录。
• PLC 项目已在控制器上，但自上次下载后已更改。

系统将提示您选择以下选项之一：
◦ 在线更改后登录（请参见“命令在线更改 [} 141]”部分中的说明）
◦ 下载后登录
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◦ 无更改登录
此时，您还可以更新控制器上的启动项目。

• 控制器上已存在未知版本的 PLC 项目。系统将询问您 TwinCAT 是否应该替换它。
• PLC 项目的 1 个版本已在控制器上运行。系统将询问您 TwinCAT 是否应该登录并覆盖当前正在运行的

PLC 程序。
• 控制器上的 PLC 程序当前停止在断点处。您已退出并更改程序：TwinCAT 警告您，如果在线更改或下

载，PLC 将完全停止。即使有多个任务并且只有其中 1 个受断点影响，也会发生这种情况。

登录前编译项目

如果 PLC 项目自上次更改后尚未编译，则 TwinCAT 会在登录前编译项目。此操作对应于命令 Compile in
logged-out state (在注销状态下编译)。

如果在编译时发生错误，则会显示一个消息对话框。错误显示在 Error List (错误列表) 视图中。然后，您可以
决定是否希望在不将程序加载到控制器的情况下登录。

另请参见：
• 命令构建 PLC 项目 [} 115]

登录时出错

如果在登录控制器时发生错误，TwinCAT 将中断加载过程并显示错误消息。错误对话框可以显示错误详情。
如果发生异常错误并且日志消息中包含文本 *SOURCEPOSITION*，则可以使用命令“在编辑器中显示”以在
编辑器中显示相关功能。光标跳转至导致错误的行。

输出关于加载过程的信息

如果 TwinCAT 在登录时将项目加载到控制器上，则消息窗口中将显示以下信息：
• 生成代码的大小
• 全局数据的大小
• 控制器上的存储器要求
• 受影响的功能块列表 (用于在线更改)

在在线模式下，无法更改设备或模块的设置。如要更改设备参数，必须退出 PLC 项目。但是，根据
总线系统，可能存在一些可以在在线模式下更改的特殊参数。

TwinCAT 分别针对在线和脱机模式存储视图配置。此外，关闭无法在操作模式下使用的视图。为
此，登录时视图可能会自动更改。

5.8.7 命令：开始

符号：

键盘快捷键：[F5]

功能：此命令开始执行程序。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)

要求：PLC 项目处于在线模式。

通过 PLC 菜单调用命令时，会影响当前启用的 PLC 项目。
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5.8.8 命令：停止

符号：

键盘快捷键：[Shift] + [F5]

功能：此命令停止执行程序。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)

要求：PLC 项目处于在线模式。

通过 PLC 菜单调用命令时，会影响当前启用的 PLC 项目。

5.8.9 命令：登出

符号：

功能：此命令终止开发系统与目标系统 (控制器或模拟设备) 之间的连接，从而切换到脱机模式。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)

5.8.10 命令冷重置

符号：

功能：此命令可将活动的 PLC 项目的所有变量重置为其初始化值，PERSISTENT 和 RETAIN 变量除外。

调用：菜单 PLC、TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：PLC 项目处于在线模式。

活动的 PLC 项目的所有变量都将被重置，PERSISTENT 变量和 RETAIN 变量除外。情况与控制器上已加载应
用程序（“冷启动”）启动时的情况相同。

执行此命令后，仍会启用在重置活动的 PLC 项目之前启用的 PLC 程序断点。执行此命令后，之前禁用的断点
仍会禁用。

如果您在程序停在断点处时选择此命令，则系统将询问您是否终止当前周期。或者，TwinCAT 立即执行重
置。但是，并非所有运行时系统都能够在不终止当前周期的情况下执行重置。

重置后，您必须通过 Start（启动）命令启动 PLC 程序。

另请参见：
• PLC 文档：剩余变量 - PERSISTENT，RETAIN
• PLC 文档：重置 PLC 项目
• 命令：初始值复位 [} 144]
• 命令：开始 [} 143]

5.8.11 命令：初始值复位

符号：

功能：此命令将活动 PLC 项目的所有变量 (包括掉电保持变量 (RETAIN、PERSISTENT 变量)) 重置为其初始化
值，并从控制器中删除应用程序。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)
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要求：PLC 项目处于在线模式。

重置会停用程序中当前设置的断点。如果在程序停在断点处时选择此命令，系统将询问是否终止当前循环。或
者，TwinCAT 立即执行重置。但是，并非所有运行时系统都能够在不终止当前循环的情况下执行重置。

另请参见：
• 命令冷重置 [} 144]

5.8.12 命令：单循环

符号：

功能：此命令执行一个周期的活动 PLC 程序。终止已启动的循环。断点将被忽略。

调用：菜单 PLC、TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：PLC 项目处于联机模式。

5.8.13 命令：切换流程控制模式

符号：

功能：此命令激活或停用流程控制。

调用：菜单 PLC、TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：PLC 项目处于联机模式。

在激活流程控制的对话框中，从选择列表中可以选择要应用流程控制的任务。默认情况下，选择 Select task
automatically（自动选择任务）选项。如果已经激活流程控制模式，则在解决方案资源管理器中所有任务的
上下文菜单中命令 Flow Control（流程控制） → Select this task（选择此任务）和 Flow Control（流程控
制） → Select task automatically（自动选择任务）均可用，以便选择另一个任务进行流程控制。

启用流程控制会延长 PLC 项目的运行时间！

另请参见：
• 文档 PLC：流程控制

5.8.14 命令：强制值

符号：

功能：此命令将控制器上的变量值永久设置为预定义值。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)

要求：PLC 项目处于在线模式。

 谨慎
受控系统异常行为导致的物料损坏和人身伤害
更改控制器上运行的 PLC 程序中的变量值可能会导致受控系统的异常行为。根据受控系统，可能会损坏设备
和工件，或者危及人员健康和生命。
• 在强制变量值前评估可能的风险并采取适当的安全预防措施。
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通过此命令，TwinCAT 将控制器上活动应用的一个或多个变量永久设置为定义值。此设置在每个处理循环的
开始和结束时执行。执行顺序：1. 读取输入、2. 强制值、3. 执行代码、4. 强制值、5. 写入输出。

您可以通过以下方式准备数值
• 点击声明部分中的 prepared value (准备值) 字段并输入新值。对于布尔变量，通过单击字段更改值。
• 点击 FBD/LD/IL 编辑器实现部分中的内联监控字段并输入新值。
• 点击监控窗口中的  prepared value (准备值) 字段并输入新值。

“强制”值以  标记。

TwinCAT 执行强制，直到用户通过
• 命令 Unforce values (取消强制值) 显式取消
• 通过 Prepare Value (准备值) 对话框取消强制
• 退出应用

默认情况下，菜单中不包括影响 TwinCAT 项目中所有 PLC 项目的命令 Force values for all
applications (强制所有应用的值)。

另请参见：
• 命令：取消强制值 [} 147]
• 对话框准备值 [} 146]
• PLC 文档：强制和写入变量值

5.8.14.1 对话框准备值

功能：此对话框用于为已强制变量准备值。TwinCAT 使用下一个强制值执行准备的操作。

调用：TwinCAT 在以下情况下打开对话框：
• 在声明部分中点击强制变量的 prepared value (准备值) 字段
• 在实现部分中点击强制变量的 inline monitoring (内联监控) 字段
• 在监控窗口中点击强制变量的 prepared value (准备值) 字段



参照用户界面

TE1000 147版本： 2.15.0

为下一次写入或强制操作准备新值 TwinCAT 在下一次强制操作期间写入变量的值
删除带值的准备工作 TwinCAT 删除准备值。
释放强制，而不修改值。 TwinCAT 保留强制值并终止强制。TwinCAT 以

<Unforce> 标记变量。
释放强制，并将变量恢复为强制之前的值。 TwinCAT 重置强制值并终止强制。变量以 <Unforce

and restore> 进行标记。

另请参见：
• 命令：强制值 [} 145]

5.8.15 命令：取消强制值

符号：

功能：此命令重置所有变量的强制。变量从控制器获取其当前值。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)

要求：PLC 项目处于在线模式。

 谨慎
受控系统异常行为导致的物料损坏和人身伤害
更改控制器上运行的 PLC 程序中的变量值可能会导致受控系统的异常行为。根据受控系统，可能会损坏设备
和工件，或者危及人员健康和生命。
• 在重置强制变量值前评估可能的风险并采取适当的安全预防措施。

默认情况下，菜单中不包括影响 TwinCAT 项目中所有 PLC 项目的命令 Unforce values for all
applications (取消强制所有应用的值)。

另请参见：
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• 命令：强制值 [} 145]
• PLC 文档：强制和写入变量值

5.8.16 命令：写入值

符号：

功能：此命令将控制器上的变量值设置为一次预定义值。

Call (调用)：菜单 PLC, TwinCAT PLC Toolbar Options (PLC，TwinCAT PLC 工具栏选项)

要求：PLC 项目处于在线模式。

 谨慎
受控系统异常行为导致的物料损坏和人身伤害
更改控制器上运行的 PLC 程序中的变量值可能会导致受控系统的异常行为。根据受控系统，可能会损坏设备
和工件，或者危及人员健康和生命。
• 在写入变量值前评估可能的风险并采取适当的安全预防措施。

通过此命令，可将控制器上活动 PLC 项目的一个或多个变量设置为一次定义值。在下一个循环开始时进行一
次写入。

您可以通过以下方式准备数值
• 点击声明部分中的 prepared value (准备值) 字段并输入新值。对于布尔变量，通过单击字段更改值。
• 点击 FBD/LD/IL 编辑器实现部分中的内联监控字段并输入新值。
• 点击监控窗口中的  prepared value (准备值) 字段并输入新值。

默认情况下，菜单中不包括影响 TwinCAT 项目中所有 PLC 项目的命令 Write values for all
applications (写入所有应用的值)。

另请参见：
• 命令：强制值 [} 145]
• PLC 文档：强制和写入变量值

5.8.17 命令：显示模式 - 二进制、十进制、十六进制
功能：Display（显示）子菜单的命令可用于在在线模式下进行监控时设置值的显示格式。

调用：PLC 菜单、上下文菜单

要求：PLC 项目处于离线或在线模式。

显示格式“二进制”和“十六进制”无符号，“十进制”有符号。

另请参见：
• PLC 文档：监控值
• PLC 文档：声明编辑器
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5.8.18 命令继承的显示 - 简单、结构化

TwinCAT 3.1 Build 4026 及以上版本可用

功能：子菜单 Presentation of inheritance（继承的显示）的命令可用于在在线模式下进行监控时设置功能
块和结构的继承层次结构的显示格式。

调用：PLC 菜单、上下文菜单

要求：PLC 项目处于离线或在线模式。

结构化 功能块和结构的继承层次结构以树状结构显示。变量作为声明它们的功能块或结构的子节
点显示。

简单 以平面列表的形式显示。

另请参见：
• PLC 文档：监控值
• PLC 文档：声明编辑器

5.8.19 命令：创建本地化模板
功能：此命令将打开 Create Localization Template (创建本地化模板) 对话框。可在此处定义将项目中的哪
些文本信息导出到文件格式 pot 的翻译模板。

调用：菜单 PLC > Project Localization (项目本地化)

要求：打开一个项目。

创建本地化模板对话框

此对话框用于选择要包含在本地化模板中的文本信息。

包括以下信息

名称 PLC 项目树中的对话框标题、对象名称等文本
标识符 变量标识符，例如：“nCounter”
字符串 例如，以下声明中的“计数”：sVar : STRING := 'count'
注释 编程块中的注释文本
位置信息 选择以上所选项目中文本类别的哪些位置应包含在翻译文件中。位置信息始终位于

翻译部分的第一行。
示例：
#: D:\Proj1.project\Project_Settings:1
msgid „Projekteinstellungen“
msgstr „„

• “All (全部)”：列出所有找到的文本位置。
• “First occurrence (首次出现)”：翻译文件包括项目中第一次出现待翻译文本

的位置。
• “None (无)”

创建 该按钮可打开用于保存文件的对话框。翻译模板在 POT 翻译模板 (*.pot) 类型的文
本文件中创建。每次进一步的创建过程会生成完整的新模板文件。
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5.8.20 命令：管理本地化
功能：此命令打开 Manage Localization (管理本地化) 对话框。在对话框中，选择所需的本地化语言或项目
原始版本。另外，还可以将本地化文件 *.<Language>.po 添加至项目或从项目中删除。

调用：菜单 PLC > Project Localization (项目本地化)

要求：打开一个项目。

管理本地化对话框

可用本地化 项目中存在的本地化文件列表。
示例：
proj1-de.po
proj1-en.po
<Originalversion>

原始版本始终可用。项目仅可在原始版本中进行编辑。
添加 此按钮可打开用于从文件系统中选择其他 po 文件的文件框。
删除 此按钮可从项目中删除在左侧选择的 po 文件。
标准本地化

 当前选择的本地化成为标准本地化。条目以粗体显示。
更改本地化 使用按钮切换至当前所选的本地化。
确认 项目以文件中选定文件所提供的国家语言显示。如果选择 <Original version>，项

目将以可编辑的非本地化版本显示。

5.8.21 命令：切换本地化

符号：

功能：此命令在当前设置的项目本地化和 <Original version> 之间切换。

调用：
• 菜单 Project (项目) > Localization (本地化)
• Manage Localizations (管理本地化) 对话框中的按钮
• 工具栏中的按钮

要求：打开一个项目。在 Manage Localizations (管理本地化) 对话框中定义了项目的标准本地化。

另请参见：
• 命令：管理本地化 [} 150]

5.8.22 命令：激活 PLC 项目
功能：用于选择活动的 PLC 项目的下拉列表。当前聚焦的项目会自动被设置为活动的 PLC 项目。

调用：TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

要求：TwinCAT 项目包含多个 PLC 项目。

另请参见：
• 命令：激活 PLC 实例 [} 151]
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• 命令登录 [} 142]

5.8.23 命令：激活 PLC 实例
功能：用于选择相应 PLC 项目的活动 PLC 实例的下拉列表。

调用：TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）

另请参见：
• 命令：激活 PLC 项目 [} 150]
• 命令登录 [} 142]

5.9 工具

5.9.1 命令：选项
功能：此命令打开用于配置 TwinCAT 选项的 Options (选项) 对话框。这些选项定义了 TwinCAT 用户界面的
行为和外观。TwinCAT 将本地系统上的当前设置保存为默认设置。

调用：菜单 Tools (工具)

5.9.1.1 对话框选项 - CFC 编辑器

功能：此对话框用于配置 CFC 编辑器中的编辑和打印设置。

调用：TwinCAT > PLC Environment (PLC 环境) > CFC editor (CFC 编辑器)
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常规选项卡

启用 AutoConnect
：将 CFC 元素拖动并粘贴到编辑器的工作区时，TwinCAT 会自动连接相互

“接触”的未链接引脚。移动元素时，确保不要创建任何不需要的连接！
准备实现部分中的值

：在在线模式下，还可以在 CFC 功能块的实现部分中准备为写入和强制准备变
量值。此外，TwinCAT 在尖括号中显示变量内联监控框中准备的值。

视图选项卡
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显示网格点
：在编辑器中，网格点是可以定位元素的有效区域。

显示框图标
：TwinCAT 显示以符号链接至位图的 CFC 编辑器中的功能块。

要求：已经为对象属性中的功能块或功能创建链接，或者使用库进行加载。
编辑行颜色 打开 Edit Line Colors (编辑行颜色) 对话框，以根据当前数据类型定义连接行的颜

色。在脱机和在线模式下，行以这些颜色显示，但 TwinCAT 用粗体黑色和蓝色行
覆盖这些颜色以指示布尔数据流。
• 添加类型：将数据类型添加到列表中。
• 删除类型

字体 显示用于更改字体的字体和按钮。

打印选项卡

布局选项

拟合方式 页面或海报
Scale (标度) 可能值：20% - 200%

另请参见：
• PLC 文档：CFC 语言编程
• PLC 文档：编程语言及其编辑器

5.9.1.2 对话框选项 - 声明编辑器

功能：此对话框用于配置声明编辑器的显示设置。

调用：TwinCAT > PLC Environment (PLC 环境) > Declaration editor (声明编辑器)
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仅文本 声明编辑器的文本视图
仅表格 声明编辑器的表格视图
可在文本与表格之间切换 声明编辑器提供两个按钮，用于在文本视图与表格视图之间切换：

：文本视图

：表格视图
以下选项定义了打开编程对象时默认显示的视图：
• 始终文本
• 始终表格
• 记住最近的设置 (每个对象)
• 记住最近的设置 (全局)

另请参见：
• PLC 文档：使用声明编辑器

5.9.1.3 对话框选项 - FBD、LD 和 IL

功能：此对话框用于配置 FBD/LD/IL 编辑器的演示选项。

调用：TwinCAT > PLC Environment (PLC 环境) > FBD, LD and IL (FBD、LD 和 IL )
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常规选项卡

视图

显示网络标题 网络标题显示在网络左上角。
显示网络注释 网络注释显示在网络左上角。如果 TwinCAT 也显示网络标题，则注释将显

示在下方的行中。
显示框图标 功能块符号显示在 FBD 和 LD 编辑器的块元素中。标准运算符也带有符号。
显示操作数注释 TwinCAT 显示已分配给实现部分中的变量的注释。相比“符号注释”，操作

数注释仅表示变量的本地使用点。
显示符号注释 TwinCAT 显示在变量名上方声明中分配给变量或符号的注释。除符号注释之

外或代替符号注释，还可以分配本地“操作数注释”。
显示符号地址 如果将地址分配给符号 (变量)，则该地址显示在变量名上方。
显示网络分隔符 在各个网络之间显示分界线。

Behavior (行为)

新操作数占位符 新功能块引脚的操作数字段留空 (而不是“???”)。
清空功能块引脚的操作数 插入空操作数，而不是 ???。

字体

点击输入字段，打开 Font (字体) 对话框。

操作数字段的固定大小
：可以启用编辑操作数大小。

编辑操作数大小 显示 Operand Size (操作数大小) 对话框，以设置字符数和行数。
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FBD 选项卡

视图

带换行符的网络
：使用换行符表示网络，以便 TwinCAT 可以在当前窗口宽度内显示尽可

能多的功能块。
使用直线连接框

：元素之间的行有固定的短长度。

Behavior (行为)

默认网络内容 选择列表：新网络的内容。
插入后选择 选择列表：插入新网络后 TwinCAT 选择的元素。
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LD 选项卡

视图

带换行符的网络
：使用换行符表示网络，以便 TwinCAT 可以在当前窗口宽度内显示尽可

能多的功能块。

Behavior (行为)

默认网络内容 选择列表：新网络的内容。
插入后选择 选择列表：插入新网络后 TwinCAT 选择的元素。
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IL 选项卡

视图

启用 IL 实现语言 IL 在开发系统中可用。

Behavior (行为)

默认网络内容 选择列表：新网络的内容。
插入后选择 选择列表：插入新网络后 TwinCAT 选择的元素。

打印选项卡
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布局选项

拟合方式 尺寸调整的选择列表。
避免切割元素 不适合该页面的项目将打印在下一页上。
标记相邻页面上的连接 如果启用了 Avoid cutting of elements (避免切割元素)，则可以启用。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：编程语言及其编辑器

5.9.1.4 对话框选项 - 库

功能：该对话框包含库的设置。

调用：TwinCAT > PLC programming environment > Libraries（TwinCAT > PLC 编程环境 > 库）

转换选项卡

此选项卡用于管理 TwinCAT 在转换旧项目时所用库引用的映射。如果您尚未保存特定库的映射，则您在每次
打开包含此库的旧项目时都必须重新定义映射。

映射定义了在将项目转换为当前格式后库引用的外观。提供 3 个选项：
• 您保留引用。这意味着，TwinCAT 还会将库转换为当前格式（*.library）并将其安装在本地库存储库

中。
• 您将引用替换为另一个引用。这意味着其中 1 个已安装的库将替换之前引用的库。
• 您删除引用。这意味着转换后的项目不再集成库。
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在下一次旧项目转换期间，TwinCAT 将所有列出的映射应用于其库引用。这意味着如果待转换项目中再次包
含相同的库，则您必须重复映射定义。您可以在最后一行输入新映射。
源库 转换前项目中所包含库的路径。

双击条目，使字段可编辑，并显示 Input Assistant（输入助手）按钮。
目标库 转换后项目中待包含库的名称和位置。

双击条目将打开“Set target system library”（设置目标系统库）对话框。

另请参见：
• PLC 文档：使用库

5.9.1.5 对话框选项 - 在线视图

在线视图

打开上一次在线视图 • TRUE (真) (默认设置)：登录时，上一条在线会话的
编辑器窗口打开。当前脱机视图保持打开状态。

• FALSE (假)：登录时，脱机视图保持打开状态。上
一条在线会话的编辑器窗口将被丢弃，并且不会重
新打开。

5.9.1.6 对话框选项 - PLCopenXML

功能：此对话框包含在 PLCopenXML 导出或导入时的 TwinCAT 行为设置。

调用：TwinCAT > PLC Environment (PLC 环境) > PLCopenXML
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PLCopenXML 导出设置

另外，以纯文本形式导出声明 默认情况下，TwinCAT 会根据 PLCopenXML 模式将声明部分分割为单个变
量，从而导致格式和一些注释信息丢失。

：保留格式和注释。另外，TwinCAT 还将已导出声明部分的纯文本写入
PLCopenXML 文件，从而扩展 PLCopenXML 模式。

导出文件夹结构
：如果包含所选对象之一，TwinCAT 还会导出文件夹。这是

PLCopenXML 模式的 TwinCAT 特定扩展。

PLCopenXML 导入设置

导入文件夹结构
：如果导入文件包含关于对象文件夹结构的信息，TwinCAT 将导入此结

构。

：TwinCAT 导入不带结构的对象。

另请参见：
• 命令：导出 PLCopenXML [} 258]
• 命令：导入 PLCopenXML [} 258]
• PLC 文档：导出和导入 PLC 项目

5.9.1.7 对话框选项 - SFC 编辑器

功能：此对话框用于配置 SFC 编辑器的设置。

调用：TwinCAT > PLC Environment (PLC 环境) > SFC editor (SFC 编辑器)
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布局选项卡

元素

定义 SFC 元素步骤、操作、限定符和属性的规格。以网格单位指定值。1 网格单位 = 当前在文本编辑器选项
(文本区域/字体) 中设置的字体大小。设置始终在所有当前打开的 SFC 编辑器窗口中立即生效。
步高 可能值：1-100
步宽 可能值：2-100
操作宽度 可能值：2-100
限定符宽度 可能值：2-100
属性宽度 可能值：2-100

字体

示例文本显示当前设置的字体。点击可更改字体。

步骤动作

默认插入方法 • 始终询问
• 重复实现
• 复制引用
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视图选项卡

属性可见性

列出普通和特殊类别的项目属性并定义显示选项。
属性 定义 SFC 图表中项目旁边显示的项目属性。
Value

：显示属性值。
带名称

：显示带名称的属性值。

在线

显示步骤时间
：TwinCAT 在步骤右侧显示在线模式下的步骤时间。

另请参见：
• PLC 文档：顺序功能图（SFC）
• PLC 文档：编程语言及其编辑器

5.9.1.8 对话框选项 - 重构

功能：此对话框用于定义自动提出重构的项目中的操作。重构功能支持您的增强工作。

调用：TwinCAT > PLC programming environment > Refactoring（TwinCAT > PLC 编程环境 > 重构）
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自动声明 如果您通过调用自动声明（Auto Declare（自动声明）对话框）更改变量
名或者添加输入或输出变量，则会自动启用选项 Apply changes using
refactoring（通过重构应用更改）。在确认对话框之后，Refactoring
（重构）对话框将打开，并且您可以在项目范围内更改变量。
在添加或删除变量时，或者用于更改范围

：通过自动声明（Auto Declare（自动声明）对话框）添加新的输入或
输出变量，或在自动声明中删除变量名，然后通过 OK（确定）关闭对话
框。这将打开 Refactoring（重构）对话框，以在项目范围内添加或删除变
量
在重命名变量时

：在自动声明（Auto Declare（自动声明）对话框）中重命名该名称，
然后通过 OK（确定）关闭对话框。这将打开 Refactoring（重构）对话
框，以在项目范围内重命名变量。

导航器 在重命名对象时

：如果您更改 PLC 项目树中对象的名称，则会出现提示，询问 TwinCAT
是否应该执行“Automatic refactoring”（自动重构）。

表格声明编辑器 在重命名变量时

：如果您在表格声明编辑器中更改变量名，则会出现提示，询问
TwinCAT 是否应该执行“Automatic refactoring”（自动重构），以进行
重命名。
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UML 类图 为类图编辑器中的更改提供重构支持的选项。
在添加或删除变量时

：当您在类图中的 VAR_INPUT、VAR_OUTPUT 和 VAR_IN_OUT 部分添
加或删除变量时，支持重构。
在重命名功能块时

：如果您更改类图中的功能块名称，则支持重构。
在重命名变量或属性时

：如果您重命名类图中的变量或属性，则支持重构。

如果在 UML 选项中启用 Skip Refactoring Preview（跳过重构预览）选
项，则可能会在项目中所有受影响的位置上执行重构，而不会首先显示在
Refactoring（重构）对话框中，具体视情况而定。（请参见 对话框选项 -
UML [} 172]）

另请参见：
• 命令：自动声明 [} 62]
• 命令：重命名 '<variable>' [} 73]
• 命令：添加 '<variable>' [} 74]
• 命令：删除 '<variable>' [} 76]
• PLC 文档：重构

5.9.1.9 对话框选项 - 智能编码

功能：此对话框用于配置更易于输入代码的设置。

调用：TwinCAT > PLC programming environment > Smart Coding（TwinCAT > PLC 编程环境 > 智能编
码）
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自动声明未知变量
（AutoDeclare） ：当您在编程语言编辑器中输入未声明的标识符并退出输入行后，Auto

Declare（自动声明）对话框将打开。
对于 Build 4026 及以上版本，为了使 AutoDeclare 功能在 ST 编辑器中也可
用，还必须启用选项 Enable for the ST editor（为 ST 编辑器启用）。

为 ST 编辑器启用 前提条件：选项 Declare unknown variables automatically
(AutoDeclare)（自动声明未知变量（AutoDeclare））已启用。

：AutoDeclare 功能在 ST 编辑器中也可用。

：AutoDeclare 功能在 ST 编辑器中不可用。
（Build 4026 及以上可用）

在输入助手中显示所有实例变量 ：List components（列出组件）功能还提供功能块实例的局部变量以
供选择。

：List components（列出组件）功能仅提供 FB 实例的输入和输出变量
以供选择。

键入点（.）后列出组件 ：启用 List components（列出组件）功能。
这意味着：如果您在 TwinCAT 需要标识符的位置输入 1 个点，则会出现 1
个带输入选项的选择列表。

键入时立即列出组件 要求：选项 List components after typing a dot (.)（键入点（.）后列出
组件）已启用。

：在输入任何字符串后，将显示可用标识符和运算符的选择列表
插入命名空间 ：TwinCAT 自动在标识符前插入命名空间。
自动将关键字转换为大写
（AutoFormat） ：TwinCAT 自动以大写字母写入所有关键字。

在交叉引用视图中自动列出选择 ：交叉引用列表自动显示当前选定或光标所在位置的变量/POU/DUT 的
引用。

编辑器中的下划线错误 ：错误或未知的程序代码加下划线。
（Build 4026 及以上可用）

突出显示符号 ：在编辑器中，光标所在的符号的所有使用位置都会以彩色突出显示。
这样，您可以在编辑器中快速识别交叉引用。
（Build 4026 及以上可用）

另请参见：
• PLC 文档：编程语言及其编辑器
• PLC 文档：使用输入助手
• PLC 文档：查找使用交叉引用列表的位置

5.9.1.10 对话框：选项 – 梯形图编辑器

符号：

功能：此对话框用于配置梯形图编辑器的显示选项。

调用：TwinCAT > PLC Environment > Ladder editor（TwinCAT > PLC 环境 > 梯形图编辑器）

常规选项卡

视图
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显示网络标题 网络标题显示在网络的左上角。
显示网络注释 网络注释显示在网络的左上角。如果 TwinCAT 也显示网络标题，则注释将

显示在下方的行中。
显示方框图标 方框图标显示在梯形图编辑器的方框元素中。标准运算符也带有符号。
显示操作数注释 TwinCAT 显示已分配给实现部分中的变量的注释。与“symbol

comment”（符号注释）相比，操作数注释仅表示变量的本地使用点。
注释会根据可用空间自动截断。

显示符号注释 TwinCAT 显示在变量名上方声明中分配给变量或符号的注释。除符号注释
之外或代替符号注释，您还可以分配本地“操作数注释”。

显示符号地址 如果将地址分配给符号（变量），则该地址显示在变量名上方。

操作数大小

最大显示行数 显示操作数名称的最大行数。
每行最大平均字符数 每行显示操作数名称的最大字符数

监控选项卡

浮点数的显示位数 位数的选择列表
示例：设置的 5 位数的值 750.15 会变为设置的 2 位数的值 7.5e+02。

显示字符串长度 字符数的选择列表

5.9.1.11 对话框选项 - 语法突出显示

功能：此对话框用于配置编辑器文本元素的颜色和字体设置 (例如操作数、编译指示)。

调用：TwinCAT > PLC Environment (PLC 环境) > Syntax highlighting (语法突出显示)
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显示项 文本项的选择列表
项目前景 文本项的前景颜色
项目背景 文本项的背景颜色
项字体样式 文本项字体样式 (粗体、斜体、下划线、删除线)
示例 示例文本在预览中显示当前设置

5.9.1.12 对话框选项 - 文本编辑器

功能：此对话框包含文本编辑器中的显示和工作设置。

调用：TwinCAT > PLC programming environment > Text editor（TwinCAT > PLC 编程环境 > 文本编辑
器）

主题选项卡

在此选项卡中，您可以针对 ST 编辑器界面设计设置所需的主题。（Build 4026 及以上可用）

主题 文本编辑器的配色方案。所选主题将显示在预览窗口中。

编辑选项卡
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撤消数 命令 Edit > Undo（编辑 > 撤销）可用的最大步骤数。
折叠 通过缩进定义代码结构。

在选择缩进时，您可以使用各部分第 1 行左侧的加号或减号展开或折叠缩进
部分。
• 缩进：TwinCAT 将所有相对于前一行缩进的行组合在 1 个缩进单元中。
• 显式：您显式使用注释来标识要在缩进单元中分组的代码部分：该部分必

须以包含 3 个前花括号“{{{”的注释开头，并且以包含 3 个后花括号
“}}}”的注释结束。注释可以包含附加文本。示例：

自动换行 • 软：如果为换行边距输入 0，则换行发生在编辑器窗口边缘。
• 硬：换行发生在换行边距指定的字符数之后。

制表符宽度 字符数
保留制表符 ：您使用 [ Tab ] 键插入的空格之后不会被 TwinCAT 转换为单独的空

格。
缩进宽度 如果您已为 Auto Indent（自动缩进）选项激活智能或智能代码补全，则

TwinCAT 将在行起始处插入一定数量的空格。
自动缩进 • 不要自动缩进

• 块：新行自动采用前一行的缩进。
• 智能：包含关键字（例如，VAR）的行后面的行会自动缩进指定的缩进宽

度。
• 智能代码补全：缩进与 Smart（智能）选项相同，此外 TwinCAT 插入最

终关键字（例如，END_VAR）。
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文本区域选项卡

突出显示当前行 ：突出显示光标所在的行。
匹配括号 ：如果光标位于代码行中括号之前或之后，则 TwinCAT 会使用边框标记

相应的右括号或左括号。
行标记 ：在行最后一个字符（包括空格）之后，TwinCAT 使用小水平线标记各

编辑器行的末端。
换行指南： ：如果启用软换行符或硬换行符，则定义的换行指南将通过垂直线显

示。
插入符颜色 光标字符的颜色
选择颜色 所选文本区域的颜色
未激活 在相应窗口未激活情况下的选择颜色（焦点在另一窗口上）。
折叠行前景 代码中闭合缩进部分的标题行颜色
折叠行背景 代码中闭合缩进部分的标题行以彩色突出显示。
字体 点击字段将打开用于配置字体的标准对话框。
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页边选项卡

文本编辑器窗口左侧页边的设置（由输入区域的垂直线分隔）：
行号 ：在声明和实现部分中显示行号，每个行号以 1 开头
前景颜色 行号颜色
背景颜色 页边颜色
突出显示当前行 ：突出显示光标所在行的行号。
显示括号范围 ：括号包括打开和关闭结构的关键字之间的行，例如 IF 和 END_IF。

如果该选项已启用并且光标位于结构的某个关键字之前、之后或之中，则括
号区域通过页边处的方括号指示。

聚焦的边框颜色 页边和输入区域之间分界线的颜色
未聚焦的边框颜色 窗口当前未激活部分的页边和输入区域之间分界线的颜色
鼠标操作 可以为每个规定的鼠标动作或鼠标按钮快捷方式分配以下操作之一。在括号

区域标题行前面的加号或减号处执行鼠标动作时，TwinCAT 执行以下动作：
• 无：鼠标动作不会触发任何动作。
• 选择折叠：TwinCAT 选择括号区域的所有行。
• 切换折叠：TwinCAT 打开或关闭括号区域，或者在嵌套括号的情况下打

开或关闭括号区域的第 1 级。
• 完全切换折叠：TwinCAT 打开或关闭嵌套括号区域的所有级。
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监控选项卡

用于显示监控字段的设置
启用内联监控 ：在在线模式下，监控字段在变量后显示
监控前景颜色 展示监控字段中的值
监控背景颜色 展示监控字段中的背景
流程控制前景颜色 展示流程控制项处监控字段中的值
流程控制背景颜色 展示流程控制位置处监控字段的背景
显示位数 监控字段中的小数位数
字符串长度 监控字段中字符串变量值的最大长度

另请参见：
• PLC 文档：编程语言及其编辑器

5.9.1.13 对话框选项 - UML

功能：此对话框用于配置 UML 编辑器。

调用：TwinCAT > PLC programming environment > UML（TwinCAT > PLC 编程环境 > UML）
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常规选项卡

触点间距 网格线间距（单位：像素）。
默认值：10

连接网格 ：UML 编辑器中的所有元素均与网格对齐。
显示网格点 ：网格点在 UML 编辑器中显示。

状态图选项卡
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关系的位置条件和动作 ：在状态图中，同步移动属于同一转换的保护条件和动作。

类图选项卡

从图中删除对象时显示提示 对象仅可从图表或图表和项目中删除。

：默认情况下，仅从图中删除对象。

：删除对象时，将出现选择窗口，以配置仅从图中还是从项目中删除
对象。

跳过重构预览 ：如果在图中启动重构，则会执行项目范围内的更改，而无需首先打
开带有所有更改点的预览的 Refactoring（重构）对话框。
另请参见：
• PLC 文档：重构

另请参见：
• UML 文档：

5.9.1.14 对话框选项 - 可视化

功能：此对话框用于配置可视化编辑器。

调用：TwinCAT > PLC Environment (PLC 环境) > Visualization (可视化)

常规选项卡

这些设置仅用于集成可视化，即不用于 TwinCAT PLC HMI (TargetVisu) 和 TwinCAT PLC HMI Web
显示变体。

显示选项
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固定
 可视化保持其原始大小。

各向同性
 可视化保持其比例。

各向异性
 可视化根据开发系统中的窗口大小进行调整

抗锯齿图
 可视化的特点是抗锯齿方法，在编辑时以及在运行时集成可视化时均不例

外。
提示：如果在特定的可视化平台上画了一条焦点不准的水平线或垂直线，则可以
通过在线厚度方向上偏移 0.5 px 进行校正；参见项属性 Absolute motion (绝对
运动)，选项 Use REAL values (使用 REAL 值)。要求：平台支持使用 REAL 坐标

编辑选项

链接到移位/关键变量
可视化元素属性中的 < 占位符 <Shift/Key
variable> 启用。
如果将属性颜色变量、颜色更改的项目拖动至可视化
编辑器，则将通过占位符 <Shift/Key variable> 配置
此属性。
以下项将受到影响：按钮、框架、图像、线条、扇
形、多边形、矩形、文本字段、滚动条

网格选项卡

Grid (网格)

可见
 网格线在可视化编辑器中按距离大小可见

启用
 网格线在可视化编辑器中按距离大小启用。项与

网格对齐，所有位置值都在一条网格线上。启用网格
时已在可视化中的项目不会自动对齐。为此，必须先
将其拖动到其他位置。
网格线可能启用且不可见

大小 网格线距离以像素为单位

文件选项选项卡

文本“列出组件”的文本文件。 .csv 类型文件的文件名和位置。其包含一个表格，而
表格包含文本列表格式的文本。
如果 List components (列出组件) 功能用作输入助
手，则提供文件中的条目。
通过“命令：导入/导出文本列表”将此文件创建为全
局文本列表的导出文件。

可视化目录
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文本列表文件 文本列表的存储位置。
只要在项目设置、类别可视化、文本列表文件中未配
置其他位置，此设置即可适用于项目。

图像文件 图像文件的存储位置。用分号分隔多个存储位置。
例如，TwinCAT 在导出或导入图像文件时使用此目
录。
只要在项目属性、类别可视化、图像文件中未配置其
他位置，此设置即在项目中有效。

另请参见：
• PLC 文档：创建可视化

5.9.1.15 对话框选项 - 可视化样式

功能：此对话框用于配置可视化样式。

调用：TwinCAT > PLC Environment > visualization styles（TwinCAT > PLC 环境 > 可视化样式）

样式选择

显示所有版本（仅限专家）
 除了当前所选样式之外，存储库的所有其他样式

均可供选择，但仅在最新版本中可用。如果为所选样
式安装了较新版本，则也会列出这些新版本。

 所有已安装版本中的所有已安装样式均可供选
择。

新可视化管理器的样式

最近使用：<style, version, manufacturer> 在您添加新的可视化应用时自动设置为已选择的样
式。
尽管已进行此设置，根据设备的不同，显示变体会以
不同方式显示。

默认：<style, version, manufacturer> 设置制造商的默认样式。
<Style, Version, Manufacturer> 为样式、版本和制造商设置显示变体。

5.9.1.16 对话框选项 - 写入选项

写入选项
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单独的行 ID • TRUE（标准设置）：POU 的行 ID 存储在 1 个单独的文件（LineIDs.dbg）中，
因此行 ID 的更改不会导致 POU 的更改，而 POU 的更改可能会在源码控制系统中
被误判为内容更改。对于 TC3.1 Build 4026 及以上版本，“Write Line IDs”（写
入行 ID）的值必须为 TRUE – 这是实现此功能的前提条件。
对于 TC3.1 Build 4024 及以下版本，行 ID 主要用于断点处理等场景，同时确保
可以将代码行能够与机器代码指令一一对应。

按名称排序 • TRUE（默认设置）：POU 的子元素（动作、方法、属性）按名称而非内部 ID 排
序（请参见示例 [} 177]）。

写入行 ID TC3.1 Build 4026 及以上版本可用
• TRUE：在新项目中为 POU 创建并存储行 ID。
• FALSE（默认设置）：在新项目中不会为 POU 生成行 ID。
此设置为写入行 ID 的全局默认设置。在创建新 PLC 项目时，这个设置的值会被一
次性同步到项目本地设置中。这可以在 PLC 项目属性（高级类别 [} 104]）中找到，
并可针对每个项目进行单独调整。

将 PLC 书签写入文件 TC3.1 Build 4026 及以上版本可用
• TRUE：在新项目中，书签存储在项目目录下的单独 .bookmarks 文件中。
• FALSE（默认设置）：在新项目中，书签不会存储在项目目录下的单

独 .bookmarks 文件中。
此设置为写入书签的全局默认设置。在创建新 PLC 项目时，这个设置的值会被一次
性同步到项目本地设置中。这可以在 PLC 项目属性（高级类别 [} 104]）中找到，并
可针对每个项目进行单独调整。

示例

示例说明了 METH_A、METH_B 和 METH_C 方法的不同存储顺序，具体取决于 Sort by name（按名称排序）
选项是启用还是禁用。如果禁用该选项（FALSE），则 METH_B 方法不会根据其名称排在第 2 位，而是根据其
内部 ID 排在第 1 位。

按名称排序 = TRUE 按名称排序 = FALSE

5.9.1.17 对话框选项 - ZIP 导出/导入

功能：此对话框用于配置 ZIP 导出和导入设置。

调用：TwinCAT > PLC Environment > ZIP export/import (TwinCAT > PLC 环境 > ZIP 导出/导入)

另请参见：
• PLC 文档：导出和导入 PLC 项目

5.9.2 命令：自定义
功能：此命令打开 Customize (自定义) 对话框。对话框包含用于配置用户界面的选项卡。您可在此自定义符
合您要求的菜单、工具栏和键盘映射。

调用：菜单 Tools (工具)

您可以随时通过 Reset (重置) 按钮恢复 TwinCAT 标准设置。

另请参见：
• TC3 用户界面文档 > 自定义菜单 [} 33]
• TC3 用户界面文档 > 自定义工具栏 [} 34]
• TC3 用户界面文档 > 自定义键盘快捷方式 [} 35]



参照用户界面

TE1000178 版本： 2.15.0

5.9.2.1 对话框自定义 - 工具栏选项卡

功能：您可使用此对话框创建新的工具栏或调整现有工具栏。

调用：菜单 Tools > Customize (工具 > 自定义)

使用 Close (关闭) 关闭对话框后，这些更改将在 TwinCAT 用户界面的菜单栏中显示。

新建...
(添加工具栏)

TwinCAT 在所选工具栏上添加一个工具栏。对话框打开，可在其中输入名
称。

Delete (删除)
(删除工具栏)

TwinCAT 删除所选工具栏。
您只能删除自己创建的工具栏。

修改选择
(位置工具栏)

TwinCAT 将所选工具栏置于主窗口的上、下、左或右框

键盘.... 打开 Options (选项) 对话框，您可以在其中定义键盘快捷方式。

工具栏
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显示当前定义的工具栏。

 (隐藏)
隐藏用户界面上所选的工具栏。

 (显示)
显示 TwinCAT 用户界面中所选的隐藏工具栏。

另请参见：
• TC3 用户界面文档 > 自定义工具栏 [} 34]

5.9.2.2 对话框自定义 - 命令选项卡

功能：您可通过此对话框定义命令、菜单的结构和内容以及用户界面的工具栏。

调用：菜单 Tools > Customize (工具 > 自定义)

使用 Close (关闭) 关闭对话框后，这些更改将在 TwinCAT 用户界面的菜单栏中显示。

菜单和工具栏
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显示当前定义的工具栏、菜单、子菜单以及其中所包含的命令。
菜单栏 菜单和子菜单列表
工具栏 工具栏列表
上下文菜单 上下文菜单列表

控制

控制 所选菜单或工具栏中包含的命令或子菜单列表。从上到下的排列对应于
之后在 TwinCAT 菜单或工具栏中显示的排列方式。

添加命令 打开 Add Command (添加命令) 对话框。Add Command (添加命令)
对话框用于选择一项或多项命令。左部：类别列表。右部：所选类别的
命令列表。
在所选命令上添加命令。

添加新菜单 在所选菜单上添加新菜单。

修改选择 打开可确定新添加菜单名称的菜单。
Delete (删除) 删除所选菜单或命令。
向上移动 按命令或菜单顺序向上移动所选命令或菜单。
向下移动 按命令或菜单顺序向下移动所选命令或菜单。
全部重置 将整个菜单重置为默认设置。

键盘 打开 Options (选项) 对话框，您可以在其中定义键盘快捷方式。

5.10 窗口

5.10.1 命令：浮动
功能：此命令将停靠 (固定) 至用户界面边框的视图或窗口从边框分离，并将其作为独立窗口置于屏幕上。

调用：Window (窗口) 菜单，视图标题或选项卡 (窗口) 中的上下文菜单或按钮

之后，可以将该视图放在用户界面之外。使用 Dock (程序坞) 命令将分离的视图重新附加到用户界面边框。

另请参见：
• 命令：程序坞 [} 180]
• TC3 用户界面文档：排列视图和窗口 [} 36]

5.10.2 命令：程序坞
功能：此命令将之前通过 Float (浮动) 命令分离并且目前作为单独视图位于屏幕上的视图与用户界面边框重新
“对接”。

调用：Window (窗口) 菜单，视图标题或选项卡 (窗口) 中的上下文菜单或按钮

另请参见：
• 命令：浮动 [} 180]
• TC3 用户界面文档：排列视图和窗口 [} 36]
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5.10.3 命令：隐藏

符号：

功能：此命令隐藏视图。

调用：Window (窗口) 菜单，视图标题中的上下文菜单或按钮

要求：视图已启用。

隐藏指视图被关闭。因此，该命令相当于通过视图标题栏中的  按钮关闭视图。在 View (视图) 菜单中使
用此命令可取消隐藏或打开隐藏的视图。

另请参见：
• 视图 [} 77]
• TC3 用户界面文档：显示/隐藏视图 [} 37]

5.10.4 命令：自动隐藏全部
功能：此命令隐藏所有视图。

调用：Window (窗口) 菜单，视图标题中的上下文菜单或按钮

隐藏指 TwinCAT 在用户界面内仅以选项卡形式显示所有视图，并且仅当您点击选项卡时才可见。如果您在之

后点击视图标题栏中的  按钮或选择 Dock (程序坞) 命令，则该视图将被重新固定在用户界面。

另请参见：
• 命令：程序坞 [} 180]
• 视图 [} 77]
• TC3 用户界面文档：显示/隐藏视图 [} 37]

5.10.5 命令：自动隐藏

符号：

功能：此命令将视图置于后台。

调用：Window (窗口) 菜单，视图标题中的上下文菜单或按钮

要求：视图已启用。

置于后台表示 TwinCAT 在用户界面内仅以选项卡形式显示视图，并且仅当您点击选项卡时才可见。如果您在

之后再次点击标题栏中的  按钮或选择 Dock (程序坞) 命令，则该视图将被重新固定在用户界面。

另请参见：
• 命令：程序坞 [} 180]
• TC3 用户界面文档：显示/隐藏视图 [} 37]

5.10.6 命令：固定选项卡

符号：

功能：此命令将当前活动的选项卡固定在主窗口左边缘。
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调用：Window (窗口) 菜单，选项卡 (窗口) 标题栏中的上下文菜单或按钮

要求：选项卡 (窗口) 已启用。

另请参见：
• TC3 用户界面文档：显示/隐藏视图 [} 37]

5.10.7 命令：新水平选项卡组

符号：

功能：此命令将活动窗口移动到现有选项卡下的一个单独的新选项卡组。

调用：Window (窗口) 菜单，选项卡 (窗口) 标题栏的上下文菜单

要求：若干编辑器窗口作为选项卡依次排列。

如果在编辑器中打开另一个对象，则会被自动放置在重点关注的选项卡组中。

另请参见：
• TC3 用户界面文档：排列视图和窗口 [} 36]
• 命令：新垂直选项卡组 [} 182]

5.10.8 命令：新垂直选项卡组

符号：

功能：此命令将活动窗口移动到现有选项卡右侧的一个单独的新选项卡组。

调用：Window (窗口) 菜单，选项卡 (窗口) 标题栏的上下文菜单

要求：若干编辑器窗口作为选项卡依次排列。

如果在编辑器中打开另一个对象，则会被自动放置在重点关注的选项卡组中。

另请参见：
• TC3 用户界面文档：排列视图和窗口 [} 36]
• 命令：新水平选项卡组 [} 182]

5.10.9 命令：重置窗口布局
功能：此命令将所有当前打开的窗口和视图重置到默认位置。您需要在执行前确认命令。

调用：Window (窗口) 菜单

5.10.10 命令：关闭所有文件

符号：

功能：此命令关闭所有当前打开的编辑器窗口。

调用：Window (窗口) 菜单

要求：至少打开一个编辑器窗口。
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另请参见：
• TC3 用户界面文档：显示/隐藏视图 [} 37]

5.10.11 命令：窗口
功能：此命令打开 Window (窗口) 对话框，其中显示所有打开的对象。您可以启动或关闭其中的窗口。

调用：Window (窗口) 菜单

5.10.12 窗口子菜单命令
功能：此命令启用所选窗口。

调用：Window (窗口) 菜单

在每个打开的编辑器窗口中，Window (窗口) 菜单包含 <n><Object name> 命令，您可通过此命令启用该窗
口，即重点关注该窗口。在脱机模式中，TwinCAT 在该命令后添加扩展名 (脱机)。为功能块添加扩展名
(impl) 或 <instance path> 以区分实现和实例。

另请参见：
• 命令：窗口 [} 183]

5.11 SFC

5.11.1 命令：初始化步骤

符号：

功能：此命令将当前所选步骤转换为初始化步骤。

调用：菜单 SFC，上下文菜单

执行该命令可以将步骤元素的边框更改为双行。该步骤 (之前是初始化步骤) 自动成为“普通”步骤并通过单边
框表示。

也可在步骤元素的 Properties (属性) 视图中启用或禁用属性 Init step (初始化步骤)，尽管在此情况下
TwinCAT 不会自动调整其他步骤的设置。

如果您要更改图表，则此命令十分有用。创建新的 SFC 对象时将自动包含一个初始化步骤，然后转换 (TRUE)
并跳转回初始化步骤。

注意：可以在在线模式下使用 SFC 标记 SFCInit 和 SFCReset 将图表重置为初始化步骤。

另请参见：
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 元素属性

5.11.2 命令：插入步骤转换

符号：
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功能：此命令在当前所选位置前添加一个步骤和转换。

调用：菜单 SFC，上下文菜单

如果您已选择一个步骤，TwinCAT 将插入新的步骤转换组合。如果您已选择一个转换，则新的转换步骤组合
已插入。

新步骤的默认名称为步骤 <n>。n 是一个序号，第一步从 0 开始，并且在初始化步骤之外添加。因此，新转换
的默认名称为 Trans<n>。您可以通过单击名称直接编辑默认名称。

另请参见：
• 命令：在...后插入步骤-转换 [} 184]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 元素步骤和转换

5.11.3 命令：在...后插入步骤-转换

符号：

功能：此命令在当前所选位置后添加一个步骤和转换。

调用：菜单 SFC，上下文菜单

如果您已选择一个步骤，TwinCAT 将插入新的转换步骤组合。如果您已选择一个转换，则新的步骤转换组合
已插入。

新步骤的默认名称为步骤 <n>。n 是一个序号，第一步从 0 开始，并且在初始化步骤之外添加。因此，新转换
的默认名称为 Trans<n>。您可以通过单击名称直接编辑默认名称。

另请参见：
• 命令：插入步骤转换 [} 183]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：

5.11.4 命令：平行

符号：

功能：此命令将所选替代分支转换为平行分支。

调用：菜单 SFC，上下文菜单

要求：选择分支的平行连接行。

注意：转换分支后，您必须检查并调整分支前后的步骤和转换顺序。

另请参见：
• 命令：替代 [} 185]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
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5.11.5 命令：替代

符号：

功能：此命令将所选平行分支转换为替代分支。

调用：菜单 SFC，上下文菜单

要求：选择分支的平行连接行。

注意：转换分支后，您必须检查并调整分支前后的步骤和转换顺序。

另请参见：
• 命令：平行 [} 184]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器

5.11.6 命令：插入分支

符号：

功能：此命令在当前所选位置左侧添加分支。

调用：菜单 SFC，上下文菜单

该命令的效果对应于命令 Insert branch right (在右侧插入分支)。

另请参见：
• 命令：在右侧插入分支 [} 185]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 元素分支

5.11.7 命令：在右侧插入分支

符号：

功能：此命令在当前所选位置右侧添加分支。

调用：菜单 SFC，上下文菜单

所插入的分支类型取决于所选元素：
• 如果当前所选元素最上方的元素是一个转换或一个替代分支，TwinCAT 将插入一个替代分支。
• 如果当前所选元素最上放的元素是一个步骤、一个宏、一个跳转或一个平行分支，TwinCAT 将添加一个

带标签的平行分支：分支 <x>，其中 x 是一个序号。您可以编辑此默认标签名称。您可以将标签指定为
跳转目标。

• 如果当前选择了现有分支的公共元素 (水平线)，TwinCAT 将最右边的新分支添加为附加分支。如果当前
选择了现有分支的整个分支，TwinCAT 将新分支作为新分支直接添加到其右侧。

注意：您可以使用命令 Alternative (替代) 或 Parallel (平行) 以将分支转换为相应的其他类型。

示例：平行分支
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下图显示了一个新插入的平行分支，通过“命令：在右侧插入分支”生成，同时已选步骤 11。TwinCAT 自动
插入步骤 (示例中的步骤 2)。

在在线模式下处理：如果 t2 返回 TRUE，TwinCAT 将在步骤 11 之后立即执行步骤 2，然后再评估 t3。

与替代分支相反，TwinCAT 执行两个分支。

示例：替代分支

下图显示了一个新插入的替代分支，通过“命令：在右侧插入分支”生成，同时已选转换 t4。TwinCAT 自动
插入一个步骤 (示例中的步骤 32)、一个之前的转换和一个之后的转换 (t41、t42)。

在在线模式下处理：如果步骤 3 处于活动状态，TwinCAT 将从左到右评估以下转换 (t4、t41)。执行第一次转
换返回 TRUE 的分支的第一个连接点。与平行分支相反，仅执行一个连接点。

另请参见：
• 命令：替代 [} 185]
• 命令：平行 [} 184]
• 命令：插入分支 [} 185]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 元素分支

5.11.8 命令：插入动作关联

符号：

功能：此命令将 IEC 动作分配到一个步骤。

调用：菜单 SFC，上下文菜单

要求：选择一个步骤。
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TwinCAT 在当前所选步骤元素右侧添加动作元素。

如果您已将一个或多个动作分配至该步骤，它们将从上至下依次显示在“操作列表”中。之后，新动作排列如
下：

• 如果您选择了步骤元素，则作为该步骤的第一个操作，即位于操作列表顶部。
• 如果您选择了步骤操作列表中的一个当前操作，则位于该操作之前，即在该操作上方。

操作元素左部包含限定符，默认为 N，您可在右部输入操作名称。为此，点击方框以编辑边框。您必须创建此
操作作为项目中的 POU。

您还可以编辑限定符。关于有效限定符列表的描述，请参见“SFC 中的操作限定符”一节。

另请参见：
• 命令：在...后插入动作关联 [} 187]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 中的操作限定符

5.11.9 命令：在...后插入动作关联

符号：

功能：此命令将 IEC 动作分配到一个步骤。

调用：菜单 SFC，上下文菜单

要求：选择一个步骤。

该命令对应于插入操作关联的描述。不同之处在于，TwinCAT 未将新操作放在操作列表的第一个位置，而是
放在操作列表的最后一个位置。如果您在操作列表中选择了一个操作，TwinCAT 不会将新操作放在其上方，
而是放在下方。

另请参见：
• 命令：插入动作关联 [} 186]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 中的操作限定符

5.11.10 命令：插入跳转

符号：

功能：此命令在当前所选元素前插入一个跳转元素。

调用：菜单 SFC，上下文菜单

要求：选择一个步骤。

TwinCAT 通过跳转目标步骤自动插入跳转。然后必须用实际跳转目标替换此跳转目标。您可以选择带输入助
手的目标。

另请参见：
• 命令：在...后插入跳转 [} 188]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
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• PLC 文档：SFC 元素跳转

5.11.11 命令：在...后插入跳转

符号：

功能：此命令在当前所选元素后插入一个跳转元素。

调用：SFC 菜单

TwinCAT 通过跳转目标步骤自动插入跳转。然后必须用实际跳转目标替换此跳转目标。您可以选择带输入助
手的目标。

另请参见：
• 命令：插入跳转 [} 187]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 元素跳转

5.11.12 命令：插入宏

符号：

功能：此命令在当前所选元素前插入一个宏元素。

调用：菜单 SFC，上下文菜单

新宏的默认名称为宏 <x>。x 是一个序号，第一个宏从 0 开始。您可以通过单击名称直接编辑默认名称。

如要编辑宏，使用宏编辑器中的 Show macro (显示宏) 命令打开它。

另请参见：
• 命令：显示宏 [} 189]
• 命令：在...后插入宏 [} 188]
• PLC 文档：顺序功能图（SFC）
• SFC 编辑器

5.11.13 命令：在...后插入宏

符号：

功能：此命令在当前所选元素后插入一个宏元素。

调用：菜单 SFC，上下文菜单

该命令对应于命令 Insert macro (插入宏) 的描述。

另请参见：
• 命令：插入宏 [} 188]
• 命令：显示宏 [} 189]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
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5.11.14 命令：显示宏

符号：

功能：此命令在宏编辑器中打开一个宏以进行编辑。

调用：SFC 菜单

要求：已选择一个宏。

该命令使 TwinCAT 关闭 SFC 编辑器的主视图，转而打开宏编辑器。这也是一个 SFC 编辑器，您现在可在其中
编辑 SFC 示意图的一部分，该部分在主视图中显示为宏框。

使用命令 Exit macro (编辑宏) 返回至主视图。

另请参见：
• 命令：退出宏 [} 189]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器

5.11.15 命令：退出宏

符号：

功能：此命令关闭宏编辑器并且返回 SFC 编辑器的主视图。

调用：SFC 菜单

要求：在宏编辑器中打开一个宏。

另请参见：
• 命令：显示宏 [} 189]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器

5.11.16 命令：在...后插入

符号：

功能：此命令在当前所选位置后插入剪贴板中的元素。

调用：SFC 菜单

5.11.17 命令：添加输入操作

符号：

功能：此命令引导至 Add entry action (添加输入操作) 对话框，您可在其中定义类型为“输入操作”的新步
骤操作。根据 SFC 选项，可能会预先出现选择新步骤操作复制模式的提示。

调用：SFC 菜单，所选步骤元素的上下文菜单

要求：选择一个步骤元素。

在 ST 编辑器中自动打开输入操作。在左下角为该步骤元素分配一个“E”。
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用于选择复制模式的查询对话框

复制引用。新步骤将调用相同的操作 如在 SFC 内复制该步骤，则也会复制该步骤操作的链
接。因此，彼此复制的步骤将调用所有相同的操作。

复制实现。为新步骤创建新的操作对象 这意味着为复制的步骤“嵌入”步骤操作。默认设置
下，新创建的操作对象出现在解决方案资源管理器
PLC 项目树中的 SFC 功能块下方。最初，这些对象包
含各自操作的原始实现代码副本。

设置为默认。可在 SFC 编辑器选项中更改此设置。 对话框中的设置作为默认设置接受。您可以在类别
SFC editor (SFC 编辑器) 的 TwinCAT 选项中更改默
认设置。为此，在下拉列表 Standard insert
method (标准插入方法) 的组字段  Step actions (步
骤操作) 中，选择 Always ask (始终询问)、Copy
reference (复制引用) 或  Duplicate
implementation (复制实现) 条目。

另请参见：
• 命令：选项 > 对话框选项 - SFC 编辑器 [} 161]
• PLC 文档：命令：添加退出操作 [} 190]
• PLC 文档：顺序功能图（SFC）
• PLC 文档：SFC 编辑器
• PLC 文档：用顺序功能图（SFC）编程
• PLC 文档：SFC 元素动作

5.11.18 命令：添加退出操作

符号：

功能：此命令引导至 Add exit action (添加退出操作) 对话框，您可在其中定义类型为“输入操作”的新步骤
操作。根据 SFC 选项，可能会预先出现选择新步骤操作复制模式的提示。请参见命令 Add entry action (添
加输入操作) 的帮助页面。

调用：SFC 菜单，所选步骤元素的上下文菜单

要求：选择 SFC 中的步骤元素。

另请参见：
• 命令：添加输入操作 [} 189]
• 命令：选项 > 对话框选项 - SFC 编辑器 [} 161]
• PLC 文档：顺序功能图（SFC）
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• PLC 文档：用顺序功能图（SFC）编程
• PLC 文档：SFC 编辑器
• PLC 文档：SFC 元素动作

5.11.19 命令：更改复制 - 设置
功能：此命令将 SFC 功能块中的步骤或转换调用的各步骤操作或转换永久链接到调用端。操作或转换对象只
能由该调用端调用 (伪嵌入)。因此，复制调用操作或转换的步骤和转换元素会自动创建新的操作或转换对象。
在每种情况下都会复制实现代码。

调用：SFC 菜单

有关复制模式的详细信息，请参见帮助页面以了解 SFC 元素属性和添加步骤操作的指令。

另请参见：
• PLC 文档：SFC 元素属性
• PLC 文档：用顺序功能图（SFC）编程

5.11.20 命令：更改复制 - 删除
功能：此命令通过调用整个 SFC 功能块的步骤或转换来删除动作或转换对象的固定链接。这取消了操作或转
换对象的伪嵌入。如果之后复制调用操作或转换的步骤和转换元素，则副本将调用与源相同的操作和转换。

调用：SFC 菜单

有关复制模式的详细信息，请参见帮助页面以了解 SFC 元素属性和添加步骤操作的指令。

另请参见：
• PLC 文档：SFC 元素属性
• PLC 文档：用顺序功能图（SFC）编程

5.11.21 命令：插入步骤

此命令不作为标准包含在 SFC 菜单中。

符号：

功能：此命令在当前所选位置前添加一个步骤。

调用：SFC 菜单，SFC 编辑器中的上下文菜单

新步骤的默认名称为步骤 <n>。n 是一个序号，第一步从 0 开始，并且在初始化步骤之外添加。可以通过点击
名称进行编辑。

插入不带转换的步骤或不带步骤的转换将导致编译错误。

另请参见：
• 命令：在...后插入步骤-转换 [} 184]
• 命令：初始化步骤 [} 183]
• PLC 文档：SFC 元素步骤和转换
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5.11.22 命令：在...后插入步骤

此命令不作为标准包含在 SFC 菜单中。

符号：

功能：此命令在当前所选位置后插入一个步骤。

调用：SFC 菜单，SFC 编辑器中的上下文菜单

新步骤的默认名称为步骤 <n>。n 是一个序号，第一步从 0 开始，并且在初始化步骤之外添加。可以通过点击
名称进行编辑。

插入不带转换的步骤或不带步骤的转换将导致编译错误。

另请参见：
• 命令：初始化步骤 [} 183]
• 命令：在...后插入步骤-转换 [} 184]
• PLC 文档：SFC 元素跳转

5.11.23 命令：插入转换

此命令不作为标准包含在 SFC 菜单中。

符号：

功能：此命令在当前所选位置前添加一个转换。

调用：SFC 菜单，SFC 编辑器中的上下文菜单

新转换的默认名称为转换 <n>。n 是一个序号，第一个转换从 0 开始。可以通过点击名称进行编辑。

插入不带转换的步骤或不带步骤的转换将导致编译错误。

另请参见：
• 命令：在...后插入步骤-转换 [} 184]
• PLC 文档：SFC 元素步骤和转换

5.11.24 命令：在...后插入转换

此命令不作为标准包含在 SFC 菜单中。

符号：

功能：此命令在当前所选位置后插入一个转换。

调用：SFC 菜单，SFC 编辑器中的上下文菜单

新转换的默认名称为转换 <n>。n 是一个序号，第一个转换从 0 开始。可以通过点击名称进行编辑。

插入不带转换的步骤或不带步骤的转换将导致编译错误。
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另请参见：
• 命令：在...后插入步骤 [} 192]
• PLC 文档：SFC 元素步骤和转换

5.12 CFC

5.12.1 命令：编辑工作表
功能：此命令打开 Edit Worksheet (编辑工作表) 对话框，您可在其中指定工作表的大小。

调用：CFC 菜单

要求：CFC 编辑器处于活动状态。

编辑工作表对话框

使用以下尺寸 您可在此设置工作表的大小。只有尺寸大小满足现有
程序时，才接受您的更改。

自动调整尺寸 根据您程序的大小自动调整工作表尺寸。
相对移动工作表来源 在 x 或 y 轴上移动工作表。允许输入负值。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.2 命令：编辑页面大小
功能：此命令打开编辑页面大小对话框。可使用该对话框更改以页面为导向的 CFC 编辑器的大小。

调用：CFC 菜单

要求：以页面为导向的 CFC 编辑器处于活动状态。
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对话框：编辑页面大小

宽度 页面宽度 (最小 24，最大 1024)。工作区域外的元素以红色高亮显示。
高度 页面高度 (最小 24，最大 1024)。工作区域外的元素以红色高亮显示。
边框宽度 边距宽度 (最小 6，最大 25% 或页面宽度)。
设置为新 CFC 对象的默
认设置 ：当前设置被设置为新 CFC 对象的默认设置。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：CFC 元素页面

5.12.3 命令：否定

符号：

功能：此命令否定功能块的输入或输出。

调用：CFC 菜单，上下文菜单

要求：CFC 编辑器处于活动状态。选择一个功能块输入或输出。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.4 命令：EN/ENO

符号：

功能：此命令向所选功能块添加布尔输入 EN (启用) 和布尔输出 ENO (启用输出)。

调用：CFC 菜单，上下文菜单

要求：CFC 编辑器处于活动状态。选择一个功能块。

添加的输入“EN”启用功能块。仅当它的值为 TRUE 时执行功能块。在输出 ENO 处输出该信号的值。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.5 命令：无

符号：

功能：此命令删除来自“输出”元素输入的重置（R）、设置（S）或 REF。

调用：CFC > Set/Reset（CFC > 设置/重置）菜单；上下文菜单 > 设置/重置

要求：CFC 编辑器处于活动状态。选择 1 个 Output（输出）元素的输入。

另请参见：
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• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.6 命令 R（重置）

符号：

功能：此命令将重置添加到布尔元素输出的输入。

调用：菜单 CFC > Set/Reset (CFC > 设置/重置)，上下文菜单 > 设置/重置

要求：CFC 编辑器处于活动状态。选择一个“输出”元素的输入。

如果输出元素有一个重置输入，则当输入值为 TRUE 时，布尔输出值被设置为 FALSE。保留输出端的值
FALSE，即使输入值再次被更改也不例外。

另请参见：
• 命令 S（设置） [} 195]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.7 命令 S（设置）

符号：

功能：此命令将设置 (S) 添加到布尔元素“输出”的输入。

调用：菜单 CFC > Set/Reset (CFC > 设置/重置)，上下文菜单 > 设置/重置

要求：CFC 编辑器处于活动状态。选择一个输出元素的输入。

如果输出元素有一个设置输入，则当输入值为 TRUE 时，布尔输出值被设置为 TRUE。保留输出端的值
TRUE，即使输入值再次被更改也不例外。

另请参见：
• 命令 R（重置） [} 195]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.8 命令：REF = (引用分配)

符号：

功能：此命令将引用分配到“输出”元素。

调用：菜单 CFC > Set/Reset (CFC > 设置/重置)，上下文菜单 > 设置/重置

要求：CFC 编辑器处于活动状态。选择一个输出元素的输入。

示例：

声明：
refInt : REFERENCE TO INT;
nVar1 : INT;

CFC：
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这对应于 ST 代码
refInt REF= nVar1;

更多信息，请参见对数据类型的引用中的描述。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：引用

5.12.9 命令显示执行顺序

符号：

功能：此命令简要显示编程对象的所有 CFC 元素的编号标记。

调用：
• CFC > Execution order（CFC > 执行顺序）菜单
• CFC 编辑器中的上下文菜单 > Execution order（执行顺序）

要求：CFC 编辑器处于活动状态，自动数据流模式已启用。

数字反映的是自动确定的执行顺序。执行顺序根据数据流确定，而且，在多个网络的情况下，则根据它们在编
辑器中的拓扑位置确定。

只要您点击进入 CFC 编辑器，标记就会隐藏。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.10 命令设置反馈开始

符号：

功能：此命令将所选元素定义为反馈循环的起点。

调用：
• CFC > Execution order（CFC > 执行顺序）菜单
• CFC 编辑器中的上下文菜单 > Execution order（执行顺序）

要求：CFC 编辑器处于活动状态，自动数据流模式已启用。CFC 编程块的网络维持 1 个反馈循环，选择该反馈
循环中的 1 个元素。

在 CFC 编辑器中，反馈中的起点用符号  进行装饰。该元素在反馈中具有最低的执行顺序号。在运行时，
反馈的处理从该元素开始。

另请参见：
• PLC 文档：命令显示执行顺序 [} 196]
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• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.11 命令：移动到开始

符号：

功能：此命令对元素进行编号，以便所选元素位于执行顺序的开头。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序

要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。选择至少 1 个元素。

选中的元素会被分配到从 0 开始的最小数字，同时保持先前的顺序。对其余元素进行编号，使其执行顺序保持
不变。元素的拓扑位置未改变。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.12 命令：移动到结束

符号：

功能：此命令对元素进行编号，以便所选元素位于执行顺序的最后。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序

要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。选择至少 1 个元素。

选中的元素会被分配到最大数字，同时保持先前的顺序。对其余元素进行编号，使其执行顺序保持不变。元素
的拓扑位置未改变。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.13 命令：向前移动一位

符号：

功能：此命令对元素进行编号，以便所选元素位于前一位。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序

要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。选择至少 1 个元素。
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选中元素的编号会减少 1 个，同时保留先前的顺序，以便提前 1 个执行位置处理它们。对其余元素进行编号，
使其执行顺序保持不变。元素的拓扑位置未改变。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.14 命令：向后移动一位

符号：

功能：此命令对元素进行编号，以便所选元素位于后一位。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序

要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。选择至少 1 个元素。

选中元素的编号会增加 1 个，同时保留先前的顺序，以便推迟 1 个执行位置处理它们。对其余元素进行编号，
使其执行顺序保持不变。元素的拓扑位置未改变。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.15 命令：设置执行次序
功能：此命令打开用于将所选元素的编号设置为任何值的对话框。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序

要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。只选择 1 个元素。

所选元素将获得在对话框中指定的编号。对其余元素进行编号，使其执行顺序保持不变。元素的拓扑位置未改
变。

另请参见：
• PLC 文档：命令按数据流排序 [} 198]
• PLC 文档：命令按拓扑结构排序 [} 199]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.16 命令：按数据流排序
功能：此命令根据数据流对程序中的元素进行编号，而且，在多个网络的情况下，则根据它们在编辑器中的拓
扑位置进行编号。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序
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要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。

执行顺序根据数据流和（在多个网络的情况下）网络的拓扑位置进行排列。编程块的所有编号元素都会进行相
应地设置。这样，执行顺序与自动数据流模式下的执行顺序相同。元素的拓扑位置未改变。

另请参见：
• PLC 文档：命令按拓扑结构排序 [} 199]
• PLC 文档：命令设置执行顺序 [} 198]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.17 命令：按拓扑结构排序
功能：此命令根据元素的拓扑位置从右到左以及从上到下排列元素的执行顺序。

调用：CFC > Execution order（CFC > 执行顺序）菜单、上下文菜单 > 执行顺序

要求：CFC 编辑器处于活动状态，显式执行顺序模式已启用。选择至少 1 个元素。

该命令影响程序中的所有元素，即使在执行该命令时未选择所有元素也不例外。元素的拓扑位置未改变。

另请参见：
• PLC 文档：命令按数据流排序 [} 198]
• PLC 文档：命令设置执行顺序 [} 198]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：按数据流自动执行顺序
• PLC 文档：CFC 设置 [} 91]

5.12.18 命令：连接所选引脚

符号：

功能：此命令建立所选引脚之间的链接。

调用：CFC 菜单，上下文菜单

要求：CFC 编辑器处于活动状态。仅选择一个输出和多个输入。

如要选择引脚，点击引脚时长按 [CTRL]。然后执行该命令。

另请参见：
• 命令：选择连接引脚 [} 200]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.19 命令：解锁连接

符号：

功能：此命令解除锁定的连接。



参照用户界面

TE1000200 版本： 2.15.0

调用：菜单 CFC > Routing (CFC > 路由选择)，上下文菜单 > 路由选择

要求：CFC 编辑器处于活动状态。选择一个连接或连接标记。

为自动路由选择更改连接将会导致锁定连接。如要重新执行自动路由选择，您必须首先解除锁定连接。

您还可通过点击锁定连接图标解除该连接。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：CFC 元素连接标记源端/目标端

5.12.20 命令：显示下一个冲突
功能：此命令指示编辑器中的下一个冲突并标记受影响的位置。

调用：编辑器右上角的  按钮

要求：CFC 编辑器处于活动状态，并且至少与冲突有一个连接。

如果您使用大型网络并且只有一个子集可见，则该功能非常实用。冲突也用编辑器右上角带红框的符号表示。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.21 命令：选择连接引脚

符号：

功能：此命令选择连接到当前所选行或面向页面的 CFC 中当前所选连接标记的所有引脚。

调用：上下文菜单

要求：CFC 编辑器或面向页面的 CFC 编辑器处于活动状态。选择 1 个行，并仅选择 1 个连接或 1 个连接标
记。

另请参见：
• 命令：连接所选引脚 [} 199]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.22 命令使用属性组件作为输入端

符号：

功能：此命令允许连接结构组件与标量类型的输入端。

调用：CFC > Pins（CFC > 引脚）菜单、上下文菜单 > 引脚

要求：CFC 编辑器处于活动状态，并选择 1 个功能块输入端。



参照用户界面

TE1000 201版本： 2.15.0

将与后续功能块的输入端连接的结构组件必须具有 {attribute 'ProcessValue'} 属性。结构组件的数据类型必
须与后续输入端的数据类型兼容。以这种方式连接的输入端标有 V 符号。

示例
TYPE ST_Sample :
STRUCT
    {attribute 'ProcessValue'}
    nVar1 : INT;
    nVar2 : INT;
END_STRUCT
END_TYPE

PROGRAM MAIN
VAR
    stInput   : ST_Sample;
    stOutput  : ST_Sample;
    nVar      : INT;
END_VAR

如果您没有为此链接执行命令 Use Attributed Component as Input（使用属性组件作为输入端），则会生
成编译器错误。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.23 命令：重置引脚

符号：

功能：此命令恢复删除的功能块引脚。

调用：菜单 CFC > Pins (CFC > 引脚)，上下文菜单 > 引脚

要求：CFC 编辑器处于活动状态，并选择一个功能块。

根据实现中的定义，该命令恢复功能块的所有输入和输出。

另请参见：
• 命令：删除未使用的引脚 [} 201]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.24 命令：删除未使用的引脚

符号：

功能：此命令删除所选元素的所有未使用引脚。

调用：菜单 CFC > Pins (CFC > 引脚)，上下文菜单 > 引脚

要求：CFC 编辑器处于活动状态。选择一个元素。

另请参见：
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• 命令：重置引脚 [} 201]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.25 命令：添加输入引脚

符号：

功能：此命令添加其他输入至所选功能块。

调用：菜单 CFC > Pins (CFC > 引脚)，上下文菜单 > 引脚

要求：CFC 编辑器处于活动状态。选择一个功能块。

另请参见：
• 命令：添加输出引脚 [} 202]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.26 命令：添加输出引脚

符号：

功能：此命令添加其他输出至所选功能块。

调用：菜单 CFC > Pins (CFC > 引脚)，上下文菜单 > 引脚

要求：CFC 编辑器处于活动状态。选择一个合适的功能块。

另请参见：
• 命令：添加输入引脚 [} 202]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.27 命令：引导所有连接

符号：

功能：此命令撤消对程序中的连接所作的所有手动更改并恢复原始状态。

调用：菜单 CFC > Routing (CFC > 路由选择)，上下文菜单 > 路由选择

要求：CFC 编辑器处于活动状态。

TwinCAT 无法自动引导通过控制点固定的连接。您必须在执行该命令前删除控制点。为此，使用“命令：删

除控制点”。此外，您必须断开手动更改的连接 (以图标  标记)。为此，使用“命令：解锁连接”。

另请参见：
• 命令：删除控制点 [} 203]
• 命令：解锁连接 [} 199]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
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5.12.28 命令：创建控制点

符号：

功能：此命令在连接器上创建控制点。

调用：上下文菜单 > 路由选择

要求：CFC 编辑器处于活动状态。将光标移动到连接上。

在调用命令时光标所在的连接点处创建控制点。该命令对应于 Toolbox (工具箱) 窗口中的 Control point (控
制点) 元素。

另请参见：
• 命令：删除控制点 [} 203]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：CFC 元素控制点

5.12.29 命令：删除控制点
功能：此命令删除控制点。

调用：上下文菜单 > 路由选择

要求：CFC 编辑器处于活动状态。您已选择了一个连接行。

如果将鼠标指针移动到所选连接行上，将以黄色圆圈符号显示现有的控制点。将光标移动到待删除的控制点并
执行上下文菜单中的命令。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：CFC 元素控制点
• 命令：创建控制点 [} 203]

5.12.30 命令：连接标记

符号：

功能：此命令切换连接行与连接标记之间的两个元素间连接的显示。

调用：CFC 菜单，上下文菜单

要求：CFC 编辑器处于活动状态。选择一个连接或连接标记。

如果您选择了连接行，该命令将删除该行并将连接标记源添加到其中一个元素的输出中，并将连接标记目标添
加到另一个元素的输入中。默认情况下，两者都分配相同的名称“C-<n>”；n 是一个序号。

如果选择了一个连接标记对，则该命令将这些标记转换为连接行。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器
• PLC 文档：CFC 元素连接标记源端/目标端
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5.12.31 命令：创建组

符号：

功能：此命令对所选元素进行分组。

调用：菜单 CFC > Group (CFC > 组)，上下文菜单 > 组

要求：CFC 编辑器处于活动状态。选择多个元素。

同组元素一起移动。元素位置不受分组影响。

另请参见：
• 命令：取消组 [} 204]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.32 命令：取消组

符号：

功能：此命令取消之前创建的分组。

调用：菜单 CFC > Group (CFC > 组)，上下文菜单 > 组

要求：CFC 编辑器处于活动状态。选择一个分组。

另请参见：
• 命令：创建组 [} 204]
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.33 命令：编辑参数
功能：此命令打开“Edit Parameters (编辑参数)”对话框，您可在该对话中更改功能块的常量输入参数。

调用：菜单 CFC > Edit parameters (CFC > 编辑参数)，上下文菜单 > 编辑参数，点击功能块字段
Parameter (参数)。

要求：CFC 编辑器处于活动状态。功能块实例化，其声明中带有 VAR_INPUT CONSTANT 变量。

TwinCAT 通过功能块左下角的“Parameter (参数)”一词指示带 VAR_INPUT CONSTANT 变量的功能块。
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对话框：编辑参数

参数 变量名
类型 变量的数据类型
Value 点击字段以输入值。
初始值 初始值
分类 有关参数的附加信息。这些值根据属性定义并且无法在该对话框中更改

• parameterCategory
• parameterUnit
• parameterMinValue
• parameterMaxValue

单位
最小
最大

删除预备参数 如果您已写入一个预备值，则命令激活 (命令：调试 > 写入值)

使用 OK (确认) 退出该字段并退出对话框后，值的更改将应用于项目。

带常量输入的功能块示例：
FUNCTION_BLOCK FB_Sample
VAR_INPUT CONSTANT
    {attribute 'parameterCategory':='General'}
    {attribute 'parameterUnit':= 'm/s'}
    {attribute 'parameterMinValue':= '0'}
    {attribute 'parameterMaxValue':= '100'}
    nIn1 : INT;
    nIn2 : DWORD:=24354333;
    sIn3 : STRING:='abc';
END_VAR

该功能以及带关键词 VAR_INPUT CONSTANT 的变量声明只适用于 CFC 编辑器。在 FBD 编辑器中，
TwinCAT 始终显示功能块上的所有输入参数，无论它们是被声明为 VAR_INPUT 还是 VAR_INPUT
CONSTANT 均不例外。TwinCAT 也不会区分各文本编辑器。

另请参见：
• 命令：将预备参数保存到项目中 [} 206]
• PLC 文档：
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5.12.34 命令强制 FB 输入端

TwinCAT 3.1 Build 4026 及以上版本可用

这种类型的强制在内部使用断点，因此有别于通过命令 Force values（强制值）进行的强制：通过
命令 Force FB input（强制 FB 输入端）强制输入的值不会响应命令 Watch all forces（监视所有强
制执行）或 Cancel forcing for all values（取消对所有值的强制）。

功能：此命令打开用于强制功能块的所选输入端的 Force value（强制值）对话框。使用相同的命令和对话框
可以取消强制。

调用：CFC 菜单、上下文菜单

要求：CFC 编辑器处于在线模式，并选择功能块的输入端。

在对话框 Force value（强制值）中，您可以输入 1 个强制功能块的输入端的值，或者再次删除当前强制的
值。

在强制后，输入端将显示为绿色背景。Boolean 输入端也会获得 1 个带有强制值的小型监控窗口。强制值在监
控视图的 Value（值）列中显示，即程序块的声明部分或监视列表中。

强制值对话框

表达式 功能块输入端的名称
类型 输入数据类型

您想做什么？

设置 1 个新的强制值 您可以在输入字段中输入所需的新值。格式必须与数据类型相对应。
删除值 取消输入端的强制。

另请参见：
• PLC 文档：连续功能图（CFC）
• PLC 文档：CFC 编辑器

5.12.35 命令：将预备参数保存到项目中
功能：此命令在项目中使用预备参数。

调用：CFC 菜单

要求：CFC 编辑器处于活动状态。在在线模式中更改功能块实例的参数值。该应用处于脱机模式。

如果控制器上的常量值与应用中的值不同，则由参数字段右侧的红色星号标志表示。使用命令 Apply
prepared parameter values (应用预备参数值) 将控制值应用于您的应用。

另请参见：
• 命令：编辑参数 [} 204]
• PLC 文档：更改功能块实例的常量输入参数
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5.13 FBD/LD/IL

5.13.1 命令：插入接触点 (右)

符号：

功能：此命令将一个接触点插入到所选元素的右侧。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行、接触点或框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.2 命令：插入网络

符号：

功能：此命令在 FBD/LD/IL 编辑器中插入另一个网络。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。未选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素网络

5.13.3 命令：插入网络 (下)

符号：

功能：此命令在所选网络下的 FBD/LD/IL 编辑器中插入另一个网络。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络，但不选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素网络

5.13.4 命令：切换注释状态

符号：

功能：此命令切换所选网络的注释状态。
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调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络，但不选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.5 命令：插入赋值

符号：

功能：此命令在 FBD 或 LD 编辑器中插入一个赋值。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络，但不选择框。

在 IL 中，使用操作符 LD 和 ST 对赋值进行编程。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素赋值

5.13.6 命令：插入框

符号：

功能：此命令将项目中可用的框插入到所选网络的末尾。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络，但不选择框。

当您选择该命令时，输入助手打开。您可在此选择目标框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素功能块

5.13.7 命令：插入带 EN/ENO 的框

符号：

功能：此命令将带有布尔输入“启用”和布尔输出“启用输出”的框插入到所选网络的末尾。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络，但不选择框。

另请参见：
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• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：带 EN/ENO 的 FBD/LD/IL 元素功能块

5.13.8 命令：插入空框

符号：

功能：此命令将一个空框插入当前所选网络的末尾。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络，但不选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素功能块

5.13.9 命令：插入带 EN/ENO 的框

符号：

功能：此命令将带有布尔输入“启用”和布尔输出“启用输出”的空框插入到所选网络的末尾。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 编辑器、LD 编辑器或 IL 编辑器处于活动状态。必须选择一个网络。不可选择其他框。

如果在调用框时“启用”的值为 FALSE，则不执行框中定义的操作。如果“启用”为 TRUE，则执行这些操
作。ENO 输出可作为 EN 输入的中继器。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：带 EN/ENO 的 FBD/LD/IL 元素功能块

5.13.10 命令：插入跳转

符号：

功能：此命令在当前所选元素前插入一个跳转元素。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择连接器。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素跳转
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5.13.11 命令：插入标签

符号：

功能：此命令将标签插入到当前所选的网络中。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择网络。未选择标签。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素标签

5.13.12 命令：插入返回

符号：

功能：此命令在所选位置插入“返回”元素。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 IL 编辑器处于活动状态。选择框输出。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素返回

5.13.13 命令：插入输入

符号：

功能：此命令将附加输入添加到所选输入上方的可扩展框 (ADD、OR、ADD、MUL、SEL)。

调用：菜单 FBD/LD/IL

要求：FBD/LD 编辑器处于活动状态。选择框输入。

如果选择了一个框，可在上下文菜单中使用命令 Append name input (附加名称输入)。将该输入插入到框的
底部。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.14 命令：插入平行框 (下)

符号：

功能：此命令插入一个与所选框平行的空框。

调用：菜单 FBD/IL/LD，上下文菜单
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要求：在 LD 编辑器中选择一个框。

另请参见：
• PLC 文档：FBD/LD/IL 编辑器

5.13.15 命令：插入线圈

符号：

功能：此命令将线圈插入到网络中。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择网络、线圈或连接器，但不选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素线圈

5.13.16 命令：插入置位线圈

符号：

功能：此命令将置位线圈插入网络中。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择网络、线圈或行，但不选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素线圈

5.13.17 命令：插入复位线圈

符号：

功能：此命令将复位线圈插入网络中。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择网络、线圈或行，但不选择框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素线圈
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5.13.18 命令：插入接触点

符号：

功能：此命令将一个接触点插入到所选元素的左侧。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行或接触点。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.19 命令：插入平行接触点 (下)

符号：

功能：此命令将带有行的平行接触点插入到所选元素下方。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行、接触点或框。

您可以在 LD 网络中将关闭的平行分支编程为短路评估 (SCE) 或 OR 结构。SCE 分支由双垂直行、带
单行的 OR 分支表示。参见“关闭的行分支”的帮助页面。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.20 命令：插入平行接触点 (上)

符号：

功能：此命令将带有行的平行接触点插入到所选元素上方。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行、接触点或框。

您可以在 LD 网络中将关闭的平行分支编程为短路评估 (SCE) 或 OR 结构。SCE 分支由双垂直行、带
单行的 OR 分支表示。参见“关闭的行分支”的帮助页面。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点
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5.13.21 命令：插入否定的接触点

符号：

功能：此命令将一个否定的接触点插入到所选元素左侧。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行或接触点。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.22 命令：插入否定的平行接触点 (下)

符号：

功能：此命令将带有行的否定平行接触点插入到所选元素下方。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行、接触点或框。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.23 命令：粘贴接触点：粘贴在下方
功能：此命令将带有行的之前复制的接触点粘贴到所选元素下方。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.24 命令：粘贴接触点：粘贴在上方
功能：此命令将带有行的之前复制的接触点粘贴到所选元素上方。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行或接触点。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
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• PLC 文档：LD 元素触点

5.13.25 命令：粘贴接触点：粘贴在右侧 (之后)
功能：此命令将之前复制的接触点粘贴到所选元素右侧。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行或接触点。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：LD 元素触点

5.13.26 命令：在下方插入 IL 行

符号：

功能：此命令将一个指令行插入到所选行的下方。

调用：菜单 FBD/LD/IL，上下文菜单

要求：IL 编辑器处于活动状态。选择行。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.27 命令：删除 IL 行

符号：

功能：此命令删除所选的指令行。

调用：菜单 FBD/LD/IL，上下文菜单

要求：IL 编辑器处于活动状态。选择行。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.28 命令：否定

符号：

功能：此命令否定以下元素：
• 框的输入/输出
• 跳转
• 返回
• 线圈
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调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择对应的元素。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.29 命令边缘检测

符号 FBD：

符号 LD：

功能：此命令将 1 个边缘检测插入到所选方框输入端或方框输出端之前。通过执行 1 次、2 次或 3 次命令可以
区分以下功能：

• 在执行 1 次命令时插入的边缘检测可用于检测上升沿。符号的箭头指向右侧。
• 如果再次执行命令，则边缘检测将反转，从而检测到下降沿。符号的箭头指向左侧。
• 如果再一次执行命令，则边缘检测和符号将被删除。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择方框输入端或输出端。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.30 命令：设置/重置

符号：

功能：对于带布尔输出的元素，此命令在“重置”、“设置”和“无”标签之间切换。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择带布尔输出的元素。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.31 命令：设置输出连接

符号：

功能：此命令将所选框输出分配为互联框输出。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择若干框输出之一。

另请参见：
• PLC 文档：FBD/LD/IL
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• PLC 文档：FBD/LD/IL 编辑器

5.13.32 命令：插入分支

符号：

功能：此命令在所选行上创建一个打开的分支。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择框输入或输出。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素线路分支

5.13.33 命令：在上方插入分支

符号：

功能：此命令在所选的打开分支上方创建一个分支。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择一个打开的分支。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素线路分支

5.13.34 命令：在下方插入分支

符号：

功能：此命令在所选的打开分支下方创建一个分支。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择一个打开的分支。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：FBD/LD/IL 元素线路分支

5.13.35 命令：设置分支开始点

符号：

功能：此命令在所选行上设置分支的开始点。
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调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：关闭的行分支

5.13.36 命令：设置分支结束点

符号：

功能：此命令在所选行上设置分支的结束点。

调用：菜单 FBD/LD/IL，上下文菜单

要求：LD 编辑器处于活动状态。选择行。分支的开始点已设置。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：关闭的行分支

5.13.37 命令切换平行模式
功能：此命令在 OR 结构和短路求值（SCE）之间切换平行分支。

调用：FBD/LD/IL 菜单、上下文菜单

要求：FBD/LD/IL 编辑器处于活动状态。选择 1 条平行分支的垂直线。

您可以在 LD 网络中将关闭的平行分支编程为短路求值（SCE）或 OR 结构。SCE 拓扑扩展模块用双
垂直线表示，OR 拓扑扩展模块用单行表示。请参见“封闭分支”的帮助页面。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
• PLC 文档：封闭分支

5.13.38 命令：更新参数
功能：此命令将所选元素声明中的更改应用于图形。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD、LD 或 CFC 编辑器处于活动状态。选择框。对声明进行了扩展更改。

该命令在声明编辑器中检查框及其声明是否匹配。仅当声明被扩展时才能将更改应用于框。删除和覆盖不更
新。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器
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5.13.39 命令：删除未使用的 FB 调用参数

符号：

功能：此命令删除所选功能块的输入和输出，该功能块未被赋予变量和值。但始终保留该功能块的默认输入和
输出。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择一个功能块。该功能块具有未赋值的界面。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.40 命令：修复 POU

符号：

功能：此命令修复所选功能块的内部不一致。

调用：菜单 FBD/LD/IL，上下文菜单

要求：FBD 或 LD 编辑器处于活动状态。选择一个故障功能块。编辑器检测到编程块中的内部不一致，该问题
可以自动解决。TwinCAT 在 Error list (错误列表) 视图中报告不一致现象。

当您编辑使用较旧版本编程系统 (该系统未将这种不一致视为错误) 创建的项目时，可能会发生这种情况。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.41 命令：以功能块示意图的形式查看

注意
数据丢失
零错误转换需要语法正确的代码。否则，部分实现可能会丢失。

功能：此命令将活动的指令列表或活动的梯形图转换为功能块示意图。

调用：菜单 FBD/LD/IL > View (FBD/LD/IL > 视图)

要求：LD 或 IL 编辑器处于活动状态。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.42 命令：以梯形图的形式查看

注意
数据丢失
零错误转换需要语法正确的代码。否则，部分实现可能会丢失。
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功能：此命令将当前功能块代码或活动的指令列表转换为梯形图。

调用：菜单 FBD/LD/IL > View (FBD/LD/IL > 视图)

要求：FBD 或 IL 编辑器处于活动状态。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.43 命令：以指令列表的形式查看

若需要，可通过 TwinCAT 选项启用 IL。

注意
数据丢失
零错误转换需要语法正确的代码。否则，部分实现可能会丢失。

功能：此命令将活动的功能块代码或活动的梯形图转换为指令列表。

调用：菜单 FBD/LD/IL > View (FBD/LD/IL > 视图)

要求：FBD 或 LD 编辑器处于活动状态。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.13.44 命令：转至

符号：

功能：可通过此命令跳转到任何网络。

调用：菜单 FBD/LD/IL

要求：LD、FBD 编辑器或 IL 编辑器处于活动状态。选择网络。

该命令打开带输入字段的对话框。在输入字段中输入所需网络的编号。

另请参见：
• PLC 文档：FBD/LD/IL
• PLC 文档：FBD/LD/IL 编辑器

5.14 梯形图编辑器
在梯形图编辑器中工作的命令可在梯形图菜单和相应的上下文菜单中找到。

5.14.1 命令注释掉

符号：
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功能：此命令可在注释掉和未注释掉状态之间切换网络 [} 222]。

调用：Ladder（梯形图）菜单；上下文菜单

网络内容以灰色显示，文本以斜体显示。在处理过程中，不会考虑网络。

5.14.2 命令否定

符号：

功能：此命令否定以下元素：
• 方框的输入端/输出端
• 跳转
• 返回
• 线圈
• 触点
• 变量

调用：Ladder（梯形图）菜单；上下文菜单

要求：选择要否定的元素。

示例：

1 个功能块上的否定输入端和否定输出端：

否定触点：

否定线圈：

5.14.3 命令打开平行分支

符号：

功能：此命令可打开 1 个封闭的平行分支。

调用：Ladder（梯形图）菜单；上下文菜单

要求：必须从要重新打开的分支的 2 条线路中选择 1 条。

5.14.4 命令关闭平行分支

符号：
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功能：此命令可将打开的平行分支关闭。

调用：Ladder（梯形图）菜单；上下文菜单

要求：必须选择要关闭的分支的 2 条线路：

或者，也可以通过将 1 个分支的选择标记拖到另一个分支的选择标记处来关闭 1 个打开的分支。

5.14.5 命令设置/重置 – 设置，设置/重置 – 重置

符号：设置 、重置 

功能：设置命令为编辑器中所选的元素提供 1 个设置修饰符。重置命令为元素提供 1 个重置修饰符。

例如，您可以用它将 1 个线圈 [} 223]和 1 个非主方框制成 1 个“设置线圈”。此命令仅在适当的位置可用。

调用：Ladder（梯形图）菜单、Set/Reset（设置/重置）子菜单；上下文菜单

5.14.6 命令边缘检测 – 上升沿

符号：

功能：此命令将 1 个上升沿检测插入到所选方框输入端或触点之前。

调用：Ladder（梯形图）菜单；上下文菜单

要求：选择 1 个方框输入端或触点。

5.14.7 命令边缘检测 – 下降沿

符号：

功能：此命令将 1 个下降沿检测插入到所选方框输入端或触点之前。

调用：Ladder（梯形图）菜单；上下文菜单

要求：选择 1 个方框输入端或触点。

5.14.8 命令 EN/ENO：EN

符号：

功能：此命令用于添加或删除所选方框中的 Boolean 输入端“启用”。

调用：Ladder（梯形图）菜单、EN/ENO 子菜单；上下文菜单

Boolean EN 输入端控制方框的执行。如果在方框调用期间 EN 值为 FALSE，则不会执行在方框中定义的操
作。如果 EN 为 TRUE，则执行这些操作。

如果 1 个方框有 EN 输入端，也可以为其添加 ENO 输出端 [} 221]：ENO 的值与 EN 的值相同。

5.14.9 命令 EN/ENO：ENO

符号：
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功能：此命令为带有 EN 输入端的方框添加 ENO 输出端。

调用：Ladder（梯形图）菜单、EN/ENO 子菜单；上下文菜单

要求：选择 1 个带有 EN 输入端的方框。

ENO 输出端的值与 EN 输入端的值相同。

5.14.10 命令插入网络

符号：

功能：此命令在梯形图编辑器中插入 1 个附加网络。当您将元素拖到实现部分上时，您可以通过光标  上的
加号识别可能的插入位置。

调用：Ladder（梯形图）菜单；上下文菜单

要求：未选择方框。

5.14.10.1 元素：网络

网络是 LD 程序的基本单元。在梯形图编辑器中，网络以列表形式排列在彼此下面。每个网络左侧都有 1 个递
增的网络编号，可能包括以下内容：逻辑和算术表达式、程序/函数/功能块调用、跳转或返回语句。

您可以为每个网络提供标题、注释或跳转标签。

网络标题：双击网络顶部的第 1 行，指定它。

网络注释：双击网络顶部的第 2 行，指定它。

跳转标签：双击网络顶部的第 3 行，指定它。然后，在跳转 [} 223]元素中可以将跳转标签指定为目标。

在 TwinCAT 选项的 梯形图 [} 166]类别中，您可以定义是否在编辑器中显示网络标题、网络注释以及各个网络
之间的分隔线。

5.14.11 命令插入触点

符号： ，在编辑器中为 

功能：此命令将 1 个触点插入到网络中所选元素的左侧。当您将元素从工具箱拖到实现部分时，光标  上的
加号会帮助您识别可能的插入位置。

调用：Ladder（梯形图）菜单；上下文菜单

要求：选择行或触点。

5.14.11.1 元素：触点

触点从左到右传递 TRUE（ON）或 FALSE（OFF）信号，直到信号到达网络右侧的线圈。为此，可为触点分
配 1 个包含信号的 Boolean 变量。为此，可将触点上方的 ??? 占位符替换为 Boolean 变量的名称。

您可以将多个触点串联或并联起来。如果使用 2 个并联触点，则仅限在其中 1 个触点的值为 TRUE 时，才能向
右传递 ON。如果将触点串联起来，则必须将所有触点设置为 TRUE，才能从串联的最后一个触点向右传递
ON。因此，您可以使用 LD 对并联和串联电路进行编程。

当变量值为 FALSE 时，否定触点  会传递 TRUE 信号。您可以使用 Ladder → Negate（梯形图 → 否定）
命令启用或禁用已插入触点的否定功能。



参照用户界面

TE1000 223版本： 2.15.0

5.14.12 命令插入线圈

符号：

编辑器中的符号：

功能：此命令将线圈插入到网络中。当您将元素从工具箱拖到实现部分时，光标  上的加号会帮助您识别可
能的插入位置。

调用：Ladder（梯形图）菜单；上下文菜单

要求：选择网络、线圈或连接器。未选择方框。

5.14.12.1 元素：线圈

线圈可获取从左侧传递过来的值，并将其存储到分配给它的 Boolean 变量中。其输入端可以有值 TRUE
（ON）或 FALSE（OFF）。

在否定 [} 220]线圈  中，输入信号的否定值存储在分配给线圈的 Boolean 变量中。

通过设置/重置 [} 221]子菜单的命令，您可以定义“设置线圈”或“重置线圈”：

设置线圈：如果 TRUE 值到达设置线圈，则该线圈会保留 TRUE 值。只要应用程序处于运行状态，在此处就不
再覆盖该值。

重置线圈：如果 TRUE 值到达重置线圈，则该线圈会保留 FALSE 值。只要应用程序处于运行状态，在此处就
不再覆盖该值。

5.14.13 命令插入方框
符号：

功能：此命令可插入在所选网络的末尾可用的方框。当您将元素从工具箱拖到实现部分时，光标  上的加号
会帮助您识别可能的插入位置。

调用：Ladder（梯形图）菜单；上下文菜单

该命令默认插入 1 个 EN/ENO 方框。Ladder（梯形图）EN/ENO 菜单命令可用于删除和添加 EN [} 221] 和
ENO [} 221] 修饰符。

当前未实现：如果是在项目中定义的方框，则在更改该方框后必须更新梯形图中的用法。

5.14.13.1 元素：方框

方框元素可代表其他函数：例如，IEC 功能块、IEC 函数、库功能块或运算符。

如果方框还提供图像文件，则可在方框内显示方框图标。前提条件：在 TwinCAT 选项的 Ladder（梯形图）
类别中已启用 Show box icon（显示方框图标）选项。

5.14.14 命令插入跳转

符号：

功能：此命令在所选的元素前插入 1 个跳转元素。当您将元素从工具箱拖到实现部分时，光标  上的加号会
帮助您识别可能的插入位置。

调用：Ladder（梯形图）菜单；上下文菜单
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要求：选择 1 个连接器。

5.14.14.1 元素：跳转

在 LD 中，根据当前光标位置，您可以直接在输入端前、输出端后或网络末端插入跳转。

您可以直接在跳转元素后输入网络的跳转标签作为跳转目标。

5.14.15 命令插入返回

符号：

功能：此命令在所选位置插入 Return（返回）元素。当您将元素从工具箱拖到实现部分时，光标  上的加
号会帮助您识别可能的插入位置。

调用：Ladder（梯形图）菜单；上下文菜单

5.14.15.1 元素：返回

当 Return（返回）元素的输入端变为 TRUE 时，该元素可立即中断梯形图方框的执行。您可以将 Return
（返回）语句置于与前面元素平行或在其之后的位置。

5.14.16 命令插入输入端

符号：

功能：此命令在所选位置插入输入端。当您将元素从工具箱拖到实现部分时，光标  上的加号会帮助您识别
可能的插入位置。您可以用变量名或常量替换最初显示的问号 ??? ﻿。

调用：Ladder（梯形图）菜单；上下文菜单

5.14.16.1 元素：输入

该元素用于将变量值分配给信号流中的另一个元素。它有 1 条向右延伸的线。

5.14.17 命令插入输出端

符号：

功能：此命令在所选位置插入输出端。当您将元素从工具箱拖到实现部分时，光标  上的加号会帮助您识别
可能的插入位置。您可以用变量名或常量替换最初显示的问号 ???﻿。

调用：Ladder（梯形图）菜单；上下文菜单

5.14.17.1 元素：输出

该元素用于将来自左侧的信号分配给与该元素相关的变量。它有 1 条来自左侧的输入行。

5.14.18 命令转换为新梯形图
在 FBD/LD 编辑器中可用。
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5.15 声明

5.15.1 命令粘贴

符号：

功能：此命令在表格声明编辑器中为变量声明插入新行，并打开变量名的输入字段。

调用：表格声明编辑器的声明标题中的按钮、表格声明编辑器中的上下文菜单

如要编辑声明行的其他字段，可双击这些字段，然后从选择列表或相应对话框中选择信息。

另请参见：
• PLC 文档：使用声明编辑器

5.15.2 命令编辑声明标题
功能：此命令可打开 Edit the declaration header（标记声明标题）对话框，在表格声明编辑器中使用该对
话框配置 POU 的标题。

调用：鼠标点击表格声明编辑器的标题栏、表格声明编辑器中的上下文菜单

对话框编辑声明标题
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声明 更改 POU 类型的选择列表
• PROGRAM
• FUNCTION_BLOCK

◦ EXTENDS：基本功能块的输入字段
◦ IMPLEMENTS：接口的输入字段

• FUNCTION
◦ 返回类型

带有当前 POU 名称的输入字段：您可以更改 POU 的名称。
在重命名时自动调整所有引用

：Refactoring（重构）对话框会打开。

：重命名仅在 POU 的声明标题中生效。
属性 Attributes（属性）对话框将打开，用于输入属性和编译指示。

另请参见：
• PLC 文档：使用声明编辑器
• PLC 文档：编译指示
• PLC 文档：重构

5.15.3 命令向下移动

符号：

功能：此命令将变量声明向下移动 1 行。

调用：表格声明编辑器的声明标题中的按钮、表格声明编辑器中的上下文菜单

要求：在表格声明编辑器中选择带有变量声明的行。

另请参见：
• PLC 文档：使用声明编辑器

5.15.4 命令向上移动

符号：

功能：此命令将变量声明向上移动 1 行。

调用：表格声明编辑器的声明标题中的按钮、表格声明编辑器中的上下文菜单

要求：在表格声明编辑器中选择带有变量声明的行。

另请参见：
• PLC 文档：使用声明编辑器

5.16 文本列表

5.16.1 命令：添加语言

符号：
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功能：此命令在文本列表中添加一个附加的语言列。

调用：菜单 Textlist (文本列表)，上下文菜单

要求：文本列表或全局文本列表打开并处于活动状态。

在 Choose language (选择语言) 对话框中输入新语言的缩写，例如“en-US”。TwinCAT 将缩写作为列标题
插入。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.2 命令：删除语言

符号：

功能：此命令删除文本列表中的所选语言列。

调用：菜单 Textlist (文本列表)，上下文菜单

要求：文本列表或全局文本列表打开并处于活动状态。选择您要删除的语言列中的字段。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.3 命令：插入文本

符号：

功能：此命令在文本列表中的所选行上方插入一个新行。在 Standard (标准) 下打开一个输入字段，您可在该
字段中输入源文本。

调用：菜单 Textlist (文本列表)

要求：文本列表 (不是 GlobalTextList) 打开并处于活动状态。在表中选择一个字段。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.4 命令：导入/导出文本列表

符号：

功能：此命令导出一个活动文本列表、导入一个文件或将文本列表与文件同步。该文件是 CSV 格式。Import/
Export (导入/导出) 对话框提供了用于此目的的选项。

调用：菜单 Textlist (文本列表)，上下文菜单

要求：文本列表或全局文本列表打开并处于活动状态。
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导入/导出对话框

选择要比较或导入的文件 TwinCAT 读取的文件。

 打开 Choose textlist file（选择文本列表文件）对话框，您可在其中选择 1
个文件。

选择导出文件 TwinCAT 写入的文件。

 打开 Choose textlist file （选择文本列表文件）对话框，您可在其中选择 1
个文件和 1 个目录。

导入/导出类型：

导入 要求：在 Choose file to compare or to import（选择要比较或导入的文件）中
选择 1 个文件。
该文件可能包含全局文本列表或文本列表的文本列表记录。
全局文本列表：
• TwinCAT 读取文件、比较相同源文本的文本列表记录并将差异应用于翻译中。

必要时，TwinCAT 将覆盖项目中的翻译。
文本列表：
• TwinCAT 读取文件、比较相同 ID 的文本列表记录并将差异应用于项目的源文本

和翻译中。必要时，TwinCAT 将覆盖项目中的文本列表记录。
• 如果文件包含 1 个新 ID，文本列表条目将被导入到项目的文本列表中，并且该

文本列表将被修改。
导入替换文件 要求：在 Choose file to compare or to import（选择要比较或导入的文件）中

选择 1 个替换文件。
替换文件包含全局文本列表的替换。
TwinCAT 逐行处理替换文件并在全局文本列表中实现指定的替换。有关替换文件
的结构，请参见 管理全局文本列表中的静态文本 部分。

导出 要求：在“Choose export file”（选择导出文件）中选择 TwinCAT 写入的文件。
TwinCAT 导出当前项目的所有文本列表中的所有文本。项目中可用的所有语言均
作为列插入到导出文件中。该文件可用于从外部翻译与语言相关的文本。

仅导出文本差异 要求：在 Choose file to compare or to import（选择要比较或导入的文件）中
选择 1 个用于比较的导入文件。在 Choose export file（选择导出文件）中选择
TwinCAT 写入的导出文件。
TwinCAT 读取导入文件并将活动文本列表的行与之进行比较。TwinCAT 忽视任何
匹配的行。如果行不同，TwinCAT 将该行写入导出文件并应用文本列表中的翻
译。TwinCAT 应用导入文件中的翻译并覆盖（如适用）。

另请参见：
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• PLC 文档：管理文本列表中的文本

5.16.5 命令：删除未使用的文本列表记录

符号：

功能：此命令检查项目中的文本列表记录是否用作静态文本。如果不是，TwinCAT 将从文本列表中删除该文
本。

调用：菜单 Textlist (文本列表)，上下文菜单

要求：全局文本列表打开并处于活动状态。在表中选择一个字段。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.6 命令：检查图形文本 ID

符号：

功能：此命令检查项目中的文本列表记录 ID 是否正确并报告结果。

调用：菜单 Textlist (文本列表)，上下文菜单

要求：全局文本列表打开并处于活动状态。在表中选择一个字段。

如果 TwinCAT 检测到可视化的全局文本列表与静态文本不匹配，可能是因为全局文本列表为只读状态。需要
在项目中设置用户管理。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.7 命令：更新可视化文本 ID

符号：

功能：此命令更新静态文本列表中的所有不一致 ID。

调用：菜单 Textlist (文本列表)，上下文菜单

要求：全局文本列表打开并处于活动状态。在表中选择一个字段。该对象为只读状态。

如果 TwinCAT 检测到可视化的全局文本列表与静态文本不匹配，可能是因为全局文本列表为只读状态。需要
在项目中设置用户管理。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.8 命令导出全部

符号：

功能：此命令导出项目的所有文本列表。

调用：菜单 Textlist（文本列表）、上下文菜单
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要求：
• 文本列表或全局文本列表打开并处于活动状态。
• 可视化未通过 Unicode 对文本字符进行编码。

TwinCAT 为每个文本列表创建 1 个 .txt 格式的普通文本。文本列表名称成为文件的名称。该文件保存在
TwinCAT 项目的目录中。

控制器可读取并使用此格式。例如，您可以将文件复制到控制器，并通过可视化管理器中的设置配置该文件，
以便在加载 PLC 项目时不会再次传输文本列表。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.9 命令导出所有 Unicode

符号：

功能：此命令导出项目的所有文本列表。

调用：菜单 Textlist（文本列表）、上下文菜单

要求：
• 文本列表或全局文本列表打开并处于活动状态。
• 可视化通过 Unicode 对文本字符进行编码。

◦ 在可视化管理器中启用选项 Use Unicode strings （使用 Unicode 字符串）。

TwinCAT 为每个文本列表创建 1 个 .txt 格式的普通文本。文本列表名称成为文件的名称。该文件保存在
TwinCAT 项目的目录中。

控制器可读取并使用此格式。例如，您可以将文件复制到控制器，并通过可视化管理器中的设置配置该文件，
以便在加载 PLC 项目时不会再次传输文本列表。

另请参见：
• PLC 文档：管理文本列表中的文本

5.16.10 命令：添加文本列表支持

符号：

功能：此命令将文本列表支持添加到 Enumeration (枚举) 类型的所选 DUT 对象中。

调用：Enumeration (枚举) 类型标准 DUT 对象的上下文菜单 ( )

文本列表支持实现了枚举组件标识符的本地化以及可视化文本输出中符号组件值的表示。

另请参见：
• PLC 文档：对象 DUT
• 命令：删除文本列表支持 [} 230]

5.16.11 命令：删除文本列表支持

符号：

功能：此命令删除所选枚举对象中的文本列表支持。
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调用：带文本列表支持的枚举对象的上下文菜单 ( )。

文本列表支持实现了枚举组件标识符的本地化以及可视化文本输出中符号组件值的表示。

5.17 配方

5.17.1 命令：添加新配方

符号：

功能：此命令打开一个用于在配方定义中插入新配方 (新列) 的对话框。

调用：菜单 Recipes (配方)，上下文菜单

要求：配方定义在编辑器中打开。

当您运行该命令时，将打开一个对话框，您可以在其中设置新配方的名称。对话框还提供用于将现有配方复制
到新配方的选项。

另请参见：
• PLC 文档：更改带配方的值

5.17.2 命令：删除配方

符号：

功能：此命令从当前打开的配方定义中删除配方。

调用：菜单 Recipes (配方)，上下文菜单

要求：在配方定义的配方列中选择一个字段。

另请参见：
• PLC 文档：更改带配方的值

5.17.3 命令：加载配方

符号：

功能：此命令加载文件中的配方。

调用：Recipes（配方）菜单；上下文菜单

要求：在配方定义的配方列中选择 1 个字段。
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当您运行该命令时，将打开用于选择文件的标准对话框。筛选器自动设置为文件扩展名 *.txtrecipe。加载后，
将覆盖配方定义中所选配方的值并更新显示。

如果您只想用新值覆盖单个配方变量，请在将配方加载到配方文件中之前删除其他变量的值。不读取没有值规
范的条目，这意味着这些变量不受控制器上和项目中更新的影响。以下是配方文件中的条目示例。加载时，仅
写入带新值（6）的 MAIN.nVar：
MAIN.nVar1:=
MAIN.nVar2:=6
MAIN.nVar3:=
MAIN.sVar4:=
MAIN.wsVar5:=

对于 REAL/LREAL 数据类型的值，在某些情况下也会将十六进制值写入配方文件。这样做很有必要，以便在反
向转换过程中恢复完全相同的值。在这种情况下，更改十进制值并删除十六进制值。

另请参见：
• PLC 文档：更改带配方的值

5.17.4 命令：保存配方

符号：

功能：此命令将配方变量的值保存在文件中。

调用：菜单 Recipes (配方)，上下文菜单

要求：在配方定义中选择配方值。

执行该命令时，TwinCAT 将所选配方的值保存在扩展名为 *.txtrecipe 的文件中，必须定义该文件的名称。用
于保存文件的标准对话框打开。格式通过 Storage (存储) 选项卡中的配方管理器进行设置。

覆盖隐式配方文件
不得覆盖作为读取和写入配方的剪贴板的隐式配方文件。这意味着该文件名称必须与 <Recipe
name>.<Recipe definition name>.txtrecipe 不同。

另请参见：
• PLC 文档：更改带配方的值

5.17.5 命令：读取配方

符号：

功能：此命令读取来自控制器的配方变量值。

调用：菜单 Recipes (配方)，上下文菜单

要求：PLC 项目处于在线模式，并在配方定义中选择配方值。

执行该命令时，TwinCAT 用从控制器读取的值覆盖所选配方的值。在此过程中，值被隐式存储在控制器的文
件中，并同时显示在配方定义表中。

另请参见：
• PLC 文档：更改带配方的值

5.17.6 命令：写入配方

符号：



参照用户界面

TE1000 233版本： 2.15.0

功能：此命令将配方值写入控制器中的变量。

调用：菜单 Recipes (配方)，上下文菜单

要求：PLC 项目处于在线模式，并在配方定义中选择配方值。

执行该命令时，TwinCAT 用所选配方的值覆盖控制器中的值。

另请参见：
• PLC 文档：更改带配方的值

5.17.7 命令：加载和写入配方

符号：

功能：此命令加载文件中的配方并将值写入控制器中的变量。

调用：Recipes（配方）菜单；上下文菜单

要求：PLC 项目处于在线模式，并在配方定义中选择配方值。

在运行命令之后，系统将询问您文件中的值应该写入项目中的配方还是只写入 PLC。需要在下一次登录时进行
在线更改才能更新配方中的值。

当您执行命令时，TwinCAT 将覆盖配方定义中所选配方的值。此外，控制器中的变量值被这些配方值覆盖。

如果您只想用新值覆盖单个配方变量，请在将配方加载到配方文件中之前删除其他变量的值。不读取没有值规
范的条目，这意味着这些变量不受控制器上和项目中更新的影响。以下是配方文件中的条目示例。加载时，仅
写入带新值（6）的 MAIN.nVar1。
MAIN.nVar1:=
MAIN.nVar2:=6
MAIN.nVar3:=
MAIN.sVar4:=
MAIN.wstVar5:=

对于 REAL/LREAL 数据类型的值，在某些情况下也会将十六进制值写入配方文件。这样做很有必要，以便在反
向转换过程中恢复完全相同的值。在这种情况下，更改十进制值并删除十六进制值。

另请参见：
• PLC 文档：更改带配方的值

5.17.8 命令：读取和保存配方

符号：

功能：此命令读取控制器中的配方变量值并将该值保存在文件中。

调用：菜单 Recipes (配方)，上下文菜单

要求：PLC 项目处于在线模式，并在配方定义中选择配方值。

执行命令后，将询问您是否将变量值读入项目中的配方，还是只保存它们。需要在下一次登录时进行在线更改
才能更新配方中的值。

根据配方管理器的设置，这些值以配方文件的默认名称保存 (Storage (存储) 选项卡)。

另请参见：
• PLC 文档：更改带配方的值
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5.17.9 命令：插入变量

符号：

功能：此命令在所选位置前添加一个变量到当前打开的配方定义。

调用：菜单 Recipes (配方)，上下文菜单

要求：在编辑器中打开配方定义，并选择简单视图。

TwinCAT 在 Variable (变量) 列中添加默认文本“NewVariable”。您必须用相应的有效变量名替换该名称。
为此，通过  按钮打开输入助手或直接在表字段中输入变量名。

另请参见：
• PLC 文档：更改带配方的值

5.17.10 命令：删除变量

符号 

功能：此命令删除配方定义中的所选变量。

调用：[Del] 键，上下文菜单

要求：已选择一个变量。

另请参见：
• PLC 文档：更改带配方的值

5.17.11 命令：更新结构化变量

符号：

功能：此命令打开对话框 Update structured variables (更新结构化变量)。

调用：菜单 Recipes (配方)

在对话框中，如果结构化变量或功能块的声明已更改，则可以更新配方定义。例如，如果阵列尺寸已更改，则
可以自动删除或添加配方定义中的条目。
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更新结构化变量对话框

删除不存在的变量
：从配方定义中删除由于结构化元素的更改而不

再存在于项目中的变量。
更新结构和功能块的实例

：如果扩展了由配方定义中的实例表示的结构或
功能块声明，则相应变量将被添加到配方定义中。

更新阵列实例的阵列尺寸
：如果扩展了由配方定义中的实例表示的阵列尺

寸，则相应变量将被添加到配方定义中。
更新所包含的全局变量列表

：如果扩展了由配方定义中的实例表示的全局变
量列表声明，则相应变量将被添加到配方定义中。

更新所包含的程序
：如果扩展了在配方定义中实例化的程序声明，

则相应变量将被添加到配方定义中。

另请参见：
• PLC 文档：更改带配方的值

5.17.12 命令从设备下载配方

符号：

功能：此命令启动项目中当前打开的配方定义中的配方与设备上以配方文件形式存在的配方的同步。

调用：菜单 Recipes（配方）

要求：PLC 项目处于在线模式，您已在编辑器中打开配方定义。具体来说，同步具有以下效果：
• 项目中存在的配方变量的当前值将被控制器上的配方值覆盖。这可能会在下次登录时触发在线更改。
• 如果在控制器上的配方文件中定义了配方变量，而项目中的配方定义中缺少这些变量，则在加载时会忽

略这些变量。对于每个配方文件，都会出现 1 条包含受影响变量的消息。
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• 如果控制器上的配方文件中缺少配方变量（这些变量包含在项目的配方定义中），则会为每个配方文件
显示 1 条显示受影响变量的消息。

• 如果在控制器上为这些变量创建了附加配方，这些配方将被添加到项目中的配方定义中。

5.18 库
命令 PLC 文档的更多信息
库创建
命令：另存为库... 命令另存为库 [} 258]
命令：另存为库并安装... 命令另存为库并安装 [} 260]
库安装
命令：库存储库 库存储库
库管理
库管理器对话框 库管理器
其他命令和对话框
命令：添加库 命令添加库
命令：添加无解析的库 添加无占位符解析的库命令
命令：尝试重新加载库
命令：删除库
命令：详细信息
命令：相关性
命令：属性
命令：占位符 占位符
命令：设置为有效版本
命令：设置为始终最新版本
命令：转换为项目引用 命令：转换为项目引用
命令：转换为库 命令：转换为库
命令：转换为库并安装 命令：转换为库并安装

另请参见：
• PLC 文档：使用库 > 更多命令和对话框

5.19 可视化
可视化命令由可视化命令菜单类别中的 Visual Editor (可视化编辑器) 插件提供，位于对话框
Tools > Customize (工具 > 自定义) 中。您可通过其编辑可视化编辑器中的可视化对象。

大多数命令作为标准命令包含在 Visualization (可视化) 菜单中，因此也可在可视化编辑器的上下文菜单中使
用它们。必要时，打开对话框 Tools > Customize (工具 > 自定义) 以查看或修改类别 Visualization (可视化)
的菜单配置。

5.19.1 命令：界面编辑器

符号：

功能：此命令打开用于在可视化中定义边框参数的界面编辑器，这些参数将在其他可视化的 Frame (边框) 元
素中引用。其显示在可视化编辑器上部的选项卡视图中。

调用：菜单 Visualization (可视化)

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/18014402723197963.html?id=6000900910688230529
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5.19.2 命令：热键配置

符号：

功能：此命令打开当前可视化的键盘配置编辑器。其显示在可视化编辑器上部的选项卡视图中。

调用：菜单 Visualization (可视化)

5.19.3 命令：元素列表

符号：

功能：此命令打开当前可视化的元素列表编辑器。其显示在可视化编辑器上部的选项卡视图中。

调用：菜单 Visualization (可视化)

5.19.4 命令：左对齐

符号：

功能：此命令将所有选中的可视化元素与其最左侧元素的左边缘对齐。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.5 命令：顶部对齐

符号：

功能：此命令将所有选中的可视化元素与其最顶部元素的上边缘对齐。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.6 命令：右对齐

符号：

功能：此命令将所有选中的可视化元素与其最右侧元素的右边缘对齐。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.7 命令：底部对齐

符号：

功能：此命令将所有选中的可视化元素与其最底部元素的下边缘对齐。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.8 命令：垂直居中对齐

符号：

功能：此命令将所有选中的可视化元素与其共同的垂直中心对齐。
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调用：菜单 Visualization (可视化)，上下文菜单

5.19.9 命令：水平居中对齐

符号：

功能：此命令将所有选中的可视化元素与其共同的水平中心对齐。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.10 命令：使水平间距相等

符号：

如果选中三个或更多元素，则此命令激活。
1. 选择所有要具有相同水平间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Make horizontal spacing equal (使水平间距相等)。
ð 最左和最右的元素保持其位置，位于它们之间的元素以相等的水平间距对齐。

5.19.11 命令：增加水平间距

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有要增加水平间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Increase horizontal spacing (增加水平间距)。
ð 蓝色元素保持其位置，其他元素水平对齐，各元素之间的间距增加。间距增加 1 个像素。

5.19.12 命令：缩小水平间距

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有要缩小水平间距的元素。
2. 运行命令 Decrease horizontal spacing (缩小水平间距)。
ð 蓝色元素保持其位置，其他元素水平对齐，各元素之间的间距缩小。间距减小 1 个像素。

5.19.13 命令：删除水平间距

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有不设置水平间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Remove horizontal spacing (删除水平间距)。
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ð 蓝色元素保持其位置，其他元素水平对齐，彼此之间无间距。

5.19.14 命令：使垂直间距相等

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有要具有相同垂直间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Make vertical spacing equal (使垂直间距相等)。
ð 最顶部和最底部的元素保持其位置，位于它们之间的元素以相等的垂直间距对齐。

5.19.15 命令：增加垂直间距

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有要增加垂直间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Increase vertical spacing (增加垂直间距)。
ð 蓝色元素保持其位置，其他元素垂直对齐，各元素之间的间距增加。间距增加 1 个像素。

5.19.16 命令：缩小垂直间距

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有要缩小垂直间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Decrease vertical spacing (缩小垂直间距)。
ð 蓝色元素保持其位置，其他元素垂直对齐，各元素之间的间距缩小。间距减小 1 个像素。

5.19.17 命令：删除垂直间距

符号：

如果选中两个或更多元素，则此命令激活。
1. 选择所有不设置垂直间距的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Remove vertical spacing (删除垂直间距)。
ð 蓝色元素保持其位置，其他元素垂直对齐，彼此之间无间距。
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5.19.18 命令：使宽度相等

符号：

如果选中超过一个元素，则此命令激活，但选择一个行或多边形元素除外。
1. 选择应具有相同宽度的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Make same width (使宽度相同)。
ð 所有元素被设置为以蓝色标记的元素的宽度。

5.19.19 命令：使高度相等

符号：

如果选中超过一个元素，则此命令激活，但选择一个行或多边形元素除外。
1. 选择应具有相同高度的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Make same width (使高度相同)。
ð 所有元素被设置为以蓝色标记的元素的高度。

5.19.20 命令：使大小相等

符号：

如果选中超过一个元素，则此命令激活，但选择一个行或多边形元素除外。
1. 选择应具有相同大小的元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Make same width (使大小相同)。
ð 所有元素被设置为以蓝色标记的元素的大小。

5.19.21 命令：对齐网格

符号：

如果选中超过一个元素，则此命令激活，但选择一个行或多边形元素除外。
1. 选择位置和大小应与网格对齐的所有元素。

ð 第一个元素以蓝色高亮显示，其他元素显示为灰色。
2. 运行命令 Size to Grid (对齐网格)。
ð 所有元素均基于其大小和位置对齐到网格。

5.19.22 命令：前置

符号：
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功能：此命令将所选元素向上移动一级，即可视化前景中的更高一层。较低层次的元素被较高层次的元素遮
盖。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.23 命令：置于顶层

符号：

功能：此命令将所选元素移动到可视化的前景中，即最高层。较低层次的元素被较高层次的元素遮盖。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.24 命令：后置

符号：

功能：此命令将所选元素向下移动一级，即可视化背景中的更低一层。较低层次的元素被较高层次的元素遮
盖。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.25 命令：置于底层

符号：

功能：此命令将所选元素移动到可视化的背景中，即最低层。较低层次的元素被较高层次的元素遮盖。

调用：菜单 Visualization (可视化)，上下文菜单

5.19.26 命令：分组

符号：

功能：此命令对当前所选可视化元素进行分组并将该组显示为一个单一对象。

调用：菜单 Visualization (可视化)，上下文菜单

要求：选择多个可视化元素。如要选择多个对象，按住 [<Shift>] 键并点击需要的项。或者可以点击元素外的
编辑器窗口，并按住鼠标键围绕目标元素绘制一个矩形。

使用命令 Ungroup (取消组) 解除该组。

下图显示的是两个矩形元素的分组 (从左到右) 或取消组 (从右到左)：

• 命令：取消组 [} 242]
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5.19.27 命令：取消组

符号：

功能：此命令解除可视化元素组。单独的元素再次被单独选中。

调用：菜单 Visualization (可视化)，上下文菜单

另请参见：
• 组 [} 241]

5.19.28 命令：背景

符号：

功能：此命令打开对话框 Frame Configuration (边框配置)，可在该对话框中选择可视化背景的颜色或图
像。

调用：菜单 Visualization (可视化)，上下文菜单

背景对话框

启用所需选项：
• 位图：要定义背景图像，请输入项目图像库中可用的图像文件路径。输入图像库的名称和图像文件 ID，

用点号“.”分隔：<image pool>.<ID> (例如“Images_1.drive_icon>”，“Images_1.43”)。
• 颜色：要定义可视化的背景颜色，从颜色列表中选择所需颜色。

5.19.29 命令：全选

符号：  / 

功能：此命令选择当前在编辑器中打开的所有可视化元素。

调用：菜单 Visualization (可视化)，上下文菜单

另请参见：
• 取消全选 [} 242]

5.19.30 命令：取消全选

符号：

功能：此命令清除当前选择的可视化元素。
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调用：菜单 Visualization (可视化)

另请参见：
• 命令：全选 [} 242]

5.19.31 命令：倍增可视化元素

符号：

功能：此命令打开对话框 Multiply visu element (倍增可视化元素)，您可使用该对话框配置倍增步骤。

调用：菜单 Visualization (可视化)，上下文菜单

要求：可视化处于活动状态并选择模板元素。

倍增可视化元素对话框

TwinCAT 添加更多与模板元素类似的元素。您可在此对话框中设置索引的数量和排列以及它们的替换。

基本设置选项卡

元素总数：

TwinCAT 将新元素作为表格插入。行数以水平方式设置，列数以垂直方式设置。两者的乘积决定了要插入元
素的实际总数。
水平 每行的元素数

预设：对应于 $FIRSTDIM$ 中的组件数
垂直 每列的元素数

预设：对应于 $SECONDDIM$ 中的组件数

元素之间的偏移量：

TwinCAT 将可视化中的元素排列为表格。如果您指定了一个偏移量，则在元素之间插入间距。
• 0：元素边框重叠一个像素
• 1：元素相互接触
• <n>：元素之间插入可见的 n-1 像素间距
水平 元素行间距的像素数
垂直 元素列间距的像素数

高级设置选项卡

第一层：

起始指数 $FIRSTDIM$ 的起始指数
预设：1 表示 $FIRSTDIM$ 的特定指数，从 1 开始。示例：阵列 [1,
<$SECONDDIM$>]

增量 指数的递增数
预设：1

第二层：
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起始指数 $SECONDDIM$ 的起始指数
预设：1 表示 $SECONDDIM$ 的特定指数，从 1 开始。示例：阵列
[<$FIRSTDIM$>, 1] 具有相关性

增量 指数的递增数
预设：1

5.19.32 命令：激活键盘

符号：

功能：此命令可在菜单栏中用于集成可视化 (诊断可视化)。该命令启用或禁用可视化在线模式中的键盘使用。

调用：菜单 Visualization (可视化)

如果启用键盘，可以通过特定的快捷方式输入和选择元素。在此情况下，只要可视化编辑器激活并在线，就不
会执行其他键盘命令。

5.20 其他

5.20.1 命令：实现界面
功能：此命令通过添加功能块当前未包含的界面元素来更新功能块的实现界面。

调用：在 PLC 项目树中选择功能块时的上下文菜单。

要求：该功能块使用您已更改的界面。例如您已将另一个方法添加到界面。

应用

执行此命令时，自动创建的方法或属性将被赋予一个编译指示属性，这将引发编译错误或警告。这提供了支
持，因为自动创建的元素不会意外保持为空。根据应用使用错误或警告属性。

案例 1：

情况：执行命令 Implement interfaces (实现界面) 的功能块并非源于其他功能块。

结果：执行命令时，界面元素在功能块中创建而无需实现 (“存根”) 并被赋予警告属性 (在方法/属性声明的第
一行)。编译期间生成的警告提醒您，这些元素是自动生成的，您需要添加所需的实现代码。
{warning 'add method/property implementation'}

步骤：将所需的实现代码添加到相应的界面元素 (方法或属性)。然后删除方法或属性声明中的警告属性。

案例 2：

情况：执行命令“Implement interfaces (实现界面)”的功能块源于其他功能块。在派生功能块中执行命令时
创建的元素 (方法或属性) 并非由基础功能块的继承提供 (也就是说，元素不在基础功能块或更高父类别之下)。

结果/步骤：见案例 1。

案例 3：

情况：执行命令 Implement interfaces (实现界面) 的功能块源于其他功能块。在派生功能块中执行命令时创
建的元素 (方法或属性) 已由基础功能块的继承提供 (也就是说，元素位于基础功能块或更高父类别之下)。

结果：执行命令时，界面元素在派生功能块中创建而无需实现 (“存根”) 并被赋予错误属性 (在方法/属性声明
的第一行)。编译期间生成的警告提醒您，这些元素是自动生成的，并且该方法或属性覆盖基本功能块的对应
元素。
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{error 'add method/property implementation or delete method/property to use base implementation'}

步骤：如果您希望覆盖或增强基本功能块的方法或属性，请将所需的实现代码添加到派生功能块下的元素中。
然后删除方法或属性声明中的错误属性。但是，如果您不想覆盖基本功能块的方法或属性，请删除派生功能块
下的方法或属性。在此情况下，使用基本功能块的方法或属性。

5.21 解决方案上下文菜单

5.21.1 命令构建解决方案

符号：

功能：此命令可启动解决方案中包含的所有项目的编译过程或代码生成。

调用：Build（构建）菜单或解决方案的上下文菜单

要求：选择解决方案。

解决方案中包含的所有项目依次进行编译。这也涉及到在 TwinCAT 项目下集成的项目（PLC、C++ 等）。在
命令构建 PLC 项目 [} 255] 部分中描述了针对 PLC 项目执行的步骤。

5.21.2 命令重建解决方案
功能：此命令可启动解决方案中包含的所有项目的编译过程，即使之前编译时没有错误也不例外。

调用：Build（构建）命令或解决方案的上下文菜单

要求：选择解决方案。

在重建解决方案时，首先要对其进行清除（另请参见：命令清除解决方案 [} 245]），然后再进行构建（另请
参见：命令构建解决方案 [} 245]）。

另请参见：
• 命令重建 PLC 项目 [} 255]

5.21.3 命令清除解决方案
功能：此命令可开始清除解决方案中包含的所有项目。

调用：Build（构建）菜单或解决方案的上下文菜单

要求：选择解决方案。

依次清除解决方案中包含的所有项目。这也涉及到在 TwinCAT 项目下集成的项目（PLC、C++ 等）。在 命令
清除 PLC 项目 [} 256] 部分中描述了针对 PLC 项目执行的步骤。

5.21.4 命令将 <solution name> 另存为存档……
功能：此命令可打开用于将文件另存为存档的标准对话框。解决方案可作为 *.tnzip 存档保存在目标路径下。

调用：File（文件）菜单，上下文菜单
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要求：在 Solution Explorer（解决方案资源管理器）中选择解决方案。

*.tnzip 的内容 *.tnzip 存档文件夹包含在解决方案中所包含的所有 TwinCAT 项目类型。
这些项目可以是 TwinCAT、TwinCAT HMI、Scope 或 Connectivity 项目。

打开命令 使用以下命令可以重新打开 tnzip 存档：
命令从存档中打开解决方案 [} 49]。

关于 PLC 项目的说明 如果解决方案包含 1 个或多个 PLC 项目，则在这些 PLC 项目的存档文件夹中存储
的文件和文件夹将取决于相关项目的 PLC 项目设置。
设置选项卡 [} 111]

5.21.5 命令：通过电子邮件发送...

符号：

功能：此命令启动系统中设置的电子邮件程序并打开一个新电子邮件，该邮件以所选项目的存档文件作为附
件。

调用：File (文件) 菜单，上下文菜单

5.22 上下文菜单 TwinCAT 项目

5.22.1 命令将 <TwinCAT project name> 另存为存档……

符号：

功能：此命令可打开用于将文件另存为存档的标准对话框。项目可作为 *.tszip 存档保存在目标路径下。

调用：File（文件）菜单，上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

*.tszip 的内容 *.tszip 存档文件夹包含要存档的 TwinCAT 项目。
打开命令 使用以下命令可以重新打开 tszip 存档：

命令项目/解决方案（打开项目/解决方案） [} 49]
关于 PLC 项目的说明 如果 TwinCAT 项目包含 1 个或多个 PLC 项目，则在这些 PLC 项目的存档文件夹

中存储的文件和文件夹将取决于相关项目的 PLC 项目设置。
设置选项卡 [} 111]

5.22.2 命令：通过电子邮件发送...

符号：

功能：此命令启动系统中设置的电子邮件程序并打开一个新电子邮件，该邮件以所选项目的存档文件作为附
件。

调用：File (文件) 菜单，上下文菜单
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5.22.3 命令自动将 <TwinCAT project names> 备份到目标系统
功能：此命令可用于启用或禁用在激活过程中将 TwinCAT 项目以 .tszip 格式自动存储到目标系统中。如果您
想要稍后使用命令 命令：从目标打开项目 [} 56] 从目标系统加载并打开项目，则必须这样做。

调用：TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

5.22.4 命令将 <TwinCAT project name> 与目标系统进行比较……
功能：此命令可以使用 TwinCAT 项目比较工具将所选的 TwinCAT 项目与目标系统上的项目状态进行比较。

调用：TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目，并选择已下载 TwinCAT 项目的
目标系统。

另请参见：
• 命令使用目标系统更新项目…… [} 247]

5.22.5 命令使用目标系统更新项目……
功能：此命令可以将所选的 TwinCAT 项目更新为连接的目标系统的项目状态。为此，系统会打开 1 个弹出对
话框，显示已更改的文件列表，您必须确认该对话框才能成功执行动作。此处不提供详细的比较。

调用：TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

另请参见：
• 命令将 <TwinCAT project name> 与目标系统进行比较…… [} 247]

5.22.6 命令使用 TwinCAT 2.xx 版本加载项目……
功能：此命令可打开标准浏览器对话框，通过该对话框可以选择并导入 TwinCAT 2 系统管理器文件。通过这
种方式，您可以将现有的 TwinCAT 2 项目（包括系统管理器设置和 PLC 项目）转换为 TwinCAT 3。

调用：TwinCAT 项目的上下文菜单

要求：TwinCAT 项目已新建且未进行任何更改，并在 Solution Explorer（解决方案资源管理器）中选中。

另请参见：
• --- FEHLENDER LINK ---

5.22.7 命令显示隐藏的配置
功能：此命令可打开 1 个详细菜单，其中列出了隐藏的配置，您可以再次显示它们。

调用：TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

5.22.8 命令从解决方案中删除

符号：
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功能：此命令可以从解决方案中删除 TwinCAT 项目。

调用：TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

5.22.9 命令重命名

符号：

功能：此命令可以在 Solution Explorer（解决方案资源管理器）中重命名 TwinCAT 项目。

调用：TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

5.22.10 命令构建 TwinCAT 项目

符号：

功能：此命令可启动当前活动的 TwinCAT 项目的编译过程或代码生成。

调用：如果当前选择的是 TwinCAT 项目，则调用 Build（构建）菜单，或 TwinCAT 项目的上下文菜单

要求：选择 TwinCAT 项目。

TwinCAT 项目中包含的所有项目（PLC、C++ 等）依次进行编译。在 命令构建 PLC 项目 [} 255] 部分中描述了
针对 PLC 项目执行的步骤。

另请参见：
• 命令重建 TwinCAT 项目 [} 248]

5.22.11 命令重建 TwinCAT 项目
功能：此命令可启动当前活动的 TwinCAT 项目的编译过程或代码生成，即使上次编译时没有错误也不例外。

调用：如果当前选择的是 TwinCAT 项目，则调用 Build（构建）菜单，或 TwinCAT 项目的上下文菜单

要求：选择 TwinCAT 项目。

在重建项目时，首先要对 TwinCAT 项目进行清除（另请参见：命令清除 TwinCAT 项目 [} 248]），然后再进
行构建（另请参见：命令构建 TwinCAT 项目 [} 248]）。

5.22.12 命令清除 TwinCAT 项目
功能：此命令可删除当前活动的 PLC 项目的本地编译信息，并更新所有对象的语言模型。

调用：如果当前选择的是 TwinCAT 项目，则调用 Build（构建）菜单，或 TwinCAT 项目的上下文菜单

要求：选择 TwinCAT 项目。

TwinCAT 项目中包含的所有项目（PLC、C++ 等）依次进行清除。在 命令清除 PLC 项目 [} 256] 部分中描述了
针对 PLC 项目执行的步骤。

另请参见：
• 命令重建 TwinCAT 项目 [} 248]



参照用户界面

TE1000 249版本： 2.15.0

5.22.13 命令卸载项目
功能：此命令可卸载 TwinCAT 项目，以便释放 TwinCAT 项目的所有文件。

调用：项目菜单或 TwinCAT 项目的上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

5.22.14 通过 AML DataExchange 导入 AutomationML……
功能：此命令可打开标准浏览器对话框，通过该对话框您可以搜索并导入 AutomationML 格式的文件。

调用：从 TwinCAT 项目的上下文菜单中的 Import AutomationML（导入 AutomationML）下或者从菜单栏
中的 TwinCAT 项目的 AutomationML 和 Import AutomationML（导入 AutomationML）下可以调用此命
令。

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

另请参见
• 命令：

5.22.15 导出 AutomationML……
功能：此命令可打开标准浏览器对话框，以 AutomationML 格式保存文件，用于导出 I/O 节点下的拓扑结
构。

调用：从 TwinCAT 项目的上下文菜单或者从菜单栏中的 TwinCAT 项目的 AutomationML 下可以调用此命
令。

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT 项目。

5.23 PLC 项目上下文菜单

5.23.1 命令：激活启动项目

符号：

功能：此命令生成或更新目标系统的启动项目。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

5.23.2 命令：自动运行启动项目
功能：此命令更改 PLC 项目中的选项 Autostart boot project（自动运行启动项目）。如果该选项先前处于
停用状态，则在执行该命令后将被激活。如果该选项先前处于激活状态，则在执行该命令后将被停用。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。
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5.23.3 命令：更改 ADS 端口
功能：您可以使用打开的对话框更改 PLC 运行时系统的 ADS 端口号。第一个 PLC 运行时系统的 ADS 端口的
默认设置为 851，第二个为 852，依此类推。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

如果 PLC 项目包含多个实例（请参见 命令：添加新项目（实例） [} 252]），则更改 ADS 端口的对话框将按照
项目实例的数量依次显示。使用第一个对话框设置第一个项目实例的 ADS 端口，使用第二个对话框设置第二
个项目实例的 ADS 端口，依此类推。

5.23.4 命令：安装项目库
功能： PLC 项目文件层级下的 _Libraries 文件夹中包含的库文件，会被安装到本地库的存储库中。随后，存
储库中包含的所有库均会被识别，并可在项目中使用。如果某个库在执行此命令前已存在于本地存储库中，则
该库将被重新安装。因此，在正常情况下，执行安装项目库（未知版本） [} 250]命令即可满足需求。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

背景信息：

_Libraries 文件夹包含在 PLC 项目中直接或间接引用的库。直接引用是指在库管理器中处于最高层级集成的
库。间接引用是指在另一库文件中被引用的库文件。

该文件夹的用途是：例如在项目存档时，将项目中使用的库文件一并存档（您可以在项目设置中配置是否应该
执行此操作，请参见 设置选项卡 [} 111]）。例如，您可以将项目存档分发给同事，如果项目使用的库在同事
的本地库存储库中不存在，则可以使用安装项目库命令 [} 250]或安装项目库（未知版本）命令 [} 250]来安装
缺失的库。

最近使用的库会在以下时间被添加至 _Libraries 文件夹：
• 在创建文件/电子邮件存档 [} 48]时，如果文件/电子邮件存档被配置为包含库（请参见 设置选项卡

[} 111]）。
• 在激活配置 [} 122]或激活启动项目 [} 249]时，如果目标存档被配置为包含库（请参见 设置选项卡

[} 111]）。
• 在执行更新项目库文件夹命令 [} 251]时。

不再使用的库会在以下时间从 _Libraries 文件夹中被删除：
• 在执行更新项目库文件夹命令 [} 251]时。

另请参见：
• 命令：安装项目库（未知版本） [} 250]
• 命令：更新项目库文件夹 [} 251]
• PLC 文档：使用库

5.23.5 命令：安装项目库（未知版本）
功能：将 PLC 项目文件层级的 _Libraries 文件夹中包含的库以及此前未存在于本地库存储库中的库安装到本
地库存储库中。随后，存储库中包含的所有库均会被识别，并可在项目中使用。如果某个库在执行此命令前已
存在于本地存储库中，则不会重新安装该库。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。
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背景信息：

_Libraries 文件夹包含在 PLC 项目中直接或间接引用的库。直接引用是指在库管理器中处于最高层级集成的
库。间接引用是指在另一库文件中被引用的库文件。

该文件夹的用途是：例如在项目存档时，将项目中使用的库文件一并存档（您可以在项目设置中配置是否应该
执行此操作，请参见 设置选项卡 [} 111]）。例如，您可以将项目存档分发给同事，如果项目使用的库在同事
的本地库存储库中不存在，则可以使用安装项目库命令 [} 250]或安装项目库（未知版本）命令 [} 250]来安装
缺失的库。

最近使用的库会在以下时间被添加至 _Libraries 文件夹：
• 在创建文件/电子邮件存档 [} 48]时，如果文件/电子邮件存档被配置为包含库（请参见 设置选项卡

[} 111]）。
• 在激活配置 [} 122]或激活启动项目 [} 249]时，如果目标存档被配置为包含库（请参见 设置选项卡

[} 111]）。
• 在执行更新项目库文件夹命令 [} 251]时。

不再使用的库会在以下时间从 _Libraries 文件夹中被删除：
• 在执行更新项目库文件夹命令 [} 251]时。

另请参见：
• 命令：安装项目库 [} 250]
• 命令：更新项目库文件夹 [} 251]
• PLC 文档：使用库

5.23.6 命令：更新项目库文件夹
功能：更新 PLC 项目文件层级的 _Libraries 文件夹。随后，该文件夹包含 PLC 项目中使用的所有库文件。先
前包含在 _Libaries 文件夹中但现在不再使用的库将从该文件夹中被删除。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

背景信息：

_Libraries 文件夹包含在 PLC 项目中直接或间接引用的库。直接引用是指在库管理器中处于最高层级集成的
库。间接引用是指在另一库文件中被引用的库文件。

该文件夹的用途是：例如在项目存档时，将项目中使用的库文件一并存档（您可以在项目设置中配置是否应该
执行此操作，请参见 设置选项卡 [} 111]）。例如，您可以将项目存档分发给同事，如果项目使用的库在同事
的本地库存储库中不存在，则可以使用安装项目库命令 [} 250]或安装项目库（未知版本）命令 [} 250]来安装
缺失的库。

最近使用的库会在以下时间被添加至 _Libraries 文件夹：
• 在创建文件/电子邮件存档 [} 48]时，如果文件/电子邮件存档被配置为包含库（请参见 设置选项卡

[} 111]）。
• 在激活配置 [} 122]或激活启动项目 [} 249]时，如果目标存档被配置为包含库（请参见 设置选项卡

[} 111]）。
• 在执行更新项目库文件夹命令 [} 251]时。

不再使用的库会在以下时间从 _Libraries 文件夹中被删除：
• 在执行更新项目库文件夹命令 [} 251]时。

另请参见：
• 命令：安装项目库 [} 250]
• 命令：安装项目库（未知版本） [} 250]
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• PLC 文档：使用库

5.23.7 命令：更改项目
功能：此命令打开标准浏览器对话框，通过该对话框您可以搜索并选择 PLC 项目文件。当前选定的 PLC 项目
随后将被新选定的 PLC 项目取代。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

5.23.8 命令：添加新项目（实例）
功能：此命令可用于在选定的 PLC 项目中添加另一个实例（过程映像）（即“多个 PLC 实例”）。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

此机制可用于实例化 PLC 项目，从而为每个 PLC 运行时系统生成一个项目实例。可为每个项目实例分配单独
的 ADS 端口号（请参见 命令：更改 ADS 端口 [} 250]）。此外，每个项目实例在过程映像中均有各自的链
接。

每个项目实例均有自己的联机模式，例如，每个项目实例均可单独登录和启动。
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5.23.9 命令将 <PLC project name> 另存为存档……
功能：此命令可打开用于将文件另存为存档的标准对话框。PLC 项目可作为 *.tpzip 存档保存在目标路径下。

调用：File（文件）菜单，上下文菜单

要求：在 Solution Explorer（解决方案资源管理器）中选择 TwinCAT PLC 项目（<PLC project name>）。

存档文件夹中的文件和文件夹取决于 PLC 项目设置。

*.tpzip 的内容 *.tpzip 存档文件夹包含要存档的 PLC 项目。
打开命令 使用以下命令可以重新打开 tpzip 存档：

命令添加现有项目（项目） [} 84]
关于 PLC 项目的说明 在 PLC 项目的存档文件夹中存储的文件和文件夹取决于该 PLC 项目的 PLC 项目

设置。
设置选项卡 [} 111]

5.23.10 命令：通过电子邮件发送...

符号：

功能：此命令启动系统中设置的电子邮件程序并打开一个新电子邮件，该邮件以所选项目的存档文件作为附
件。

调用：File (文件) 菜单，上下文菜单

5.23.11 命令：使用目标系统更新项目…
功能：此命令可以将所选的 TwinCAT 项目更新为连接的目标系统的项目状态。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：已在解决方案资源管理器中选择 PLC 项目，且PLC 项目的源文件位于已连接的目标系统中。

5.23.12 命令：独立的项目文件
功能：将 PLC 项目显式保存在一个单独的（*.XTI）文件中。例如，这样一来PLC 项目的链接等信息将不再保
存在 TwinCAT 项目文件中，而是保存在该 PLC 项目的 XTI 文件中。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。

5.23.13 命令：停用
功能：该 PLC 项目被停用 ，例如在构建 TwinCAT 项目时会被忽略。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目的上下文菜单

要求：选择 PLC 项目。
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5.24 上下文菜单 PLC 项目对象（<PLC project name> 项目）

5.24.1 命令登录

符号：

功能：此命令可将编程系统（所选 PLC 项目）与目标系统（控制器）连接，从而建立在线操作。在目标系统
上创建 PLC 项目的实例并加载。

调用：PLC 菜单或 TwinCAT PLC toolbar options（TwinCAT PLC 工具栏选项）或 Solution Explorer（解
决方案资源管理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

要求：PLC 项目无错误，目标系统处于运行模式。

可能的登录情况：
• 控制器尚不存在 PLC 项目：系统将提示您确认下载。
• PLC 项目已在控制器上，且自上次下载后未更改。无需进一步互动即可登录。
• PLC 项目已在控制器上，但自上次下载后已更改。

系统将提示您选择以下选项之一：
◦ 在线更改后登录（请参见“命令在线更改 [} 141]”部分中的说明）
◦ 下载后登录
◦ 无更改登录

此时，您还可以更新控制器上的启动项目。
• 控制器上已存在未知版本的 PLC 项目。系统将询问您 TwinCAT 是否应该替换它。
• PLC 项目的 1 个版本已在控制器上运行。系统将询问您 TwinCAT 是否应该登录并覆盖当前正在运行的

PLC 程序。
• 控制器上的 PLC 程序当前停止在断点处。您已退出并更改程序：TwinCAT 警告您，如果在线更改或下

载，PLC 将完全停止。即使有多个任务并且只有其中 1 个受断点影响，也会发生这种情况。

登录前编译项目

如果 PLC 项目自上次更改后尚未编译，则 TwinCAT 会在登录前编译项目。此操作对应于命令 Compile in
logged-out state (在注销状态下编译)。

如果在编译时发生错误，则会显示一个消息对话框。错误显示在 Error List (错误列表) 视图中。然后，您可以
决定是否希望在不将程序加载到控制器的情况下登录。

另请参见：
• 命令构建 PLC 项目 [} 255]

登录时出错

如果在登录控制器时发生错误，TwinCAT 将中断加载过程并显示错误消息。错误对话框可以显示错误详情。
如果发生异常错误并且日志消息中包含文本 *SOURCEPOSITION*，则可以使用命令“在编辑器中显示”以在
编辑器中显示相关功能。光标跳转至导致错误的行。

输出关于加载过程的信息

如果 TwinCAT 在登录时将项目加载到控制器上，则消息窗口中将显示以下信息：
• 生成代码的大小
• 全局数据的大小
• 控制器上的存储器要求
• 受影响的功能块列表 (用于在线更改)
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在在线模式下，无法更改设备或模块的设置。如要更改设备参数，必须退出 PLC 项目。但是，根据
总线系统，可能存在一些可以在在线模式下更改的特殊参数。

TwinCAT 分别针对在线和脱机模式存储视图配置。此外，关闭无法在操作模式下使用的视图。为
此，登录时视图可能会自动更改。

5.24.2 命令构建 PLC 项目

符号：

功能：此命令可启动当前活动的 PLC 项目的编译过程或代码生成。

调用：如果当前选择的是 PLC 项目，则调用 Build（构建）菜单，或者 Solution Explorer（解决方案资源管
理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

要求：选择 PLC 项目。

在编译期间，TwinCAT 对 PLC 项目中所用的所有对象执行语法测试。当您想要用更改后的程序记录项目时，
始终自动执行编译程序。检查完成后，TwinCAT 会在 Error List [} 81]（错误列表）视图中显示任何错误消息
或警告。

此外，在构建项目时会创建 PLC 项目的编译信息，并将其保存在解决方案中的本地文件（*.compileinfo）
中。

如果自上次无错编译过程后程序未更改，则不会重新编译。如果无论如何都要执行语法测试，请使用 命令重
建 PLC 项目 [} 255]。

5.24.3 命令重建 PLC 项目
功能：此命令可启动当前活动的 PLC 项目的编译过程或代码生成，即使上次编译时没有错误也不例外。

调用：如果当前选择的是 PLC 项目，则调用 Build（构建）菜单，或者 Solution Explorer（解决方案资源管
理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

要求：选择 PLC 项目。

在重建项目时，首先要对项目进行清除（另请参见：命令清除 PLC 项目 [} 256]），然后再进行构建（另请参
见：命令构建 PLC 项目 [} 255]）。

5.24.4 命令检查所有对象
功能：此命令可启动编译运行，即对 PLC 项目的项目树中的所有对象进行语法检查。这在创建库或处理库项
目时非常有用。

调用：Solution Explorer（解决方案资源管理器）中的 PLC 项目对象（<PLC project name> 项目）的上下
文菜单

与只检查所用对象的 命令构建 PLC 项目 [} 255] 不同，在执行该命令时，将会检查 PLC 项目中所有对象的语
法。

该命令不会导致代码生成。在项目目录中未创建包含编译运行信息的文件。
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5.24.5 命令清除 PLC 项目
功能：此命令可更新当前活动的 PLC 项目中的所有对象的语言模型。

调用：如果当前选择的是 PLC 项目，则调用 Build（构建）菜单，或者 Solution Explorer（解决方案资源管
理器）中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

前提条件：选择 PLC 项目。

如果清除 PLC 项目，则只更新 PLC 项目中的所有对象的语言模型。目标系统上的编译信息将会保留。

另请参见：
• 命令重建 PLC 项目 [} 255]

5.24.6 添加

5.24.6.1 命令：添加新项目（对象）

功能：此命令打开一个对象子菜单，菜单中会根据 PLC 项目树中当前的位置，显示所有可插入的对象。

调用：PLC 项目对象（<PLC Project name> 项目）的上下文菜单，或 Solution Explorer（解决方案资源管
理器）中 PLC 项目内已有对象或文件夹的上下文菜单

要求：如果 TwinCAT 要在 PLC 项目树中插入对象，请先选中一个现有对象或文件夹，新对象会创建在它的下
一层级。

另请参见：
• PLC 文档：添加对象
• PLC 文档：创建并配置项目

5.24.6.2 命令：添加现有项目（对象）

符号：
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功能：此命令打开标准浏览器对话框，通过该对话框您可以搜索文件并将其添加至所选的 PLC 项目。

调用：上下文菜单 PLC 项目对象（<PLC Project name> 项目）或 Solution Explorer（解决方案资源管理
器）中的现有 PLC 文件夹的上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 项目对象或 PLC 项目中的文件夹。

5.24.6.3 命令：新建文件夹

符号：

功能：此命令将一个新文件夹插入到 PLC 项目中。

调用：PLC 项目对象（<PLC Project name> 项目）的上下文菜单或 Solution Explorer > Add（解决方案资
源管理器 > 添加）中 PLC 项目内已有对象或文件夹的上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 项目对象或 PLC 项目中的文件夹。

该命令会在项目树中当前所选对象的下方插入文件夹。

另请参见：
• PLC 文档：添加对象

5.24.6.4 命令：添加现有文件夹内容

功能：此命令打开标准浏览器对话框，通过该对话框您可以在文件层级搜索并选择文件夹。该文件夹的内容将
被添加到选定的 PLC 项目中。

调用：上下文菜单 PLC 项目对象（<PLC Project name> 项目）或 Solution Explorer（解决方案资源管理
器）中的现有 PLC 文件夹的上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 项目对象或 PLC 项目中的文件夹。

5.24.7 命令：导出至 ZIP
功能：此命令打开用于以 ZIP 格式保存所选对象的标准对话框。

调用：PLC 项目对象（<PLC Project name> 项目）的上下文菜单，或 Solution Explorer（解决方案资源管
理器）中 PLC 项目内已有文件夹的上下文菜单

要求：选择 PLC 项目对象（<PLC project name> 项目）或 PLC 对象。

另请参见：
• 命令：从 ZIP 导入 [} 257]
• PLC 文档：导出和导入一个 PLC 项目

5.24.8 命令：从 ZIP 导入
功能：此命令打开用于从 ZIP 文件中导入对象的标准对话框。

调用：PLC 项目对象（<PLC Project name> 项目）的上下文菜单，或 Solution Explorer（解决方案资源管
理器）中 PLC 项目内已有文件夹的上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 项目对象或 PLC 项目中的文件夹。

另请参见：
• 命令：导出至 ZIP [} 257]

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2526208651.html
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• PLC 文档：导出和导入一个 PLC 项目

5.24.9 命令：导出 PLCopenXML

符号：

功能：此命令打开一个用于将项目对象以 PLCopen 格式导出至 XML 文件的对话框。

调用：PLC 项目对象（<PLC Project name> 项目）的上下文菜单，或 Solution Explorer（解决方案资源管
理器）中 PLC 项目内已有文件夹的上下文菜单

要求：选择 PLC 项目对象（<PLC project name> 项目）或 PLC 对象。

另请参见：
• 命令：导入 PLCopenXML [} 258]
• PLC 文档：导出和导入一个 PLC 项目

5.24.10 命令：导入 PLCopenXML

符号：

功能：此命令打开一个用于将 XML 文件中的对象以 PLCopen 格式导入的对话框。

调用：PLC 项目对象（<PLC Project name> 项目）的上下文菜单，或 Solution Explorer（解决方案资源管
理器）中 PLC 项目中已有文件夹的上下文菜单

要求：在 TwinCAT 项目树中选择 PLC 项目对象或 PLC 项目中的文件夹。

导入 PLCopenXML 对话框

该对话框列出了此时 TwinCAT 可以导入的 PLCopen 导出文件中的所有对象。

当前选中的目标对象 在项目树中选中的对象。
可插入的条目 显示导出文件中 TwinCAT 可在所选对象下方插入的所有对象。
冲突解决 如果导入了与现有对象同名的对象，则可按以下方式为每个对象解决冲突：

• 替换现有对象：项目中的现有对象将被导入的对象覆盖。
• 重命名新对象：新对象将以不同的名称导入。在名称后附加 _<No>。
• 跳过新对象：该对象不会被导入。

选择 打开选择列表，可选择对象类型。
取消选择 打开选择列表，可取消选择对象类型。

另请参见：
• 命令：导出 PLCopenXML [} 258]
• 导出和导入 PLC 项目

5.24.11 命令另存为库
功能：该命令可打开用于将 PLC 项目另存为 PLC 库的标准对话框。

调用：解决方案资源管理器中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

可将 PLC 项目另存为 PLC 库，以便将源代码作为库并通过定义的接口提供给其他应用程序。在 PLC 项目的上
下文菜单中，可使用保存库的命令。

https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2526208651.html
https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2526208651.html
https://infosys.beckhoff.com/content/1033/tc3_plc_intro/2526208651.html
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该命令会打开用于在文件系统中保存文件的标准对话框。现有项目名称已自动提供；用户可以根据需要对其进
行修改。在将项目另存为库时，可在 2 种库文件格式中做出选择：

• *.library（源库）
◦ 在项目树中的 PLC 节点上，您可以使用 Add Existing Item（添加现有项目）命令来打开源库（用

于查看和/或编辑）。
◦ 您可以使用常用的调试功能“进入”源库。

• *.compiled-library（编译库）
◦ 该文件扩展名可用于以编译格式保存库项目。库的预编译上下文的加密图像被存储起来，这意味着

库功能块的实现不再可访问或可见。
◦ 无法打开或调试编译库。
◦ 除此之外，*.compiled-library 文件的行为与 *.library 文件类似。因此，您可以以同样的方式安装

和引用它们。
◦ 使用编译库格式可以保护库的源代码。此外，库文件更小，加载时间更短。

代码无法逐步运行
常见的调试功能无法应用于编译库（*.compiled-library）。因此，无法通过调试跳转到
*.compiled-library 的库块。
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5.24.12 命令另存为库并安装
功能：该命令可打开用于将 PLC 项目另存为 PLC 库的标准对话框。此外，该命令还会在库存储库中安装已存
储的库。因此，通过库管理器可以直接将库插入项目中。

调用：解决方案资源管理器中 PLC 项目对象（<PLC project name> 项目）的上下文菜单

该命令可将 PLC 项目另存为 PLC 库，并在 库存储库 中安装它。在 PLC 项目的上下文菜单中，可使用保存并
安装库的命令。
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库的安装与保存是同时进行的，是 命令另存为库 [} 258] 的扩展，因为同时会在本地系统上安装库。然后，通
过库管理器可以立即将库添加到项目中。

5.24.13 命令：另存为 PLC 项目模板

TwinCAT 3.1 Build 4026 及以上版本可用

功能：此命令可打开用于将 PLC 项目另存为 PLC 项目模板的对话框。

调用：解决方案资源管理器中的 PLC 项目对象（<PLC project name> 项目）的上下文菜单

在对话框 Add New Item（添加新项目）中添加 PLC 项目时，可以选择 PLC 项目模板，这些模板是新项目的
起始基础。在 PLC 项目模板中，可以定义项目的结构并插入可重复使用的代码。您还可以为所有通过该模板
创建的项目统一设置 PLC 项目属性。

另存为 PLC 项目模板命令可打开用于导出 PLC 项目模板的对话框：

模板名称 项目模板名称
模板描述 项目模板的描述（可选）
图标图像 项目模板的图标图像（可选）
模板类别 项目模板在 Add New Item（添加新项目）对话框中显示的类别（可

选）。
输出位置 保存项目模板的路径（不可更改）。
自动将模板导入 Visual Studio ：项目模板被导入 Visual Studio 中并在 Add New Item（添加新项

目）对话框中显示。
在输出文件文件夹上显示资源管理
器窗口 ：打开输出位置的资源管理器窗口，并显示已创建项目模板。

在关闭导出对话框时，项目模板将以 ZIP 文件的形式保存在“输出位置”下指定的路径中（Visual Studio 默
认项目目录中的“我的导出模板”文件夹）。从那里可以复制 ZIP 文件并将其传输到其他系统。

导入 Visual Studio 的项目模板可以在 Visual Studio 默认项目目录中的“模板”文件夹中找到。如要删除已导
入的项目模板，您必须从“模板”文件夹中删除该模板，然后重新启动 Visual Studio。

在添加新 PLC 项目时，导入的项目模板会显示在导出时指定的项目模板类别下方：
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新项目将根据所选项目模板进行创建。

5.24.14 命令属性（PLC 项目）

符号：

功能：此命令可打开 1 个编辑器窗口，其中显示和定义项目的属性以及其他与项目相关的信息。

调用：PLC 项目对象（<PLC project name> 项目）的上下文菜单或 Project（项目）菜单

要求：打开 1 个项目。

TwinCAT 将 PLC 项目属性直接存储在 PLC 项目中。

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

另请参见：
• PLC 文档：--- FEHLENDER LINK ---

5.24.14.1 类别：通用

类别 Common（通用）包含项目文件的一般信息和元信息。TwinCAT 使用此信息创建 Properties（属性）
选项卡中的密钥。例如，如果 Company（公司）文本字段包含名称“Company_A”，Properties（属性）
选项卡包含值为“Company_A”的 Company（公司）密钥。

项目信息
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对于库项目，必须输入公司、标题和版本才能安装库。
公司 创建该项目（应用程序或库）的公司的名称。除了库类别之外，它还被用于库的存

储排序
标题 项目标题
版本 项目版本，例如“0.0.0.1”
已发布 ：启用修改保护。

后果：当您现在编辑项目时，将出现 1 个提示询问您是否想要更改项目。如果您的
回答是 Yes（是），则当再次编辑项目时，提示将不再出现。

库类别 您可在库的存储库对话框中进行库项目类别的排序。如果未指定类别，则库会被分
配到类别“Other”（其他）。如要将库分配到其他类别，则必须定义该类别。
在 1 个或多个 XML 格式的外部描述文件中定义库类别。如要分配库，您可以调用
此类文件或调用另一个已经从描述文件中获取类别信息的库文件。
要求：该项目是 1 个库项目。
Library Categories（库类别）对话框打开，您可在该对话框中添加库类别。

默认命名空间 库的命名空间的默认设置为库标题。或者，可显式定义不同命名空间，通常在库生
成期间在项目信息中为库定义，或者在库引用的 Properties（属性）对话框中进
行定义，以便在项目中本地使用库。
库的命名空间必须用作标识符的前缀，以便在项目中能够多次明确访问存在的模
块，或者库属性强制使用此前缀：LanguageModelAttribute“qualified-access-
only”（“对库模块或变量的明确访问”）。
如果您在此处没有定义标准命名空间，则库文件的名称将自动用作命名空间。

占位符 此时，可以指定占位符的默认名称，该名称代表或引用此库。如果此时未明确指定
占位符，则库占位符名称的默认设置将与库标题相对应。

作者 项目作者
描述 项目的简要描述（例如，内容、功能、一般信息，例如“仅供内部使用”等）

库特性
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创建全局版本结构 ：在 PLC 项目中创建全局变量列表，其中包含版本信息。全局变量列表会在保
存过程中进行更新。

自动生成库信息 POU ：在项目树中自动创建“函数”类型的 POU 对象，它们可用于访问应用程序中
的项目属性。在这种情况下，将为属性 Company（公司）、Title（标题）和
Version（版本）生成特殊函数（F_GetCompany、F_GetTitle、
F_GetVersion）。函数会在保存过程中进行更新。

文档格式 选项：
• TwinCAT 3.1 Build 4024 及以下版本：reStructuredText
• TwinCAT 3.1 Build 4026 及以上版本：TcDocGen
在库创建期间，对应于特殊格式的注释在此自定义视图中重新构建，并在库管理器
的 Documentation（文档）选项卡中显示。这会打开库文档的更多选项。

允许对已编译的库进行隐
式检查

TwinCAT 3.1 Build 4026 及以上版本可用

：TwinCAT 也会对受保护库（*.compiled-libraries）中的功能块执行隐式检
查。
要求：在 PLC project properties（PLC 项目属性）中的 Compiler definitions
（编译器定义）字段（类别 Compile（编译））中输入编译器定义
“checks_in_libs”。
另请参见：使用功能块进行隐式检查

强制对库访问进行
Qualified_only

TwinCAT 3.1 Build 4026 及以上版本可用

：该库中的对象只能与该库的命名空间规范一起使用。
另请参见：属性“qualified_only”

允许作为库引用 TwinCAT 3.1 Build 4026 及以上版本可用

：你可以将一个PLC项目作为库文件，引用到另一个PLC项目中。
另请参见：使用 PLC 项目作为引用库

库类别对话框

类别列表 分配至库项目的类别列表。类别列表可以源于多个来源。输入所有需要的类别后，
通过 OK (确定) 确认对话框。

添加 显示命令 From Description File...(从描述文件...) 和 From Other Library...(从
其他库...)。

删除 TwinCAT 删除所选类别。
从描述文件... Select Description File (选择描述文件) 对话框出现，可在其中选择扩展名为

*.libcat.xml 的描述文件。文件包含命令类别。通过 Open (打开) 退出对话框后，
TwinCAT 将应用这些类别。

从其他库... Select Library (选择库) 对话框出现，可在其中选择待采用命令类别的库
(*.library)。通过 Open (打开) 退出对话框后，TwinCAT 将应用这些类别。

确认 TwinCAT 提供类别作为项目信息，并在 Library Categories (库类别) 字段中显
示。

取消 关闭对话框。过程中止。
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另请参见：
• PLC 文档：
• PLC 文档：使用库

5.24.14.2 类别编译

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

类别“Compile”（编译）用于配置编译器选项。

设置
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编译器定义 您可以在此处输入编译器定义/“定义”（请参见 {define} 语句）和编译应用程序
的条件（条件编译）。
有关可用条件编译指示的说明，请参见“条件编译指示”部分。在此处也可以输入
此类编译指示中所用的表达式 expr。可以通过逗号分隔列表的形式输入若干条目。

系统编译器定义 TwinCAT 3.1 Build 4024 及以上版本可用
在PLC项目中编译器定义 [} 109]已经在系统管理器的设置中进行了配置。这些配置
会自动应用到当前的项目中，无需再次手动设置。

下载应用程序信息 TwinCAT 3.1 Build 4024 及以上版本可用
情景：您正在向控制器加载 1 个 PLC 项目，该项目与控制器中已存在的项目不同。
在这种情况下，会出现 1 个包含“Details”（详细信息）按钮的消息窗口。使用
此按钮可打开“Application information”（应用程序信息）窗口，您可以通过
该窗口查看当前 PLC 项目与控制器上的 PLC 项目之间的区别。其中包括比较功能
块的数量、数据和存储位置。
“Application information”（应用程序信息）窗口包含对各项区别的简要描
述，例如：
• MAIN 声明已更改
• 在 MAIN 中已插入变量 fbMyNewInstance
• FB_Sample 的方法/动作的数量已更改

（默认）：如果启用此设置，则会将 PLC 项目内容的相关信息加载到 PLC 上。
这使得可以对当前PLC项目和控制器上的PLC项目进行扩展检查。扩展检查选项的
不同之处在于，“Application information”（应用程序信息）窗口包含 1 个附
加的“Online comparison”（在线比较）选项卡，该选项卡会显示树形比较视
图。该视图会告知您哪些 POU 已更改、删除或添加。当您执行“Application
information”（应用程序信息）窗口下部区域中的蓝色下划线命令时，就会显示
该附加选项卡（“应用程序并非最新版本。立即生成代码以显示在线比较？”）。

生成 tpy 文件 TwinCAT 3.1 Build 4024 及以上版本可用
tpy 文件包含项目、路由、编译器和目标系统信息等。它是对 TwinCAT 2 PLC 项目
进行说明时所使用的格式。为了确保与现有应用程序兼容，如有需要，可为
TwinCAT 3 PLC 项目创建此文件。

（默认）：在创建 PLC 项目时，不会创建与该项目相关的 tpy 文件。

：在创建 PLC 项目时，会创建与该项目相关的 tpy 文件，并将其存储在项目文
件夹中。

请注意，该选项的值和配置可用性取决于是否将 TPY 文件配置为目标文件（请参见
“设置选项卡 [} 111]”）。
• 如果启用 TPY 文件作为目标文件，则会发生以下情况：

◦ TwinCAT 会记住“Generate tpy file”（生成 tpy 文件）选项的当前状态（=
“原始值”，见下文。）。

◦ 如果未发生这种情况，则会在下一次创建项目时自动激活“Generate tpy
file”（生成 tpy 文件）选项。

◦ 此外，“Generate tpy file”（生成 tpy 文件）选项还会显示为灰色，因此，
只要将 TPY 文件配置为目标文件，用户就无法禁用该选项。

• 如果随后禁用 TPY 文件作为目标文件，则会发生以下情况：
◦ 下次创建项目时，将为“Generate tpy file”（生成 tpy 文件）选项分配其

“原始值”（见上文）。
◦ 此外，该选项不再显示为灰色，用户可以再次进行配置。



参照用户界面

TE1000 267版本： 2.15.0

在 TMC 文件中添加声明
的初始化值

TwinCAT 3.1 Build 4026.12 及以上版本可用

（默认）：将声明的初始化值保存在 TMC 文件中。例如，如果其他应用程序需
要初始化值，可使用此选项。

：声明的初始化值不保存在 TMC 文件中。这样可以减少 TMC 文件的大小并缩
短编译时间，尤其是当 PLC 项目中的声明包含大量初始化值时。
示例：
VAR
    aSample : ARRAY[1..10] OF INT := [2, 38, 5, 9, 74, 62, 87, 3, 16, 4];
END_VAR

在 TMC 文件中添加 POU
和 DUT 声明的相关注释

TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：将 POU 和 DUT 声明上方的注释与数据类型一起存储在 TMC 文件
中。例如，如果其他应用程序需要注释，可使用此选项。

：POU 和 DUT 声明上方的注释不存储在 TMC 文件中。这样可以减少 TMC 文
件的大小并缩短编译时间，尤其是当注释中包含对 POU 和 DUT 的详细描述时。
Sample：
// This function block represents an axis
FUNCTION_BLOCK FB_Axis
…

解决方案选项

编译器版本 定义了 TwinCAT 在编译期间和编译加载期间使用的编译器版本。
请注意，该设置不会替代远程管理器。
如果 PLC 项目是应用程序项目，在处理不同版本时，应始终使用远程管理器。
在使用远程管理工具的情况下，编译器的版本应该设置为最新的版本。
编译器版本设置只有当你的PLC项目是一个库项目并且需要管理不同版本时才适
用。
建议将库保存为最终要使用的最旧版本。为此，必须将编译器版本设置为相应的固
定版本（例如，“3.1.4018.0”）。

最大警告数 指的是 TwinCAT 在“Error List”（错误列表）视图中发布的警告的最大数量。
在“Project Settings”（项目设置）对话框的类别“Compiler warnings”（编
译器警告）中定义所显示编译器警告的选择。

替换常量 ：TwinCAT 会直接加载每个标量类型常量的值，也就是说，不包括 STRING、
ARRAY 或结构的值。在在线模式下，TwinCAT 可在声明编辑器或监控窗口中用一
个符号标识这些常量的值。在这种情况下，无法通过 ADR 运算符进行访问（例
如，强制或写入这些常量的值）。

（默认）：可以访问常量。计算时间略有增加。

另请参见：
• 类别：编译器警告 [} 273]

5.24.14.3 授权类别

保留以供将来使用！
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注意：用户目前必须始终在库代码中查询自己库的 OEM 授权。请参见在 PLC 应用程序中的查询 OEM 授权。

5.24.14.4 类别：统计

Statistic (统计) 类别提供关于项目中存在多少不同类型对象的统计信息。

5.24.14.5 类别：SFC

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

SFC 类别用于配置 SFC 对象的设置。每个新 SFC 对象在其属性中自动具有已配置的设置。
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标签选项卡

隐式生成变量 (标志)，用于控制和监控 SFC 图中的流程。
使用

：使用相应变量。
声明

：自动创建相应变量。否则，如果计划使用 (设置使用)，则用户必须声明变
量。

自动声明的标志变量出现在 SFC 编辑器的声明部分中，但仅在在线模式下适用。

构建选项卡

代码生成

仅计算活动转换
：TwinCAT 仅为当前活动的转换生成代码。

另请参见：
• --- FEHLENDER LINK ---
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5.24.14.6 类别：可视化

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

Visualization (可视化) 类别用于为可视化类型的对象配置项目范围的设置。

常规选项卡

可视化目录

文本列表文件 目录，包含项目中可用于配置不同语言文本的文本列表。例如，在导出或导入文本
列表时，TwinCAT 使用此目录。

点击  打开 Find Folder (查找文件夹) 对话框，可通过此对话框选择文件系统中
的目录。

图像文件 目录，包含项目中可用的图像文件。多个文件夹以分号分隔。例如，TwinCAT 在
导出或导入图像文件时使用此目录。

点击  打开 Find Folder (查找文件夹) 对话框，可通过此对话框选择文件系统中
的目录。

扩展设置
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在所有元素属性中启用属
性处理 ：还可以在其属性中配置可视化元素，其中可以选择具有  属性的 IEC 变

量。然后，TwinCAT 在编译可视化时生成用于属性处理的附加代码。

要求：IEC 代码至少包含一个类型接口属性的对象，即属性 。

要求：Visible (可见) 启用。

5.24.14.7 类别：可视化配置文件

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

通过 Visualization Profile (可视化配置文件) 类别，可以设置可视化配置文件。

可视化配置文件

特定配置文件 TwinCAT 在项目中使用的配置文件，确定项目中可用的可视化元素。
选择列表包含所有之前安装的配置文件。

5.24.14.8 类别静态分析

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。



参照用户界面

TE1000272 版本： 2.15.0

类别 Static analysis（静态分析）定义了在静态代码分析中考虑的检查。

轻量静态分析：
• 如果您尚未激活附加的 TE1200 工程授权，则您可以使用免授权版本的静态分析（轻量静态分析），其

中包含一些编码规则。免费的轻量版本使您能够熟悉产品的基本操作，例如，基于 1 套精简的功能。
• 有关轻量静态分析的更多信息，请参见：

PLC 文档：对 PLC 项目进行编程 > 检查语法和分析代码 > --- FEHLENDER LINK ---

全量静态分析：
• 如果启用了额外的 TE1200 工程授权，则可使用全量静态分析功能（保存和加载设置、100 多条编码规

则、命名规范、度量、禁止符号）。
• 有关全量静态分析的更多信息，请参见：

TE1200 静态分析。

5.24.14.9 类别：部署

Deployment (部署) 类别用于设置在安装和启动应用时执行的命令。

以下事件可用，之后可以调用列表中列出的命令：

启用配置 启用配置后，将调用所需命令。
Plc 下载 将 PLC 应用下载到目标系统后，将调用所需命令。
Plc 在线更改 在线更改成功后，将调用所需命令。
Plc 编译后 编译 PLC 应用后，将调用所需命令。

可以执行以下命令：

复制 将参数 1 (源路径) 中的文件复制到参数 2 (目标路径) 中指定的位置。
执行 执行参数 1 下列出的应用或脚本。

源路径和目标路径可能包含虚拟环境变量，而 TwinCAT 会相应地进行解析。

支持以下环境变量：
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虚拟环境变量 注册表值 默认值
%TC_INSTALLPATH% InstallDir C:\TwinCAT\3.x \
%TC_TARGETPATH% TargetDir C:\TwinCAT\3.x \Target\
%TC_BOOTPRJPATH% BootDir C:\TwinCAT\3.x \Boot\
%TC_RESOURCEPATH% ResourceDir C:\TwinCAT\3.x

\Target\Resource\
%SOLUTIONPATH% - 解决方案文件的位置

注册表值存储在注册表中的以下项下：\HKLM\Software\Beckhoff\TwinCAT3。

示例：

在以下示例中，文件 SampleFile.xml 从解决方案的配置项目子文件夹复制到目标系统的文件夹 C:\plc\config
中。

5.24.14.10 类别：编译器警告

Compiler Warnings (编译器警告) 类别用于选择编译运行期间 TwinCAT 在消息窗口中显示的编译器警告。

可以在 Compile (编译) 类别中指定所列出的最大警告数。

另请参见：
• 命令构建 PLC 项目 [} 255]
• 类别编译 [} 265]
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5.24.14.11 类别 UML

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

在类别 UML 中，您可以更改 UML 编译器版本。此设置仅在使用 UML 状态图时相关。

有关配置选项的更多信息，请参见 TF1910 TC3 UML 文档的“UML 编译器版本”部分。

5.24.14.12 高级类别

PLC 项目属性范围
注意：不同项目属性之间的范围不同！
一些属性仅影响您当前配置属性的 PLC 项目。
另一方面，其他属性影响开发环境中的所有 PLC 项目。您可在 PLC 项目的项目属性中更改这些属
性，但这些属性也会影响所有其它 PLC 项目，并且标题为 Solution options (解决方案选项)。

类别“Advanced”（高级）用于配置高级属性。

写入选项

文件版本 1.2.0.0（或更高）与 TwinCAT 3.1 < Build 4024 在工程上不兼容
请注意，不能将以文件版本 1.2.0.0（或更高）保存的对象加载到低于 TwinCAT 3.1.4024 的开发环境
版本中！
由于在使用可选的 Base64 格式时，对象会自动以文件版本 1.2.0.0 保存，因此无法使用低于
TwinCAT 3.1.4024 的开发环境版本加载 Base64 格式的对象。
如果 1 个 PLC 项目包含文件版本为 1.1.0.1 的对象和文件版本为 1.2.0.0 的对象，则 1.1.0.1 对象将以
低于 TwinCAT 3.1.4024 的开发环境版本加载。未加载文件版本为 1.2.0.0 的对象。
使用 XAE 版本 TwinCAT 3.1.4024 或更高版本，可以将以文件版本 1.2.0.0 保存的文件的文件版本重
置为 1.1.0.1。



参照用户界面

TE1000 275版本： 2.15.0

将对象内容写为
（“Write object
content as”）

TwinCAT 3.1 Build 4024 及以上版本可用
背景信息：
从 Build 4024 版本开始，Base64 引入了 1 种新的存储格式，下列 PLC 对象可选
择使用该存储格式：
• POU（程序组织单元）的主体是用图形化编程语言编写的。

◦ 顺序功能图 (SFC)
◦ FBD/LD/IL（功能块图/梯形图/指令表）
◦ CFC（连续功能图和面向页面的 CFC）
◦ UML 类图和状态图

• 带有以图形化实现语言编程的子元素（例如，动作、方法）的 POU（有关图形
语言的信息，请参见第 1 个关键点）

• 可视化
• 可视化管理器
• 文本列表
• 配方管理器
• 图像池
到目前为止，这些对象默认以 XML 格式保存。
从 Build 4024 版本开始，您可以配置应该将这些对象类型保存为 XML 或Base64。
Base64 相对于 XML 的优点：
与 XML 相比，Base64 可实现压缩存储。因此，通过文件访问这些对象可以提高性
能，例如，这种方法在加载项目或移动、复制对象时特别有用。
标准存储格式的设置选项：
对于 PLC 项目，PLC 项目属性中的设置“Write object content as”（将对象内容
写为）可用于定义上述对象类型的默认存储格式。
选择的标准存储格式只会用于新添加的对象（例外：不适用于新添加的 POU 子对
象。示例：将 POU 保存为 XML，并将标准存储格式配置为 Base64。如果随后在
POU 中添加图形子对象，那么POU的存储格式以及这个子对象的存储格式仍然保
持为XML格式）。
在更改和保存非标准存储格式的现有对象时，其存储格式不会自动更改。可通过
“Properties”（属性）窗口单独更改现有对象的存储格式（见下文）。或者，在
更改标准存储格式时，还可以选择对所有现有对象采用新选定的存储格式。如果在
此时更改存储格式，则会出现相应的问询窗口。
设置“Write object content as”（将对象内容写为）可提供以下选项：
• XML（默认）：上述 PLC 对象默认以 XML 格式保存。

◦ 使用此存储格式的对象按文件版本 1.1.0.1 进行存储。
• Base64：上述 PLC 对象默认以 Base64 格式保存。

◦ 使用此存储格式的对象按文件版本 1.2.0.0 进行存储。
请注意，不能使用低于 TwinCAT 3.1.4024 版本的开发环境加载文件版本为
1.2.0.0（或更高）的对象！

存储格式的单独设置选项：
对于上述对象类型，可在对象的“Properties”（属性）窗口中单独配置该对象的
存储格式。有关更多信息，请参见关于属性 [} 88]的描述（格式属性）。
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在文件中写入产品版本
（“Write product
version in files”）

TwinCAT 3.1 Build 4024 及以上版本可用
产品版本表示使用哪个插件版本来保存 PLC 文件（例如，功能块）。该复选框的设
置对整个项目有效，并且是该 PLC 项目中所有已修改或新添加的 PLC 对象的默认
设置。

（默认）：不会将产品或插件版本写入文件。
• 如果您将该设置从启用改为禁用，则会出现 1 个问询窗口，您可以在其中选择是

否从所有现有文件中移除产品版本信息。
• 禁用选项的用例：如果您对产品版本不感兴趣，则可以使用该设置。这样可以最

大限度地减少源代码管理系统对文件的更改。

 将产品或插件版本写入文件（在XAE中看不到这个版本信息；只有在文件级别
进行分析时才会显示出来）。
• 如果您将该设置从禁用改为启用，则会出现 1 个问询窗口，您可以在其中选择是

否将产品版本添加到所有现有文件中。
• 启用选项的使用场景：例如，可以使用该设置将文件版本信息包含在文件中，以

便进行调试或跟踪。
• 请注意以下几点：如果以不同的产品版本保存文件，会导致该文件发生更改，在

使用源代码管理系统时会显示文件存在差异。
使用配置文件写入对象内
容

配置文件定义了对象的保存格式。例如，在 Build 4024 中，为 PLC HMI 添加了新
功能。因此，用 Build 4024 保存的可视化文件无法直接用旧版本打开。如果您在
此处设置了 4022 配置文件，可视化文件将以相应的格式保存，并可使用 Build
4022 打开。
要求：例如，若要在下拉菜单中显示 4022 配置文件，则必须安装 4022 远程管理
器，或者通过先前的 4022 XAE 安装程序安装当前最新的 4024 XAE。

将书签写入文件 TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：仅将书签保存在 Visual Studio 的 .suo 文件中。从项目目录中删除
已创建的 .bookmarks 文件。

：同时将 Visual Studio 项目用户选项文件（.suo）中存储的书签写入单独的文
件。该文件以 .bookmarks 结尾，位于项目目录中。因此，它也是已知归档选项的
一部分。
新建 PLC 项目时，是否将书签存储在单独文件中的全局默认设置请参见“对话框选
项 - 写入选项 [} 176]”。在创建新 PLC 项目时，这个设置的值会被传递到本地项
目设置中。

多用户选项

使用 Multiuser
（“Use Multiuser”）

TwinCAT 3.1 Build 4024 及以上版本可用

（默认）：不启用 PLC 项目的多用户功能。

：启用 PLC 项目的多用户功能。
另请参见多用户文档中的更多信息。

多用户 URL TwinCAT 3.1 Build 4026 及以上版本可用
相关描述见后文。

更新父节点 TwinCAT 3.1 Build 4026 及以上版本可用
相关描述见后文。

解决方案选项
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安全在线模式
（“Secure Online
Mode”）

：（默认）：出于安全考虑，始终会提示用户在调用以下命令时确认执行这些
命令。
• 激活配置
• 在配置/运行模式下重启 TwinCAT 系统
• 冷复位
• 初始值复位

：除了上述命令之外（默认出现确认提示），还将提示您确认以下命令。
• 登录
• 开始
• 停止
• 单循环
• 写入值
• 强制值
• 释放值

自动更新可视化配置文件 可通过此选项配置可视化配置文件的自动更新操作。
当您打开使用过时可视化配置文件的 PLC 项目时，会在消息窗口中出现警告
（“New Version found for Visualization profile”）（发现可视化配置文件的新
版本）。

（默认）：如果禁用了“Autoupdate Visu Profile”（自动更新可视化配置文
件）选项，可视化配置文件版本不会自动更改。您可以双击警告“New Version
found for Visualization profile”（发现可视化配置文件的新版本），打开
ProfileUpdate 对话框，在该对话框中，您可以手动更改可视化配置文件版本。

：在这种情况下，如果启用了“Autoupdate Visu Profile”（自动更新可视化
配置文件）选项，会将可视化配置文件版本自动设置为最新版本。在此类可视化配
置文件版本自动更新后，消息窗口中将显示相应的警告（例如，“Visualization
profile set from ‘TwinCAT 3.1 Build 4020.10’ to ‘TwinCAT 3.1 Build
4022.0’”（已将可视化配置文件从“TwinCAT 3.1 Build 4020.10”设置为
“TwinCAT 3.1 Build 4022.0”））。

自动更新 UML 配置文件 可通过此选项配置 UML 编译器版本的自动更新操作。
如果您打开使用过时 UML 编译器版本的 PLC 项目，会在消息窗口中显示相应的警
告（“new version for UML found”（发现 UML 的新版本））。

（默认）：如果禁用了“Autoupdate Uml Profile”（自动更新 UML 配置文
件）选项，UML 编译器版本不会自动更改。双击警告“new version for UML
found”（发现 UML 的新版本），打开 ProfileUpdate 对话框，在该对话框中，您
可以手动更改 UML 编译器版本。

：在这种情况下，如果启用了“Autoupdate Uml Profile”（自动更新 UML
配置文件）选项，会将 UML 编译器版本自动设置为最新版本。如果 UML 编译器版
本自动更新，消息窗口中将显示相应的警告（例如，“UML set from ‘4.0.2.0’
to ‘4.0.2.1’”（已将 UML 从“4.0.2.0”设置为“4.0.2.1”））。
有关更多信息，请参见“UML 编译器版本”。
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写入行 ID TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：不生成单独的行 ID。在这种情况下，机器代码指令的分配和断点处
理会使用行号。因此，对于空格或注释等更改，需要进行在线更改。

：会为项目的 POU 生成并存储行 ID（TwinCAT 3.1 Build 4024 及以下版本的
默认操作）。行 ID 可用于将代码行分配给机器代码指令，在进行断点处理等操作
时需要使用行 ID。
新建PLC项目时，全局默认设置“写入行ID”，请参见“对话框选项 - 写入选项
[} 176]”。在创建新 PLC 项目时，这个设置的值会被传递到本地项目设置中。

兼容性

将 PLC 项目转换为先前的
TwinCAT 版本

TwinCAT 3.1 Build 4026 及以上版本可用
在打开的对话框中，您可以选择 PLC 项目应该转换的 TwinCAT 版本
（TwinCAT 3.1 Build 4022 或 4024）。使用“Convert”（转换）确认转换之
后，项目将会关闭并保存为与所选版本兼容的版本。
请注意，在转换过程中，项目数据将会更改，较新版本的设置和属性将会丢失。因
此，该转换不适合在不同版本之间进行多次切换。

将事件写入事件日志

您可以使用以下 2 个选项来配置是否要记录用户事件，以及记录何种类型的用户事件。以下事件属于用户事
件：

• 登录
• 退出
• 下载
• 在线更改
• 启动 PLC 项目
• 停止 PLC 项目
• 单循环
• 冷复位
• 初始值复位
• 设置断点
• 删除断点

运行时会将事件发送至 EventLogger。此外，如果将 EventLogger 选项“Output as Task Item”（作为任
务项目输出）设置为 True，将会在消息窗口（错误列表）中输出事件。

如果您更改了下述选项，下次登录时需要进行在线更改。设置随即生效。

信息 TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：在发生成功的用户事件时，不记录任何消息。

：如果上述用户事件之一成功发生，那么与此同时将会记录此过程的相应信
息。

错误 TwinCAT 3.1 Build 4026 及以上版本可用

（默认）：当用户事件失败时，不记录任何消息。

：如果在上述用户事件之一发生时出现错误，那么与此同时将会记录此失败过
程的相应信息。例如，如果因在运行时出错而导致登录失败，就会执行此操作。

常规
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允许在 1 个解决方案中多
次出现具有相同 ID 的
（相同）对象

（或“Allow (identical)
objects with the same
ID multiple times in one
solution”）

（默认）：PLC 对象（例如，POU）通过其 GUID 进行识别，该 GUID 在整个
解决方案中只分配 1 次。在通常使用情况下，该选项可以且应该保持禁用状态。

：该激活的选项仅适用于在 1 个解决方案中多次存在具有相同 ID/GUID 的对象
的情况。在这种情况下，必须更改对象的标识类型，以便将 PLC 对象的 GUID 链接
至 PLC 项目的 GUID（使用 XOR）。这样可以避免在不同项目中多次使用同一个对
象时更改其GUID。
信息：
• 如果您更改了选项的状态，则必须重新加载项目。下次登录时也需要进行下载。
• 如果激活该选项，该 PLC 项目中所有对象的标识类型都会发生更改。
• 如果激活该选项，则无法使用或无法充分使用以下 PLC 功能：

◦ 可视化
◦ UML SC
◦ 安全管理

该选项已重命名为 TwinCAT 3.1 Build 4026.x。先前的名称为：“Minimize ID
changes in TwinCAT files”（最小化 TwinCAT 文件中的 ID 更改）或“Minimize
ID changes in TwinCAT files”（最小化 TwinCAT 文件中的 ID 更改）。该选项的
操作保持不变。
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